
 

 

 

 

 

 

OPERATION MANUAL 
for SYSTEM 8 and BoardMaster Ranges 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



ABI Electronics Ltd   Page 2 

System overview................................................... 6 
What's new in SYSTEM 8 Premier ........................ 7 

New product: the Advanced Test Module .......... 8 
New instrument: the BFL output driver .............. 8 
Integration with third party solutions .................. 8 
Database management..................................... 8 
TestFlow documentation................................... 8 
Short links to Windows utilities .......................... 8 
New TestFlows for training................................ 8 

Starting the SYSTEM 8 Premier software.............. 9 
Quitting the SYSTEM 8 Premier Software ............. 9 
Setup Interface Method......................................... 9 

Interface Card Address Setup ......................... 11 
Changing the Interface Card Address ............. 11 
PCI Card Setup .............................................. 12 
MultiLink Serial Port Setup.............................. 12 
MultiLink Parallel Port Setup ........................... 13 
MultiLink USB Port Setup................................ 14 

Contact ABI Electronics Ltd................................. 14 
ABI Products and accessories ........................ 14 

BoardMaster 8000 Plus. ............................. 15 
SYSTEM 8 Diagnostic Solution................... 15 
SYSTEM 8 IC Test Solution........................ 15 
SYSTEM 8 Analogue V-I Solution and 
Analogue IC Test Solution. ......................... 15 
SYSTEM 8 Measurement Solution.............. 15 
SYSTEM 8 Power Supply Solution. ............ 15 
LinearMaster Compact. .............................. 16 
ChipMaster Compact. ................................. 16 

Self Test Diagnostic Results ............................... 16 
MIS 3.................................................................. 16 

System Status Information .............................. 16 
MIS 3 Instrument Test Results ........................ 16 

BFL .................................................................... 17 
System Status Information .............................. 17 
BFL Instrument Test Results........................... 17 

ATS .................................................................... 17 
System Status Information .............................. 17 
ATS Instrument Test Results .......................... 18 

VPS.................................................................... 18 
System Status Information .............................. 18 
VPS Instrument Test Results .......................... 18 

ATM.................................................................... 19 
System Status Information .............................. 19 
ATM Instrument Test Results.......................... 19 

Software Support ................................................ 19 
Hardware Support............................................... 20 
Calibrating Instruments ....................................... 20 
Safety Notice ...................................................... 20 
Instrument Design Manager ................................ 20 

Designing a New Instrument ........................... 21 
Copying an Existing Instrument....................... 23 
Editing an Existing Instrument......................... 23 
Editing Controls .............................................. 24 

Moving Controls ......................................... 24 
Resizing Controls ....................................... 24 
Deleting Controls ........................................ 24 
Editing Controls .......................................... 24 

Instrument Designer TestFlow Controls .......... 24 

Instrument Designer VPS Controls.................. 25 
Instrument Designer Universal Inputs/Outputs 
Controls .......................................................... 25 
Instrument Designer Auxiliary Power Supply 
Controls .......................................................... 26 
Instrument Designer Generic Controls............. 26 

Generic Controls ................................................. 26 
Instrument Designer Function Generator Controls
....................................................................... 27 
Instrument Designer Frequency Counter Controls
....................................................................... 27 
Instrument Designer Digital Storage Oscilloscope 
Controls .......................................................... 28 
Instrument Designer Digital Multimeter Controls
....................................................................... 28 

TestFlow Automatic Test Manager ...................... 29 
Creating a New TestFlow Procedure............... 29 
Editing an Existing TestFlow ........................... 30 

Re-ordering TestFlow records..................... 30 
Adding and deleting records ....................... 30 
Copying a new record ................................. 30 
Editing an individual record ......................... 30 
Saving the modified file............................... 31 

Running a TestFlow Procedure ....................... 31 
Single Stepping a TestFlow ........................ 31 
Running a TestFlow Automatically .............. 31 

User Access Manager ......................................... 31 
Creating a New User....................................... 32 
Removing an Existing User ............................. 33 
Editing an Existing User .................................. 33 
Selecting a Different User ............................... 34 

MIS Front Panel .................................................. 35 
The MIS Function Generator ............................... 36 

Setting the waveform and frequency ............... 36 
Sweeping the Frequency ................................ 37 
Function Generator Connector ........................ 37 

The MIS Digital Multimeter .................................. 37 
The MIS Frequency Counter ............................... 37 

Frequency Measurement ................................ 38 
Event Counting ............................................... 38 

Trigger on Pulse, Positive Polarity............... 39 
Trigger on Pulse, Negative Polarity ............. 39 
Trigger on Level, Positive Polarity ............... 39 
Trigger on Level, Negative Polarity ............. 40 

Frequency Counter Connectors ...................... 40 
The MIS Auxiliary Power Supply ......................... 40 
The MIS Universal Inputs/Outputs....................... 40 

MIS Universal Inputs/Outputs Connector......... 41 
MIS Digital Storage Oscilloscope ........................ 42 

Acquisition ...................................................... 42 
Trigger ............................................................ 42 
Timebase........................................................ 42 
Channel Controls ............................................ 42 
Channel Maths................................................ 42 
Measurements................................................ 42 
DSO Acquisition Modes .................................. 42 
DSO Aliasing .................................................. 43 
DSO Automatic Measurements ....................... 43 
DSO Channel Coupling................................... 45 



ABI Electronics Ltd   Page 3 

DSO Channel Maths....................................... 45 
DSO Channel Offset ....................................... 45 
DSO Channel Sensitivity................................. 45 
DSO ERS Mode ............................................. 46 
DSO Timebase ............................................... 46 
DSO Trigger ................................................... 46 
DSO Trigger Coupling..................................... 46 
DSO Trigger Delay ......................................... 47 
DSO Trigger Edge .......................................... 47 
DSO Trigger Level .......................................... 47 
DSO Trigger Source ....................................... 47 
DSO Waveform Comparison........................... 48 
MIS Digital Storage Oscilloscope Connectors . 48 

MIS Digital Multimeter ......................................... 48 
DMM Current Measurement............................ 48 
DMM Resistance Measurement ...................... 49 
DMM Voltage Measurement ........................... 49 
MIS Digital Multimeter Connectors .................. 50 

Measurement Statistics....................................... 50 
The BFL Front Panel........................................... 50 
The BFL IC Identifier........................................... 50 

IC Size ........................................................... 51 
Circuit Types .................................................. 51 
Start/Stop Buttons........................................... 51 
Identifier Test Result ....................................... 51 
ICs Found....................................................... 51 
Identifier Progress........................................... 51 
Identifier Status............................................... 51 

The BFL Graphical Test Generator ..................... 52 
Changing Channel Numbers, Names & Types 52 
Creating a Timing Sequence........................... 52 
Save Button.................................................... 53 
Learn Button................................................... 53 
Open Button ................................................... 53 
Run Button ..................................................... 53 
Clear Button ................................................... 53 
Setup Button................................................... 53 
Delete Button.................................................. 53 
Insert Button ................................................... 53 

The BFL IC Live Comparison .............................. 53 
Part Button ..................................................... 54 
Setup Button................................................... 54 
Start Button .................................................... 54 
Stop Button..................................................... 54 
Analysis Button............................................... 54 
IC / DV-I Button .............................................. 54 
Actual / Master Button..................................... 54 
The << and < Buttons ..................................... 55 
The >> and > Buttons ..................................... 55 
V-I Result Comparison.................................... 55 

The BFL Short Locator........................................ 55 
Range ............................................................ 56 
Tone............................................................... 56 
Error Messages .............................................. 56 

The BFL IC Tester .............................................. 56 
Part Button ..................................................... 56 
Setup Button................................................... 56 
Start Button .................................................... 56 
Stop Button..................................................... 57 

Analysis Button............................................... 57 
IC / DV-I Button............................................... 57 
Rotate Button.................................................. 57 
Actual / Master Button..................................... 57 
The << and < Buttons ..................................... 57 
The >> and > Buttons ..................................... 57 
The BFL Logic Trace ...................................... 57 

Enable / Disable Logic Trace ...................... 57 
Understanding the Display .......................... 58 
Finding the Voltage..................................... 58 

BFL Main IO Connector .................................. 58 
BFL Pin Conversion Table .............................. 58 

File Format ................................................. 58 
Example ..................................................... 58 
Pin Conversion Filename............................ 59 

BFL Power Supply Connectors ....................... 59 
BFL Result Analysis Information ..................... 60 
BFL Selecting Part to Test .............................. 60 

Standard Libraries ...................................... 60 
Linear Library ............................................. 61 

BFL Setup Test Parameters............................ 61 
Test Types.................................................. 61 
Test Modes................................................. 61 
Circuit Types .............................................. 61 
DV-I Range................................................. 62 
Thresholds.................................................. 62 
Power Supply ............................................. 62 
Messages................................................... 63 
Connection Tol. .......................................... 63 
Voltage Tol. ................................................ 63 
DV-I Tol. ..................................................... 63 
Thermal Tol. ............................................... 63 

BFL Pin Conditions ......................................... 63 
The BFL EPROM Verifier .................................... 65 

EPROM Type ................................................. 65 
In Circuit / Out Circuit ...................................... 66 
Read Button.................................................... 66 
Verify Button ................................................... 66 
Open Button ................................................... 66 
Save Button .................................................... 66 
Checksum ...................................................... 66 
Status ............................................................. 66 

The BFL Output Driver ........................................ 66 
Update BFL Button ......................................... 67 
Send Settings on Open Checkbox................... 67 
Channel .......................................................... 67 
Test Point ....................................................... 67 
Drive State...................................................... 67 

BFL Auxiliary I/O Connector ................................ 67 
BFL Backdriving.................................................. 67 
BFL Conflicts Explained ...................................... 68 

How Do I Find The Conflict Source? ............... 69 
What If I Cannot Find The Conflict Source?..... 70 

BFL Loads Explained .......................................... 70 
BFL Signals Explained ........................................ 70 

How Can I Tell If An External Signal Is Affecting 
The Test? ....................................................... 70 
How Do I Stop The Signal? ............................. 71 

BFL Special Tests............................................... 71 



ABI Electronics Ltd   Page 4 

Interconnections Tests.................................... 71 
DV-I Probe Test.............................................. 71 
EPROM Socket Analysis ................................ 72 
Microprocessor BUS Analysis ......................... 72 

BFL Test Clips and Cables.................................. 72 
Connection to the PCB under Test.................. 72 
DIL Test Clip Insertion .................................... 73 
SOIC Test Clip Insertion ................................. 73 
QFP and PLCC Test Clip Insertion.................. 74 
Custom Test Clips and Cables........................ 74 

Adapters and Probes .......................................... 75 
BFL Test Techniques .......................................... 75 

Connection to the PCB under Test.................. 75 
Test Clip Installation ....................................... 76 
Using the Ground Clip..................................... 76 
Automatic Clip Positioning .............................. 76 
Powering the PCB under Test......................... 76 
Cleaning ......................................................... 77 
Clocks ............................................................ 77 
The BDOs ...................................................... 77 
BDO Usage .................................................... 77 

BFL Test Types .................................................. 77 
Truth Table Test ............................................. 77 
Connections Test............................................ 77 
Voltage Test ................................................... 78 
Thermal Test .................................................. 78 
DV-I Test ........................................................ 78 

Comparing Measurement Results ....................... 79 
BFL Select DV-I Trace Colours ........................... 79 
The AICT Front Panel ......................................... 79 
AICT Analogue V-I Tester ................................... 80 

Size Box ......................................................... 80 
Frequency Selector......................................... 81 
Impedance Selector........................................ 81 
Voltage Selector ............................................. 81 
Curve Selector................................................ 81 
Axis Selector .................................................. 81 
Setup Button................................................... 81 
Start Button .................................................... 81 
Stop Button..................................................... 81 
Store Button ................................................... 81 
Matrix Button .................................................. 81 
V-I Result Comparison.................................... 82 
Tone Box........................................................ 82 
The < and > Buttons ....................................... 82 
The Pulse Generator ...................................... 82 

AICT Analogue IC Tester .................................... 82 
Setup Button................................................... 82 
Start Button .................................................... 83 
Stop Button..................................................... 83 
Actual / Master Button..................................... 83 
Library Window............................................... 83 
Notes Button................................................... 83 
Analysis window ............................................. 83 
Result window ................................................ 83 
Trace window ................................................. 83 

AICT Analogue I/O Connector............................. 83 
AICT Analogue V-I Setup.................................... 83 

Enable Pulse .................................................. 84 

Positive Pulse ................................................. 84 
Negative Pulse................................................ 84 
Pulse Type ..................................................... 84 
DC.................................................................. 84 
Comp. Tol. ...................................................... 84 
Colours Button................................................ 84 
Dot Join .......................................................... 85 
Probe Compensation ...................................... 85 

The AICT Analogue IC Tester Analysis Information
........................................................................... 85 
The AICT IC Tester Comparison ......................... 85 
AICT IC Tests Types........................................... 85 

Functional Test ............................................... 86 
Connections Test............................................ 86 
Voltage Test ................................................... 86 

AICT Pin Conditions............................................ 86 
AICT Selecting Analogue V-I Trace Colours ........ 88 

Default Colours Button.................................... 88 
AICT Setup Test Parameters .............................. 88 

Test Types...................................................... 88 
Test Modes..................................................... 88 
Test Functions ................................................ 89 
Messages ....................................................... 89 
Voltage Tolerance........................................... 89 

AICT Using Analogue V-I .................................... 89 
About V-I Testing ............................................ 89 
Understanding the Display .............................. 90 
Summary ........................................................ 93 
Suggested V-I Test Parameters ...................... 94 

Matrix V-I ............................................................ 94 
Matrix VI Out-Of-Circuit Adapter...................... 95 

The VPS Front Panel .......................................... 95 
VPS Variable Power Supply ................................ 96 

Power Supply Output ...................................... 96 
Voltage Adjustment......................................... 96 
Over Voltage Protection .................................. 96 
Over Current Protection .................................. 97 

The ATM Front Panel .......................................... 97 
The ATM Advanced IC Identifier.......................... 97 

IC Size............................................................ 97 
Family............................................................. 97 
Start / Stop Button .......................................... 97 
Identifier Test Result ....................................... 97 
ICs Found....................................................... 98 
Identifier Progress........................................... 98 
Identifier Status............................................... 98 

The ATM Advanced Graphical Test Generator .... 98 
Part Selection ................................................. 99 
Changing Channel Numbers, Names & Types 99 
Creating a Timing Sequence........................... 99 
Save Button .................................................... 99 
Learn Button ................................................... 99 
Import Button .................................................. 99 
Export Button.................................................. 99 
Run Button ..................................................... 99 
Setup Button................................................. 100 
Delete Button................................................ 100 
Edit Button.................................................... 100 

The ATM Advanced Short Locator..................... 100 



ABI Electronics Ltd   Page 5 

Range ...........................................................100 
Tone..............................................................100 
Error Messages .............................................101 

The ATM Advanced IC Tester ............................101 
Part Selection ................................................101 
Run Modes ....................................................101 
Setup Button..................................................101 
Start / Stop Button .........................................101 
Results ..........................................................102 
IC / V-I / Logic Trace Tabs .............................102 
Rotate Button ................................................102 
Actual / Master Button....................................102 

The ATM Advanced Board Checker ...................102 
Update All Button...........................................102 
Send Settings on Open Checkbox .................102 
Channel Name...............................................103 
Action to Perform...........................................103 
Available Channels List..................................103 
Channel Results ............................................103 

Calculator ..........................................................103 
Conceptual Topics .........................................103 
Language Reference .....................................103 

Commenting your FormulaPlus Programs ..........104 
Examples of Comments:................................104 

Declaring Variables............................................104 
Examples of legal variable identifiers: ............104 
Examples of illegal variable identifiers:...........104 

Looping Through Code ......................................104 
WHILE Loops ................................................105 
REPEAT Loops .............................................105 

Understanding FormulaPlus Syntax ...................106 
Keywords ......................................................106 
Functions.......................................................106 

Writing Data to Files...........................................106 

Comma Separated Variable Files.................. 106 
Writing to the Same File................................ 107 
Database Files.............................................. 107 
Writing to the Same File................................ 107 
Conditional Expressions................................ 108 

List of Error Messages ...................................... 108 
List of Keywords................................................ 111 
List of Operators ............................................... 119 
List of System Variables.................................... 120 

Advanced Board Checker System Variables . 120 
Digital Multimeter System Variables .............. 120 
Digital Storage Oscilloscope System Variables
..................................................................... 120 
Frequency Counter System Variables ........... 125 
Function Generator System Variables ........... 125 
Miscellaneous System Variables ................... 125 
TestFlow System Variables........................... 126 
Universal Input/Outputs System Variables..... 126 
Variable Power Supply System Variables...... 127 

List of Functions................................................ 128 
What Is Python?................................................ 133 
Installing Python................................................ 133 
Python DMM..................................................... 134 
Python DSO...................................................... 134 
Python FC......................................................... 137 
Python FGen..................................................... 137 
Python UIO ....................................................... 138 
Python VPS ...................................................... 139 
Using Python Example...................................... 141 

Commenting Python Code ............................ 141 
Mixing Python and FormulaPlus Example.......... 141 
Python Input Example ....................................... 142 
Python Output Example .................................... 142 
Python Running an External Program Example . 142 



ABI Electronics Ltd   Page 6 

System overview 
The SYSTEM 8 Premier software is designed to support a range of high specification 
hardware modules containing a wide variety of test and measurement facilities including 
fault-finding instruments, component test instruments and general test and measurement 
instruments.  The hardware modules are supported by a comprehensive software package 
which allows different combinations of instruments to be used concurrently to satisfy the most 
demanding fault-finding or test applications.  Each module is the same size as a CD ROM 
drive, allowing a variety of mechanical mounting options.  A module can be mounted directly 
in your PC and controlled via an internal interface card, or it can be mounted in an external 
case and controlled via a serial or parallel cable.  In addition, fully integrated systems (the 
BoardMaster range) are available which include a PC controller and colour LCD display. 
 
The range of modules available follows: - 
 

ATM (Advanced Test Module).  The ATM will identify and locate faulty ICs, broken tracks, 

short circuits, floating inputs, mid level outputs, dry joints and leaking nodes on PCBs with 
analogue, digital and hybrid components from discrete diodes and transistors to complex 
VLSI in DIL, PLCC and SOIC packaging.  It has the added advantage of being compatible 
with all logic families including TTL, CMOS, LVTTL, ECL, DTL, LSI, PECL and LVPECL. 
 
The following instruments are included in the ATM: - 
 

Advanced IC Tester 
Advanced IC Identifier 
Advanced Short Locator 
Advanced Graphical Test Generator 
Advanced Board Checker 

 

MIS (Multiple Instrument Station) module.  The MIS module contains a comprehensive 

range of test and measurement instrumentation resources which can be used to implement 
most of the test instruments found on any electronics workbench.  The basic instrument 
readings can be processed with the built in calculator and used to calculate more complex 
results.  The Instrument Design Manager allows any combination of instruments to be 
designed and modified by the user and saved in a design file, even to the extent of adding 
instrument titles and on-screen prompts.   Built-in instrument design files emulating standard 
bench instrumentation (e.g. DSO, DMM, function generator, frequency counter) are included. 
 
The following instruments are included in the MIS module: - 
 

Digital Storage Oscilloscope: 2 channel, 100MHz, 50MS/s to 5GS/s 
Universal Inputs/Outputs: 4 channel analogue I/O, 4 channel digital I/O 
Frequency Counter: 2 channel 50Ohm/150MHz and 1MOhm/100MHz 
Function Generator: 0.1Hz to 10MHz square, sine, triangle, pulse, plus 

modulation 
Digital Multimeter: 2 channel DC/AC 0 to 400V, DC/AC 0 to 1A, 0 to 

10MOhms 
Auxiliary Power Supply: 5V and +/-9V low current for test interface power 
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VPS (Variable Power Supply) module.  The VPS module provides a programmable power 

supply with a logic output (2.5V to 6V at 5A) and dual medium voltage outputs (0 to +/-24V at 
1.5A).  The logic supply is equipped with programmable over-voltage protection, and the 
dual supplies have programmable current limit.  The voltage and current for each rail are 
displayed on-screen.  The VPS is fully compatible with the Instrument Design Manager. 
 
The following instrument is contained in the VPS module: - 
 

Variable Power Supply 
 

BFL (Board Fault Locator) module.  The BFL module will identify and locate faulty ICs, 

broken tracks, short circuits, floating inputs, mid level outputs, dry joints and leaking nodes on 
PCBs with analogue, digital and hybrid components from discrete diodes and transistors to 
complex VLSI in DIL, PLCC and SOIC packaging. 
 
The following instruments are included in the BFL module: - 
 

IC Tester 
IC Identifier 
IC Live Comparison instrument 
Short Locator 
Graphical Test Generator instrument 
EPROM Verifier 
Output Driver 
 

AICT (Analogue IC Tester) module.  The AICT module allows analogue devices (discrete 

and ICs) to be functionally tested and also the signatures of ICs and discrete components to 
be acquired and compared without removing them from the printed circuit board (PCB). 
 

The ATS module is another version of the AICT that offers analogue signature acquisition 

only. 
 
The following instruments are included in the AICT module: - 
 

Analogue IC Tester 
Analogue V-I Tester 
 

What's new in SYSTEM 8 Premier 
Thank you for updating your SYSTEM 8 Premier software to the latest version. We aim at 
constantly improving our software package by taking on feedback from our customers all 
around the world and ensuring that we supply a solution that is powerful, accessible and 
suitable to users. 
 
Please read below the summary of the changes and improvements brought to you by ABI 
Electronics.  
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New product: the Advanced Test Module 

The Advanced Test Module (ATM) is a new solution that offers high test capabilities and 
comprehensive fault diagnosis with a high degree of flexibility. The ATM is suitable for all logic 
families including TTL, CMOS, LVTTL, ECL, DTL, LSI, RTL, PECL and LVPECL. 
Components can be checked in-circuit and out-of-circuit or a complete PCB assembly can be 
tested with a fixture. Click here for more details. 
 
Five new instruments were added to the SYSTEM 8 Premier software with the introduction of 
the Advanced Test Module. Further details can be found in this help file. 

New instrument: the BFL output driver 

The 64 channels of the BFL module can be controlled individually to be set to a high or low 
logic level (or off if unused). This opens a new range of applications where the BFL channels 
can control equipment outside the SYSTEM 8 range (a power supply for instance) or can 
control an external multiplexer to route signals through various paths. Please click here for 
more details. 

Integration with third party solutions 

It is now possible to integrate third party equipment (non SYSTEM 8 equipment) to work 
smoothly within the TestFlow environment. External applications can be launched from 
SYSTEM 8 Premier, run tests until they are complete and return to SYSTEM 8 with 
information (test results, measurements etc…). This information can be used to set the result 
of a step (pass or fail). Products such as JTAGMaster for instance can be run from SYSTEM 
8 Premier. 
 
The integration of third party solutions is introduced thanks to Python, a powerful and dynamic 
programming language. For more information, visit www.python.org. 

Database management 

New keywords have been added to the calculator to enable the storing of results in databases. 
This allows data to be stored consecutively every time the same TestFlow is run. This is 
particularly useful in an environment where multiple assemblies need to be tested 
consecutively and results need to be recorded for traceability. The new commands 
(STARTLOGDB and WRITELOGDB) are compatible with a SQLite3 database type. 

TestFlow documentation 

Documents such as videos, Word, Excel, PowerPoint, PDF and others can now easily be 
added to TestFlows to make the test procedure more interactive. A simple “Add Media” button 
was added to quickly integrate information within a particular step. This could be a video 
explaining how to test a board, a device datasheet, a spreadsheet of expected values etc… 

Short links to Windows utilities 

These shortcuts allow users to quickly launch Paint, Calculator and Notepad from within 
SYSTEM 8 Premier. This is particularly useful to take screenshots or write information down. 

New TestFlows for training 

In order to get familiar with the new features of the SYSTEM 8 Premier, a range of short 
TestFlows is available from ABI Electronics. Please contact us for more information. 
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Starting the SYSTEM 8 Premier software 
SYSTEM 8 Premier operates under Windows XP or above.  To start the software, select 
Programs > SYSTEM 8 Premier > SYSTEM 8 Premier from the Start button on your 
desktop. 
 
When the software launches you will be presented with the login screen: 
 

 
 

Pressing the OK button will log you into SYSTEM 8 Premier as the selected user. 
Pressing the EXIT button will ask you whether you wish to exit the software. 
Pressing a module icon will show the complete Self Test Diagnostic Results for that 
module 

 
Initially, all instruments and settings will be in their default configuration.  A self diagnostic 
routine is invoked upon running the system to verify that all the hardware is correctly installed 
and fully functional. The results of the diagnostics are show in the upper right corner where 
each of the module types is given a PASS or FAIL. If no physical module of a particular type 
is connected, DEMO will be displayed indicating that this module will be only available in 
Demonstration Mode. 

Quitting the SYSTEM 8 Premier Software 
Quit the software by selecting File > Exit from the menu, or by double clicking on the icon at 
the top left of the main window.  Alternatively you can click on the  symbol at the top right 
of the main window. 

Setup Interface Method 
Select Tools > Setup Module Interface Methods from the menu. This opens the dialog box 
show below: 
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The following interface methods are available: - 

 
ISA Card: This is a card which is installed in an ISA slot in your PC and has an 

internal connection to the SYSTEM 8 module(s) installed in your PC.  
Alternatively, an external connection to a SYSTEM 8 External Case may 
be used. 

PCI Card: This is a card which is installed in a PCI slot in your PC and has an 
internal connection to the SYSTEM 8 module(s) installed in your PC.  
Alternatively, an external connection to a SYSTEM 8 External Case may 
be used. 

Parallel MultiLink: This is a MultiLink case with a built-in interface card which contains your 
SYSTEM 8 module.  The MultiLink case connects to your PC LPT port 
via a parallel cable. 

Serial MultiLink: This is a MultiLink case with a built-in interface card which contains your 
SYSTEM 8 module.  The MultiLink case connects to your PC COM port 
via a serial cable. 

USB MultiLink: This is a MultiLink case with a built-in interface card which contains your 
SYSTEM 8 module. The MultiLink case connects to your PC USB port via 
a USB cable. 

 
To add a new interface method click on the Add button.  This opens the dialog box shown 
below: 
 

 
 
Select the interface type you wish to add and click on the OK button, which will return you to 
the original dialog box. 



ABI Electronics Ltd   Page 11 

 
To setup the interface method you have just created, see the following sections: 
 

Setting up the ISA Card 
Setting up the PCI Card 
Setting up the Serial MultiLink Interface 
Setting up the Parallel MultiLink Interface 
Setting up the USB MultiLink Interface 

 
When you are happy with your changes, click the OK button, otherwise click the Cancel 
button to leave your settings unchanged. 

Interface Card Address Setup 

The interface card contains a bank of numbered DIP switches which determine the I/O 
address of the card.  The MIS, ATS and VPS can share a common interface card.  The BFL 
module(s) use a separate interface card.  The switches on each card must be set to an 
address which does not clash with any other card on the motherboard.  The address range is 
from 208h to 3E8h.  The default addresses below are compatible with the majority of PC 
cards. 
 

The default address for the BFL is 3E0h: The default address for the MIS, ATS & 
VPS is 238h: 

   
 

Changing the Interface Card Address 

If the default address does not work for either card, another address can be configured by 
selecting from the Tools > Setup Modules Interface Methods menu.  This utility allows you 
to add/remove interface methods, and setup which port/address to use. 
 
Select the ISA interface that you want to change then click the Setup button.  This opens a 
dialog box, similar to the following, which allows you to change the interface card address. 
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It is important to select a unique address for the interface card to avoid conflict with any other 
cards on the motherboard.  Select a new address from the pick list and the switch settings 
diagram will change, indicating the new switch settings (remember this configuration).  
Clicking on the Identify button will tell you whether or not the ISA PC interface card is 
detected at that address or not. 
 
Once the new address has been selected, press OK and then exit the software, and Windows, 
and switch off.  The switches on the appropriate interface card must now be set to the new 
settings which were displayed during the above operation. 

PCI Card Setup 

The PCI card is Plug & Play compatible, and will be setup automatically as part of the 
installation process. 

MultiLink Serial Port Setup 

If you have an ABI module in a MultiLink case, you can communicate with it using either the 
serial or parallel port.  We recommend the parallel interface because it is faster, and more 
than one unit can be attached at a time.  If you wish to use the serial port you will require an 
optional serial cable which is available from ABI Electronics Ltd. 
 
Connect the MultiLink case mini DIN serial connector to the PC COM port using a serial 
cable. 
 
See the Setup Interface Method topic about how to select the Serial Port, and then click the 
Setup button.  A dialog box similar to the following will be displayed:- 
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Select the port that the MultiLink serial cable is connected to.  Click Identify button to display 
the MultiLink module that is connected to the specified serial port. 
 
Clicking on the Cancel will leave the serial port unchanged. 

MultiLink Parallel Port Setup 

If you have an ABI module in a MultiLink case, you can communicate with it using either the 
serial or parallel port.  We recommend the parallel interface because it is faster, and more 
than one unit can be attached at a time by daisy chaining the modules. 
 
Connect the MultiLink case lower connector to the PC LPT port using a parallel cable.  
Further modules can be connected with further parallel cables from the upper connector of 
the first module to the lower connector of the next.  Up to 7 modules in total can be 
connected, but no more than 1 of each type. 
 
See the Setup Interface Method topic about how to select the Parallel Port then click the 
Setup button.  A dialog box similar to the following will be displayed:- 
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Select the port that the MultiLink parallel cable is connected to.  Click Identify to display all 
MultiLink modules that are connected to the specified parallel printer port. 
 
Clicking Cancel will leave the parallel port unchanged. 

MultiLink USB Port Setup 

The USB Multilink is Plug & Play compatible, and will be setup automatically as part of the 
installation process. 

Contact ABI Electronics Ltd 
ABI can be contacted in one of the following ways: 
 

Post: 

 
ABI. Electronics Limited 

Dodworth Business Park 
Dodworth 
BARNSLEY 
South Yorkshire 
S75 3SP 
United Kingdom 
 
Telephone: 

 
Outside UK:  +44 1226 207420 

UK only:  01226 207420 
UK Office hours:   08:00 to 17:00 Monday to Thursday, 08:00 to 12:00 Friday, closed 
Saturday and Sunday 
 
Fax: 

 
Outside UK:  +44 1226 207620 

UK only:  01226 207620 
 
Internet & E-mail: 

 
If you would like to visit our Internet web site, the address is http://www.abielectronics.co.uk 
 
Our E-mail address is support@abielectronics.co.uk 

ABI Products and accessories 

ABI has been designing, manufacturing and selling leading edge solutions in the fields of test, 
measurement and fault diagnosis since 1983 and has established a world-wide reputation in 
its field for innovative solutions to real world test and fault diagnosis problems.  ABI are the 
acknowledged leaders in the field of affordable, easy to use, powerful test and diagnosis 
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products with thousands of products installed in around 86% of the world's industrialised 
countries. The following descriptions detail some of the outstanding products and accessories 
available: 
 

BoardMaster 8000 Plus.  
The BoardMaster 8000 Plus is the ultimate in fault-finding and general purpose test and 
measurement systems.  Completely self contained, with a built-in high performance PC 
and colour LCD display, the BoardMaster 8000 Plus contains 128 digital and 24 
analogue test channels for component level fault diagnosis, a programmable power 
supply for the board under test, and the state of the art MIS 3 instrumentation module for 
general test and measurement. 

 
SYSTEM 8 Diagnostic Solution. 
The SYSTEM 8 Diagnostic Solution is the solution to board fault-finding problems. 
Equally at home with analogue or digital PCBs, the system's 64 digital and 24 analogue 
test channels provide a variety of fault-finding techniques to track down the most elusive 
faults. The in-circuit IC test is the heart of the digital fault-finding system - look into an IC, 
and check that it functions correctly, look outside, and confirm that it is correctly wired. 
Use the analogue V-I tester, with selectable test frequencies and voltages, to check 
discrete analogue components. Compare the results with a known good board, 
automate fault-finding procedures with TestFlow, and fault diagnosis becomes truly 
effortless!  
 
SYSTEM 8 IC Test Solution. 
For testing digital components, the IC Test Solution provides the user with the ability to 
functionally test common digital ICs in- and out-of-circuit. A combination of industry 
recognised test techniques provides a high level of fault coverage. Additional tools are 
provided by the software to further enhance the wide range of applications for the unit. 
The system can be upgraded to include up to 256 channels (in 64 channel steps) which 
enables live comparison of good and bad boards. 
 
SYSTEM 8 Analogue V-I Solution and Analogue IC Test Solution. 
For testing all analogue components, the Analogue IC Test Solution is the answer. The 
key feature of the Analogue IC Test Solution is its ability to functionally test common 
analogue ICs in-circuit. It is also capable of identifying and testing all other analogue 
devices by means of the well-known V-I test technique. For users requiring only the 
latter function, the Analogue V-I Solution is a lower cost option.  
 
SYSTEM 8 Measurement Solution. 
The Measurement Solution contains the MIS instrumentation module providing no less 
than 6 high specification test and measurement instruments in one compact module. 
Ideal for design or education, or for general purpose work bench use, the system really 
is a complete laboratory on your PC.  The Measurement Solution is fully compatible 
with other SYSTEM 8 Solutions. 
 
SYSTEM 8 Power Supply Solution. 
The SYSTEM 8 Power Supply Solution contains the VPS module and provides the 
necessary supply voltages to the unit under test to allow other SYSTEM 8 modules to be 
utilised in fault-finding. The three output voltages are variable in both voltage and current 
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making the Power Supply Solution suitable for a wide variety of applications. 

LinearMaster Compact. 

A hand held out of circuit analogue IC tester 

ChipMaster Compact. 

A hand held out of circuit digital IC tester 
 
For further details of these and other ABI products and accessories visit our Website, contact 
your local distributor or contact ABI as detailed above. 

Self Test Diagnostic Results 
The self test diagnostic results provide information on the status of the hardware.  To run the 
self test diagnostics, select Self Test Diagnostics from the Tools menu.  This will run a self 
test on all hardware and display any errors that occur. 
 
In the event of a fault occurring with any hardware it will be highlighted on one of the 
diagnostic screens.  A summary of the diagnostic results is shown below.  Note that further 
information about any indicated fault can be displayed by clicking the Extended Diagnostic 
Fault Information button. 

MIS 3  

System Status Information 

 
Diagnostic result: Displays the overall self test diagnostic result (PASS / 

FAIL) 
Software version: Displays the currently installed software version 
Number of MIS 3 modules: Displays the number of MIS modules detected (0 or 1) 
Interface method: Displays the currently selected interface method together 

with its selected address 
Firmware version: Displays the version number of the firmware installed in the 

interface card 
Firmware test: Displays the firmware checksum test result (PASS / FAIL) 
RAM test: Displays the interface card RAM test result (PASS / FAIL) 

MIS 3 Instrument Test Results 

 
LCAs: Displays the LCA configuration results for both boards 

(PASS / FAIL) 
EEPROMs: Displays the EEPROM checksum test results for both 

boards (PASS / FAIL) 
Universal I/O: Displays the universal I/O test result (PASS / FAIL) 
Auxiliary PSU: Displays the auxiliary PSU test result (PASS / FAIL) 
Digital multimeter: Displays the digital multimeter test result (PASS / FAIL) 
Frequency counter: Displays the frequency counter test result (PASS / FAIL) 
Function generator: Displays the function generator test result (PASS / FAIL) 
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Digital storage oscilloscope: Displays the DSO test result (PASS / FAIL) 
 
All the above results will be displayed as UNDEFINED if the software is in Demonstration 
Mode.  The software will enter demonstration mode if no MIS 3 hardware is detected. 

BFL 

System Status Information 

 
Diagnostic result: Displays the overall self test diagnostic result (PASS / 

FAIL) 
Software version: Displays the currently installed software version 
Number of BFL modules: Displays the number of BFL modules detected (BFL = 0, 1, 

2, 3, 4) 
Interface method: Displays the currently selected interface method together 

with its selected address 
EPROM version: Displays the version number of the EPROM installed in the 

interface card 
EPROM test: Displays the EPROM test result (PASS / FAIL) 
RAM test: Displays the RAM test result (PASS / FAIL) 

BFL Instrument Test Results 

 
Drive Channel test: Displays the drive channels test result (PASS / FAIL) 
BDO test: Displays the BDO test result (PASS / FAIL) 
Primary PSU test: Displays the primary PSU test result (PASS / FAIL) where 

fitted 
Secondary PSU test: Displays the secondary PSU test result (PASS / FAIL) 

where fitted 
Number of channels: Displays the number of installed channels 
Multiplexer: Displays Installed or Not Found.  Note that the Multiplexer 

is now obsolete. 
 
All the above results will be displayed as UNDEFINED if the software is in Demonstration 
Mode.  The software will enter demonstration mode if no BFL hardware is detected. 

ATS 

System Status Information 

 
Diagnostic result: Displays the overall self test diagnostic result (PASS / 

FAIL) 
Software version: Displays the currently installed software version 
Number of ATS modules: Displays the number of ATS modules detected (0 or 1) 
Interface method: Displays the currently selected interface method together 

with its selected address 
EPROM version: Displays the version number of the EPROM installed in the 
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interface card 
EPROM test: Displays the result of the EPROM test (PASS / FAIL) 
RAM test: Displays the result of the RAM test (PASS / FAIL) 

ATS Instrument Test Results 

 
LCA 0: Indicates whether LCA 0 has successfully programmed or 

not (PASS / FAIL) 
EEPROM test: Displays the result of the EEPROM checksum test (PASS / 

FAIL) 
High voltage power supply test: Displays the result of the high voltage power supply test 

(PASS / FAIL) 
Analogue V-I probe test: Displays the result of the V-I probe test (PASS / FAIL) 
Pulse generator test: Displays the result of the pulse generator test (PASS / 

FAIL) 
Number of analogue V-I channels: Display the number of analogue V-I channels 
Analogue IC tester:  PASS/FAIL or NOT FOUND if no IC tester module (AICT) 

detected 
 
Note: The Analogue IC tester is an option and therefore may not be present even if the ATS 
V-I Solution is installed.  All the above results will be displayed as UNDEFINED if the 
software is in Demonstration Mode.  The software will enter demonstration mode if no ATS 
hardware is detected. 

VPS 

System Status Information 

 
Diagnostic result: Displays the overall self test diagnostic result (PASS / 

FAIL) 
Software version: Displays the currently installed software version 
VPS modules detected: Displays the number and type of VPS modules detected (A, 

B or A+B) 
Interface method: Displays the currently selected interface method together 

with its selected address 
EPROM version: Displays the version number of the firmware installed in the 

interface card 
EPROM test: Displays the firmware checksum test result (PASS / FAIL) 
RAM test: Displays the interface card RAM test result (PASS / FAIL) 

VPS Instrument Test Results 

 
Lattice: Displays the Lattice IC test result (PASS / FAIL) 
EEPROM test: Displays the EEPROM checksum test result (PASS / FAIL) 
+HT supply test: Displays the high voltage supply test result (PASS / FAIL) 

where fitted 
+V supply test A: Displays the positive supply A test result (PASS / FAIL) 

where fitted 
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-V supply test A: Displays the negative supply A test result (PASS / FAIL) 
where fitted 

Logic supply test: Displays the logic supply test result (PASS / FAIL) where 
fitted 

+V supply test B: Displays the positive supply B test result (PASS / FAIL) 
where fitted 

-V supply test B: Displays the negative supply B test result (PASS / FAIL) 
where fitted 

 
All the above results will be displayed as UNDEFINED if the VPS is in Demonstration Mode.  
The software will enter demonstration mode if no VPS hardware is detected. 

ATM 

System Status Information 

 
Diagnostic result: Displays the overall self test diagnostic result (PASS / 

FAIL) 
Software version: Displays the currently installed software version 
Number of ATM modules: Displays the number of ATM modules detected (0 or 1) 
Interface method: Displays the currently selected interface method together 

with its selected address 
EPROM version: Displays the version number of the firmware installed in the 

interface card 
EPROM test: Displays the firmware checksum test result (PASS / FAIL) 
RAM test: Displays the interface card RAM test result (PASS / FAIL) 

ATM Instrument Test Results 

 
Drive Channel test: Displays the drive channels test result (PASS / FAIL) 
BDO test: Displays the BDO test result (PASS / FAIL) 
Number of channels: Displays the number of installed channels 
 
All the above results will be displayed as UNDEFINED if the ATM is in Demonstration Mode.  
The software will enter demonstration mode if no ATM hardware is detected. 

Software Support 
ABI believes that it has a duty to support users who have invested in our equipment, and we 
also believe it is unfair to regard support as a means of generating income.  That is the 
reason we provide all our customers with a two year hardware parts and labour warranty. 
 
If you purchase an ABI product you will receive support free of charge for your two year 
warranty period.  During this time you may send us product support queries via e-mail or fax 
detailing the nature of your problem.  We will do our best to help you get the best from your 
purchase, but please remember that support is not the same as training.  Should you require 
training we will be happy to arrange training courses for you and your staff on request. 
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While SYSTEM 8 Premier is a quality piece of software, it will occasionally be necessary to 
release service releases.  Where a service release is necessary the release will be available 
free of charge from our Internet site.  As part of ABI's commitment to innovation, new 
software will be developed which enhances existing produces and incorporates any new 
product developments.  These innovations will be available for a reduced upgrade fee to 
existing users of SYSTEM 8 Premier. 

Hardware Support 
All ABI products are supplied with a 2 year parts and labour return to base warranty.  If the 
event of a problem with your product, to upgrade your hardware to the latest version, or to 
take advantage of our calibration service, contact ABI Electronics Limited or your local 
distributor for help and advice. 

Calibrating Instruments 
Calibration of the system should be performed by ABI or an authorised distributor, who has 
the necessary equipment and software to ensure that your system is calibrated correctly.  In 
particular, the precision instruments in the MIS module require special high accuracy 
equipment for calibration and cannot be calibrated by the user.  Contact ABI Electronics Ltd 
or your dealer for details of calibration services. 

Safety Notice 
All SYSTEM 8 hardware modules with the exception of the VPS module are designed to be 
installed in a standard 5.25 inch drive bay in your PC and powered from your PC supply, or in 
an external case supplied by ABI.  The VPS module requires a mains transformer and can 
only be mounted in a special version of the external MultiLink case. 
 
Operation in any other configuration or with any other form of power supply is not supported 
and will invalidate your warranty. 
 
The BoardMaster range is designed to be operated from 240V AC, 50/60Hz power supply 
with safety ground but is also available in 110V AC, 50/60Hz when specified at time of order.  
Please check that the rating label on the back of the unit is compatible with your local supply 
before connecting.  The power cable colour codes are as follows:- 
 

Europe: 
Live: Brown 
Neutral: Blue 
Earth (ground): Green/Yellow 
 
USA: 
Live: Black 
Neutral: White 
Ground: Green 
 

Mains Fuse - mains power cord fused plug - 13A fuse to BS 1362. 

Instrument Design Manager 
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The Instrument Design Manager allows you to design your own instrument layouts, or to 
modify the appearance of the built in layouts.  You can design your own instruments using 
drag and drop editing of the extensive library of instrument controls, readouts and displays.  
You can edit instrument captions, titles and labels, and add bitmaps for meaningful layouts.  
You can simplify screen layouts by eliminating unnecessary channels and controls and by 
combining measurement resources in one window.  For example, if your application uses 
only one channel of the DSO, you can design a special version of the DSO instrument with 
the other channel removed. 
 
The Instrument Design Manager allows instruments in the MIS (Multiple Instrument Station) 
and VPS (Variable Power Supply) modules to be designed and modified.  Instruments in the 
BFL, ATS and ATM modules use fixed designs and cannot be edited. 
 
With the Instrument Design Manager you can Design a New Instrument from scratch, or you 
can Edit an Existing Instrument.  You can also Copy an Existing Instrument to customise it to 
your own requirements.  The SYSTEM 8 Premier software is supplied with a standard range 
of instrument layouts covering most test and measurement requirements. 
 
When you have designed a new instrument, you can use the Customising the Instruments 
Menu function to include it in the Instruments menu and the tool bar.  Your customised 
instrument can then be used in the same way as the built-in instruments.   

Designing a New Instrument 

To design a new SYSTEM 8 Premier instrument, select Instruments > Design New 
Instrument from the menu. 
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An empty instrument window appears together with the Instrument Design Manager window.  
Enter the title for your instrument in the Instrument title entry box.  The title will be used as 
the caption for the instrument when you open it.  If you wish, you can also enter Instrument 
hint text which will display when your mouse cursor hovers over the instrument menu 
commend or icon (see Customising the Instrument Menu for further details).  The two check 
boxes are for internal use only; we recommend that you do not change these settings. 
 
Click Save Design to save your new instrument design using a file name of your choice with 
the lyt extension. 
 
In the Instrument Design Manager window you will see several control tabs, each containing 
different types of instrument controls.  A summary of the types of control follows: - 
 

Gen: Contains generic controls such as a text box, group box and action 
buttons to enhance the appearance of your layout. 

 

DMM: Contains instrument controls and displays for the digital multimeter.  
FG: Contains instrument controls and displays for the function generator.  
FC: Contains instrument controls and displays for the frequency counter.  
APS: Contains instrument controls and displays for the auxiliary power 

supply. 
 

UIO: Contains instrument controls and displays for the universal 
inputs/outputs. 

 

DSO: Contains instrument controls and displays for the digital storage 
oscilloscope. 
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VPS: Contains instrument controls and displays for the variable power 
supply. 

 

TFL: Contains instrument controls and displays for the TestFlow.  
 
If you select a control by clicking it, you can place it on your new instrument by clicking on the 
blank instrument window.  You can then Move, Resize, Delete or Edit the control. 

Copying an Existing Instrument 

To copy an existing SYSTEM 8 Premier instrument, select Instruments > Design New 
Instrument from the menu. 
  

 
 
An empty instrument window appears together with the Instrument Design Manager window.  
Click Load Design and select the file name of the instrument you wish to edit.  Click Open 
to open the file you wish to copy and display the instrument on the screen.  
 
Click Save Design to save the instrument design using a new file name of your choice with 
the .lyt extension. 
 
If the instrument you wish to copy is already open, right click anywhere on the background of 
the instrument.  When the pop-up menu appears left click Design Instrument to open the 
Instrument Design Manager, and then follow the instructions given above. 
 
To make changes to the instrument, follow the instructions given in Designing a New 
Instrument. 

Editing an Existing Instrument 

To edit an existing SYSTEM 8 Premier instrument select Instruments > Design New 
Instrument from the menu. 
 

 
 
An empty instrument window appears together with the Instrument Design Manager window.  
Click Load Design and select the file name of the instrument you wish to edit.  Click Open 
to open the file and display the instrument on the screen.  
 
If the instrument you wish to edit is already open, right click anywhere on the background of 
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the instrument.  When the pop-up menu appears left click Design Instrument to open the 
Instrument Design Manager. 
 
To make changes to the instrument, follow the instructions given in Designing a New 
Instrument. 

Editing Controls 

You can only edit, move, resize or delete a control on a SYSTEM 8 Premier instrument if you 
are in Design instrument mode.  If you have just loaded or created an instrument, you will 
already be in Design instrument mode.  If not, enter Design instrument mode by 
right-clicking anywhere on the background of the instrument.  When the pop-up menu 
appears, left click Design instrument to open the Instrument Design Manager. 

Moving Controls 

To move a control on a SYSTEM 8 Premier instrument, click it and drag to a new position 
using the mouse.  A grid of 4 pixels will be used to aid alignment of controls.  You can make 
fine adjustments to the position by using the cursor keys.  Alternatively, you can edit the Top 
and Left Properties in the window to specify the new position of the control. 

Resizing Controls 

To change the size a control on a SYSTEM 8 Premier instrument, select it by clicking with the 
mouse.  Point to an edge or corner of the control with the mouse until a grab handle (a 
double ended arrow symbol) appears.  Click and drag the drag handle to resize the control.  
A grid of 4 pixels will be used to aid alignment of controls.  To make fine adjustments edit the 
Height and Width Properties. 

Deleting Controls 

To delete a control from a SYSTEM 8 Premier instrument, select it by clicking with the mouse.  
Press the Delete key to permanently remove it from the instrument. 

Editing Controls 

When you select a control by clicking on it, you will then see a table of Properties which you 
can change to alter the behaviour and/or appearance of your instrument design.  The name 
of the property is shown in the left hand column, and the value in the right hand column.  You 
can click in the value column to change the value of the property only, either by typing in a 
new value or by selecting from a pick list. 
 
If a control overlaps another control, you can specify the Z order (the order in which the 
controls are viewed) by right-clicking on the control and clicking with Send to Back or Bring 
to Front from the pop-up menu.  For example, if you place a group box control on your 
layout, it might hide other controls which were already present.  To correct this, right-click on 
the group box and select Send to Back to make the previous controls visible again 

Instrument Designer TestFlow Controls 

The following controls and a summary of their common Properties are available on the 
TestFlow tab of the Instrument Design Manager. 
 

Control Function 
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 A control that displays a list of all records in a test flow. 

 A button used to perform some action associated with manipulating 
records in a TestFlow. 

 An edit box used to display the instructions associated with the current 
TestFlow record. 

 A group of buttons used to set the mode of execution of a TestFlow. 

 A control that displays the result of the TestFlow comparison. 

 A control that displays a specified webpage or HTML file. 

 A control that displays a specified document file e.g. PDF. 

 A control that displays a specified video file e.g. AVI, WMV. 

 A control that changes the Play/Pause/Stop state of a video which it is 
assigned to. 

 A control that displays the current position within the video to which it is 
assigned. 

 A control which opens a browse window allowing files to be opened in a 
control to which it is assigned. 

Instrument Designer VPS Controls 

The following controls and a summary of their common Properties are available on the VPS 
(Variable Power Supply) tab of the Instrument Design Manager. 
 

Control Function 

 A button to switch the supply on or off. 

 An indicator, representing an LED, which displays whether the supply is 
on or off. 

 A control used to set values associated with the VPS, such as current 
limits. 

 A display used to indicate the value of a VPS measurement. 

 An indicator, displaying text, which shows whether the supply is on or off. 

 Text describing the specification of the VPS. 

Instrument Designer Universal Inputs/Outputs Controls 

The following controls and a summary of their common Properties are available on the UIO 
(Universal Inputs/Outputs) tab of the Instrument Design Manager. 
 

Control Function 

 A scrollbar control used to set the value of an analogue channel. 

 An indicator, representing an LED, which displays the state of an 
analogue channel. 

 An entry box control used to set the value of an analogue channel. 

 A group of buttons used to determine whether an analogue channel is an 
input or an output. 

 A group of buttons used to determine whether an analogue channel is 
setting/measuring volts or amps. 



ABI Electronics Ltd   Page 26 

 A display used to indicate the value of an analogue channel. 

 An entry box control used to set the value of an analogue channel by 
entering a number, or by using up / down arrow buttons. 

 An indicator, representing an LED, which displays the state of a digital 
channel. 

 A group of buttons used to determine whether a digital channel is set 
high / low, or whether it is set to be an input. 

 An indicator, displaying text, which shows the settings for an analogue 
channel. 

Instrument Designer Auxiliary Power Supply Controls 

The following controls and a summary of their common Properties are available on the APS 
(Auxiliary Power Supply) tab of the Instrument Design Manager. 
 

Control Function 

 A button to switch the supply on or off. 

 An indicator, representing an LED, which shows whether the supply is on 
or off. 

 A display used to indicate the value of an APS measurement. 

 An indicator, displaying text, which shows whether the supply is on or off. 

 Text describing the specification of the APS. 

Instrument Designer Generic Controls 

The following controls and a summary of their common Properties are available on the 
Generic tab of the Instrument Design Manager. 
 

Control Function 

 A text box containing free text to annotate your layout. 

 A button used to perform some action on a calculator, such as open or 
run a FormulaPlus program, or perform a user definable action. 

 A group box used to group related controls on your layout. 

 A button used to close an instrument and return to the previous one. 

 A button associated with a help file and context number. 

 A button used to open another instrument from the current one. 

 A viewer that displays a picture on your layout. 

 An edit box where a FormulaPlus program can be entered. 

 A display used to indicate the result of a FormulaPlus program. 

 A control that allows a predefined FormulaPlus program to be selected. 

 A bar graph display indicating the value calculated by FormulaPlus in 
analogue form, and also used for comparing the value with a target. 

 An entry control used for setting the target value and tolerances for the 
bar graph control. 

 A checkbox control to enable a comparison within a TestFlow. 
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 A label for a calculator entry box. 

 A display used to indicate the minimum, maximum and average values 
of the measurement. 

Instrument Designer Function Generator Controls 

The following controls and a summary of their common Properties are available on the FG 
(Function Generator) tab of the Instrument Design Manager. 
 

Control Function 

 A scrollbar used to set various FG values, such as the frequency, 
amplitude etc. 

 A display used to indicate the value of a FG setting, such as the 
frequency, amplitude etc. 

 A group of buttons used to set the wave shape. 

 A checkbox control used to set whether frequency locking should be 
used. 

 A control used to set the impedance of the externally connected circuit. 

 A display used to indicate the FG settings. 

 A control used to set the frequency range in use. 

 A display used to measure the actual frequency output. 

 A button used to trigger a pulse. 

 A group of buttons used to set the modulation type. 

 A button used to perform some action on the FGEN, such as setting to a 
predefined duty cycle, a sweep setting, etc. 

 Text describing the specification of the FGEN. 

Instrument Designer Frequency Counter Controls 

The following controls and a summary of their common Properties are available on the FC 
(Frequency Counter) tab of the Instrument Design Manager. 
 

Control Function 

 A display used to indicate the value of a FC measurement. 

 A control to select the frequency measurement range. 

 A bar graph display indicating the measured value in analogue form, and 
also used for comparing the measured value with a target. 

 A control to select the measurement mode, such as frequency, RPM etc. 

 A display used to indicate the minimum, maximum and average values of 
the measurement. 

 A button used to clear the statistics. 

 A control used to select frequency or event mode. 

 A control used to select between level or pulses when in event mode. 

 A control used to select the event mode polarity. 

 A control used to select the event mode duration. 
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 An entry control used for setting the target value and tolerances for the 
bar graph control. 

 A button to start/stop the FC when in event mode. 

 A button to zero the counters when in event mode. 

 A checkbox control to enable a comparison within a TestFlow. 

 Text describing the specification of the FC. 

Instrument Designer Digital Storage Oscilloscope Controls 

The following controls and a summary of their common Properties are available on the DSO 
(Digital Storage Oscilloscope) tab of the Instrument Design Manager. 
 

Control Function 

 A display showing the waveform measured by the DSO. 

 A scrollbar used to adjust the value of a DSO setting, such as the offset 
on channel 1. 

 A group of buttons used to select the acquisition mode. 

 A group of buttons used to set the channel coupling. 

 A control used to select the volts per division for a channel. 

 A control used to select the trigger source. 

 A group of buttons used to select the trigger edge. 

 A control used to select the timebase. 

 A grid control used to display measurements taken from the DSO. 

 A button used to store / clear comparison waveforms. 

 A control that displays the result of a comparison with a stored waveform. 

 Text describing the specification of the DSO. 

 A control to set whether an item on the DSO, such as the trace on 
channel 1, is visible or not. 

Instrument Designer Digital Multimeter Controls 

The following controls and a summary of their common Properties are available on the DMM 
(Digital Multimeter) tab of the Instrument Design Manager. 
 

Control Function 

 A display used to indicate the value of a DMM measurement. 

 A group of buttons used to select the measurement mode. 

 A bar graph display indicating the measured value in analogue form, and 
also used for comparing the measured value with a target. 

 A display used to indicate the minimum, maximum and average values 
of the measurement. 

 A button used to clear the statistics. 

 An entry control used for setting the target value and tolerances for the 
bar graph control. 

 A checkbox control to enable a comparison within a TestFlow. 
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 Text describing the specification of the DMM. 

TestFlow Automatic Test Manager 
The TestFlow Automatic Test Manager allows you to design your own step by step test 
procedures for automatic PASS/FAIL testing of boards or complete assemblies.  You can 
use a combination of the built-in instruments, or even design your own instruments with the 
Instrument Design Manager, to develop a test and measurement procedure for almost any 
application.  Measurements and waveforms can be compared against target values, with 
programmable tolerances, and a PASS/FAIL result obtained.  On-screen operator 
instructions, including pictures, can be used to guide the operator through the procedure. 
 
For each step, all instrument settings, target measurement values, tolerances, user 
instructions, pictures and screen layouts are saved in a single record in a TestFlow file.  The 
file can contain an unlimited number of records to enable complex tests to be developed.  As 
all the test parameters are stored, repeatability and consistency of test results is assured. 
 
To produce a TestFlow, you perform the following steps: - 
 
1. Create a New TestFlow by opening the TestFlow Automatic Test Manager. 
2. Edit an existing TestFlow to add, copy or delete records, or to amend the settings in a 

record. 
4. Single Step or Run the TestFlow to debug the test flow. 
 
When you have finished editing or running your TestFlow procedure, close the TestFlow 
window to revert to normal operation. 
 
Once a TestFlow has been created it can be run again and again. 

Creating a New TestFlow Procedure 

To create a new TestFlow, select File > New TestFlow from the menu, or click on the  
icon.  Enter a suitable filename for your new TestFlow and click Save.  A TestFlow 
Automatic Test Manager window will appear containing one record: - 
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1. The Edit button on the Edit/Step/Run control should already be selected. 

2. Select Step 1 by clicking on it and click again to enter rename mode (do not 
double-click), then type in a name for the first test step. 

3. Fill in the Test Instructions field with free format text to guide the operator through the 
test procedure for this step. 

4. Open the instruments you wish to use for this test step, resize them and position them 
where you want on the screen.  Or use the Add Media button to quickly add videos, 
images, document and web pages to this step. 

5. Set all instrument controls to the required settings and ranges, depending on the nature 
of the tests you wish to perform. 

6. Set all target measurement values.  For example, you can use Compare Measurement 
Results to save multimeter and frequency counter measurements, and you can use the 
DSO Waveform Comparison function to store DSO waveforms. 

7. Select File > Save TestFlow As from the menu, or click the  icon, to save the 
TestFlow procedure under a new filename.  Enter a filename for your TestFlow and 
click Save. 

8. Use the Edit an Existing TestFlow function to add additional records, delete records or 
re-order records in your TestFlow procedure. 

Editing an Existing TestFlow 

To open a TestFlow file for editing select File > Open TestFlow from the menu or use the 

 icon on the toolbar. 
 
Select the file you wish to edit and click Open.  After opening the TestFlow file, you can 
make changes to it by editing.  The following editing functions are provided:- 

Re-ordering TestFlow records 

In the TestFlow Automatic Test Manager window, each TestFlow record is represented by an 
icon and the test step name.  The currently selected record is highlighted.  To select a 
record, click on it, and the instruments contained in the record will automatically open and 
restore the previously saved control settings.  To change the order of the records with the 
TestFlow procedure, you can click and drag the record to its new position with the mouse. 

Adding and deleting records 

To add a new TestFlow record, click the Add button.  A new blank record will be added to 
the end of the file, regardless of the position of the currently selected record.  Click Delete to 
remove a record.  Note that you can insert a record anywhere in the file by adding it at the 
end and then dragging it to the desired position with the mouse. 

Copying a new record 

To copy a TestFlow record, click the Copy button.  An exact copy of the currently selected 
record will be inserted immediately after it.  All instrument settings, screen layouts and text 
will be identical. 

Editing an individual record 
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You can change the instrument settings or screen layouts at any time by operating the 
instrument controls in the normal way.  You can also rename the record name and test 
instructions by typing in new text. 

Saving the modified file 

After changing the TestFlow file, select File > Save from the menu, or use the  icon on 
the toolbar to save the file on your hard disk.  We recommend that you save the file regularly 
to avoid losing data, particularly if you are making a large number of changes. 

Running a TestFlow Procedure 

To open a TestFlow file for running select File > Open TestFlow from the menu or use the 

 icon on the toolbar. 
 
Select the file you wish to edit and click Open.  After opening the TestFlow file, you can 
make run it manually using single stepping, or automatically. 

Single Stepping a TestFlow 

When user intervention is required (for example to change test clips), the TestFlow should be 
run in step mode. 
 

 
 
1. Click on the step button to place the TestFlow into single stepping mode. 
2. If the test passes, a green tick  appears next to the TestFlow record.  If the test fails, 

a red cross  appears next to the TestFlow record. 
3. Click on the next button to move to the next record. 
 
To navigate to a specific record in the TestFlow, click on the record number to select it. 

Running a TestFlow Automatically 

When user intervention is not required (except at the start and end of the test), the TestFlow 
should be run in automatic mode.  This allows the TestFlow to run unattended. 
 

 
 
1. Click on the run button to start running the TestFlow. 
2. If the test passes, a green tick  appears next to the TestFlow record.  If the test fails, 

a red cross  appears next to the TestFlow record. 
3. The TestFlow will move onto the next step as soon as a result is available. 

User Access Manager 
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SYSTEM 8 Premier introduces the concept of users, each with different access levels, to 
control access to the different functions of the software.  For example, you can set up a user 
who can use the system to carry out tests, but who is not allowed to edit or modify files. 
 
When the software is installed there is only a single user, the Administrator.  The 
Administrator has access to all software features.  If you wish, you may continue to use the 
software in this way without setting up any additional users.  If you intend to add users we 
recommend that you set a password for the Administrator. 
 
To add, remove, change, or edit a user select Tools > User Access Manager from the 
menu. 
 

 
 
From this dialog box, you can perform the following operations: 
 

Add a New User 
Remove an Existing User 
Edit the Settings for an Existing User 
Change the Currently Active User 

Creating a New User 

To manage users you need to select Tools > User Access Manager from the menu: 
 

 
 



ABI Electronics Ltd   Page 33 

To add your new user, click on the Add User button.  This opens the User Access Levels 
dialog box: 
 

 
 
Type in the desired name for the user, and a password.  If you do not wish to use a 
password, leave the Password edit box blank. 

Removing an Existing User 

To manage users you need to select Tools > User Access Manager from the menu: 
 

 
 
To remove a user, select the user you wish to remove (their user name is highlighted against 
a blue background), and press the Remove User button.  You will be asked whether you 
really wish to remove this user.  If you do, click the Yes button, otherwise click the No button. 
 
Note: The current user must have the Modify Users privilege in order to edit users.  If the 

current user does not have this privilege the Edit User button will be greyed out. 

Editing an Existing User 

To manage users you need to select Tools > User Access Manager from the menu: 
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To edit an existing user, select the user you wish to edit (their username is highlighted against 
a blue background), and press the Edit User button.  This opens the User Access Levels 
dialog box: 
 

 
 

From this dialog box you can modify the User Name, Password, and Granted Access Levels. 
 
The list of available access levels is displayed on the left, while the privileges the user actually 
has is displayed on the right.  To change the access levels granted to this user, use the 
following controls to move access levels between the two lists: 
 

> Add the selected function to the Granted Access Levels list 
>> Add all functions to the Granted Access Levels list 

< Remove the selected function from the Granted Access Levels list 
<< Remove all functions from the Granted Access Levels list 

Selecting a Different User 

To manage users you need to select Tools > User Access Manager from the menu: 
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To change to a different user, select the user you want to change to and click on the Select 
User button.  If a password has not been assigned to that user, the user will automatically be 
made current, otherwise a password entry dialog box will open: 
 

 
 
If, when you click the OK button, the password is not correct, you will be informed and given 
the opportunity to enter it again. 
 
The current user is indicated by the text [Current] being appended after the user name.  
Click the OK to accept these changes, or Cancel to leave the current user unchanged. 

MIS Front Panel 
This is the MIS front panel: 
 

 
 
All of the connectors on the front panel are industry standard connectors and accommodate 
standard probes and test cables. 
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The MIS Function Generator 
The MIS Function Generator produces sine, square, triangle or single pulse waveforms 
between 0.1Hz to 10MHz via a 50 ohm output impedance BNC connector on the front panel.  
The amplitude, DC offset and duty cycle can all be adjusted.  AM, FM and PWM types of 
modulation are also included, with variable modulation level.  The function generator 
contains a built in frequency counter, which can be used to display the actual frequency and 
to synthesize accurate frequencies.  A preview display gives a general impression of the 
selected waveform. 
 

  

To open this instrument, click on the Function Generator icon, or select 
Instruments > Function Generator from the menu. 

Setting the waveform and frequency 

Use the following buttons to select the type of waveform: - 
 

 Click to select sine wave output. 

 Click to select square wave output. 

 Click to select triangle wave output. 

 Click to select single pulse output. 

 Click to trigger single pulse output.  
 
Use the following controls to adjust the frequency and duty cycle of the waveform: - 
 

Range Select the desired frequency range with this selector. 
Set Frequency Adjust the scroll bar to set the desired output frequency for the chosen 

range. 
Set Duty Cycle Adjust the scroll bar to set the desired duty cycle. 
Phase Lock Select this check box to enable closed loop frequency synthesis mode.  

Note that phase locking takes an appreciable amount of time with low 
frequencies. 

 
Use the following controls to adjust the amplitude and offset of the waveform: - 
 

Amplitude Adjust the scroll bar to set the output amplitude. 
DC Offset Adjust the scroll bar to set the output amplitude. 

 
Select the modulation mode with the following buttons: - 
 

 Click to select amplitude modulation (AM) mode. 

 Click to select frequency modulation (FM) mode. 

 Click to select pulse width modulation (PWM) mode. 

 Click to select normal mode (no modulation). 
Modulation Level Adjust the scroll bar to set the modulation level. 
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Sweeping the Frequency 

The Function Generator is capable of sweeping a frequency between two frequency limits in a 
linear or logarithmic fashion.  The controls to perform this action are located in the bottom 
right hand corner of the Function Generator instrument. 
 

 
 

Select the frequency to start sweeping from then click the From button, then select the end 
frequency and click the To button.  Set how many steps are to be used to reach the final 
frequency using the scrollbar, and the time to spend between steps using the Time/step 
scrollbar. 
 
To perform a linear sweep click the Lin button, or run a logarithmic sweep by clicking on the 
Log button.  To interrupt the Function Generator mid-sweep, click on the Stop button. 
 
For more complex sweeps the FormulaPlus calculator can be used. 

Function Generator Connector 

This is a standard BNC connector that outputs waveforms of varying frequency, amplitude 
and shape. 
 
DC Offset: -7.5V to +7.5V 
Amplitude: 0V to 5V 
Frequency: 0.1Hz to 10MHz 

The MIS Digital Multimeter 
The MIS Digital Multimeter is a fully isolated 2 channel multimeter providing AC and DC 
voltage, current and resistance measurement functions. 
 

  

To open this instrument, click on the Digital Multimeter icon, or select 
Instruments > Digital Multimeter from the menu. 

 
The multimeter provides DC and AC Voltage Measurement on channels 1 and 2, and channel 
2 provides in addition Current Measurement and Resistance Measurement.  All ranges are 
switched automatically.  The inputs use shrouded connectors for operator safety, and share 
a common ground connection.   Directly beneath each display is an analogue bar meter 
which is used for Comparing Measurement Results, and a Measurement Statistics display for 
monitoring drift and stability of measurements. 

The MIS Frequency Counter 
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The MIS Frequency Counter is a 2 channel frequency counter providing frequency counting 
from 2Hz to 150MHz, in addition to event counting and RPM measurement.  Reciprocal 
mode measurement ensures accurate measurement of low frequencies without the need to 
use long gate times. 
 

  

To open this instrument, click on the Frequency Counter icon, or select 
Instruments > Frequency Counter from the menu. 

 
Channel 1 is a 50 ohm high frequency input providing Frequency Measurement up to 150MHz, 
while the 1M ohm input impedance channel 2 is designed for lower frequencies and covers 
the full range from 2Hz to 100MHz. 
 
In Event Mode, channel 2 provides the gate input for the event counter, while channel 1 is 
used for counting events. 
 
Directly beneath each display is an analogue bar meter which is used for Comparing 
Measurement Results, and a Measurement Statistics display for monitoring drift and stability 
of measurements. 

Frequency Measurement 

To measure frequency, set the Mode selector to Frequency and connect the input signal to 
either channel 1 or channel 2 as required.  Select a suitable range with the Range switch. 
 
Channel 1 is a 50 ohm input impedance high frequency channel optimised for frequencies 
between 1MHz and 150MHz.  Channel 2 is a 1M ohm input impedance channel that allows 
frequencies from 2Hz to 100MHz to be measured. 
 
The result can be displayed either as a Frequency, Period or RPM using the Display switch.  
The measurement is displayed in both digital form and on the analogue bar graph below the 
digital readout.  The bar graph can also be used for Comparing Measurement Results by 
setting target values with adjustable tolerances. 
 
Below the bar graph the Measurement Statistics for the measurement are displayed, which 
give an indication of the stability of the measurement. 

Event Counting 

To count events, set the Mode selector to Event and connect the signal to be counted to 
channel 1.  The gate signal to time the count is connected to channel 2.  The Range and 
Display switches are disabled. 
 
To start counting events, click the Start button.  You can stop at any time by clicking Stop, 
and clicking Zero can clear the count. 
 
In event mode, channel 1 of the frequency counter will count external events when the TTL 
level external gate signal is in the active logic state.  The Trigger On and Edge selectors set 
this active state.  The edge polarity can be set to Positive or Negative and can trigger on a 
Pulse or logic Level. 
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Channel 2 will display the total time, in seconds, during which the external gate signal is 
active. 
 
The event count and time are displayed in both digital form and on the analogue bar graphs 
below the digital readouts.  The bar graph can also be used for Comparing Measurement 
Results by setting target values with adjustable tolerances. 
 
Below the bar graph the Measurement Statistics for the measurement are displayed, which 
give an indication of the stability of the measurement. 
 
Below are examples of the signals to further explain the operation of event mode: 

Trigger on Pulse, Positive Polarity 

If Positive is selected in Pulse mode, channel 1 starts counting pulses when the external 
gate signal goes to a high logic level.  When the external gate signal eventually goes to a low 
logic level, pulse counting is stopped.  Even if the external gate signal goes to a high logic 
level again, no more pulses will be counted. 
 

 

Trigger on Pulse, Negative Polarity 

If Negative is selected in Pulse mode, channel 1 starts counting pulses when the external 
gate signal goes to a low logic level.  When the external gate signal eventually goes to a high 
logic level, pulse counting is stopped.  Even if the external gate signal goes to a low logic 
level again, no more pulses will be counted. 
 

 

Trigger on Level, Positive Polarity 

If Positive is selected in Level mode, channel 1 counts pulses when the external gate signal 
is at a high logic level.  When the external gate signal goes to a low logic level, pulse 
counting is stopped.  If the external gate signal goes to a high logic level again, pulses will 
continue to be counted. 
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Trigger on Level, Negative Polarity 

If Negative is selected in Level mode, channel 1 counts pulses when the external gate signal 
is at a low logic level.  When the external gate signal goes to a high logic level, pulse 
counting is stopped.  If the external gate signal goes to a low logic level again, pulses will 
continue to be counted. 
 

 

Frequency Counter Connectors 

There are 2 channels for measuring frequency and both have standard BNC connectors. 
   Channel 1: impedance = 50 ohm, max input voltage = 5V peak to peak 
   Channel 2: impedance = 1M ohm, max input = 200V peak to peak 

The MIS Auxiliary Power Supply 
The MIS Power Supply provides a fixed triple rail power supply intended for external test 
interfaces or accessories.  The power supply provides +5V at 0.5A, +9V at 0.1A and -9V at 
0.1A.  The outputs are brought out to the Analogue Outputs Connector on the Front Panel of 
the MIS module. 
 

  

To open this instrument, click Power Supply icon, or select Instruments 
>Auxiliary Power Supply from the menu. 

 
The output voltages and currents for each of the three rails are displayed on the digital 
readouts. 
 

The MIS Universal Inputs/Outputs 
The Universal Inputs/Outputs are designed for controlling external test interfaces.  Four 
bidirectional multi-mode analogue channels and four digital channels are provided.  The 
outputs are brought out to the Analogue Outputs Connector on the Front Panel of the MIS 
module. 
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To open this instrument, click on the Universal I/O icon, or select 
Instruments > Universal I/O from the menu. 

 
Each analogue channel can be programmed to be either an input or output, and can be 
further programmed in voltage or current mode.  To configure the analogue channels, click 
the following buttons: - 
 

 Configures the analogue channel in Voltage mode.  The digital readout 
shows the voltage at the external pin.  In output mode, the voltage in the edit 
box is output to the external pin. 

 Configures the analogue channel in Current mode.  In output mode, the 
current in the edit box is output to the external pin, and the digital readout 
shows -.--.  In input mode, an active clamp is used to clamp the external 
circuit to 0V, and the resulting current is shown on the digital readout. 

 Configures the channel as an Output.  In voltage mode, the voltage in the 
edit box is output to the external pin.  In current mode, the current in the edit 
box is output to the external pin. 

 Configures the channel as an Input.  In voltage mode the digital readout 
shows the voltage at the external pin.  In current mode, an active clamp is 
used to clamp the external circuit to 0V, and the resulting current is shown on 
the digital readout. 

 
To adjust the analogue output voltage or current to the required setting, click the spin box 
arrows or enter the value directly.  The output voltage can be varied from +9.0V to -9.0V in 
0.1V steps, the current from +20mA to -20mA in 100uA steps. 
 
Each digital channel can be programmed to be either an input or output.  To configure the 
digital channels, click the following buttons: - 
 

 Configure the channel as an input.  The LED indicates the logic level high 
(LED on) or low (LED off). 

 Configure the channel as a high output. 
 

 Configure the channel as a low output. 

MIS Universal Inputs/Outputs Connector 

This connector contains: 
4 Analogue input/output channels (pins 1 to 4) 
4 Digital input/output channels (pins 5 to 8) 
Auxiliary PSU +5V 0.5A output (pins 15 to 16) 
Auxiliary PSU +9V 0.1A output (pins 17 to 18) 
Auxiliary PSU -9V 0.1A output (pins 13 to 14) 
Digital ground (pin 10) 
Analogue ground (pins 11 to 12, and pins 19 to 20) 
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MIS Digital Storage Oscilloscope 
The MIS Digital Storage Oscilloscope (DSO) provides two input channels each with a 
bandwidth of 100MHz and one external trigger.  The sampling rate is 50MS/s for single-shot 
signals, and an Extended Resolution Sampling mode (ERS mode) is available which extends 
the sampling rate to 5GS/s for repetitive signals. 
 

 

To open this instrument, click on the Oscilloscope icon, or select 
Instruments > Oscilloscope from the menu. 

Acquisition 

The Acquisition buttons determine the way in which the input signal is acquired when a 
Trigger occurs.  There are four alternatives available: 
 

Single: Single mode.  Data is acquired until a trigger occurs.  Acquisition then 
continues for a time set by the Trigger Delay control, before the acquisition 
stops and the data is plotted. 

Normal: Normal mode.  Data is acquired as for Single mode, but after the data is 
plotted further acquisitions take place while ever a valid trigger occurs.  This 
continues until the user presses the Stop button. 

Auto: Automatic mode.  Data is acquired as for Normal mode, but if no trigger 
occurs within a preset time a trigger is generated internally. 

Stop: Stop acquisition.  An acquisition in progress will be abandoned. 

Trigger 

The Trigger signal is used to produce a stable waveform on the display.  The Trigger Source, 
Trigger Edge, Trigger Level, Trigger Coupling and Trigger Delay controls are used to 
configure the trigger. 

Timebase 

The Timebase control sets the time per horizontal (i.e. x-axis) division which will be used 
during an oscilloscope acquisition. 

Channel Controls 

The Channel Sensitivity, Channel Coupling and Channel Offset controls are used to configure 
the vertical (i.e. y-axis) parameters which will be used during an oscilloscope acquisition. 

Channel Maths 

The Channel Maths controls are used to perform mathematical operations on the acquired 
waveforms and to compare a waveform with a previously stored version. 

Measurements 

The Measurements grid can be used to automatically calculate and display a wide range of 
measurements on the displayed waveform for either channel. 

DSO Acquisition Modes 

In Single mode, data acquisition continues indefinitely until a valid trigger condition occurs (as 
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determined by the Trigger settings and trigger signal).  When a valid trigger condition occurs, 
data acquisition continues until a time set by the Trigger Delay control has elapsed.  The 
resultant data is plotted on the display for examination.  The acquired data may be either 
100% pre-trigger data, 100% post trigger data, or a combination of both depending on the 
trigger delay setting.  Further acquisitions only take place if the Single button is pressed 
again. 
 
In Normal mode, the acquisition sequence is identical to that of single mode described above, 
except that a further acquisition is started after the data is displayed.  After each normal 
acquisition, the display is updated with the latest data. 
 
In Auto mode, the acquisition sequence is identical to that of normal mode described above, 
except that if a valid trigger does not occur within a preset time a trigger will be automatically 
generated internally to ensure that a display is possible.  Note that in ERS mode auto 
acquisition is disabled, because a trigger is required from the signal to build the acquisition. 
 
Finally, the Stop button stops all acquisitions that are in progress. 

DSO Aliasing 

Aliasing is a term used to describe a sampling phenomenon that can occur with Digital 
Storage Oscilloscopes.  Nyquist sampling theory suggests that the sampling rate must be at 
least twice the frequency of the highest frequency in the input signal in order for it to be 
reproduced in sampled form with the correct frequency.  A high frequency signal which 
violates this sampling criterion (under sampled) can result in a lower frequency signal being 
displayed (see diagram below).  This can fool even the most experienced user.  Note that 
as the sweep speed (timebase) is reduced the sampling rate starts to reduce, which means 
that even low frequency signals can cause aliasing if the timebase setting is set too low. 
 

 
 
It is important that the user has some idea about what the signal being displayed is, and what 
frequency content to expect.  Setting the timebase appropriate to the expected waveform will 
help eliminate problems with aliasing.   
Try turning the timebase to a faster setting (increasing the sampling rate) to check if a higher 
frequency signal is present.  Often, aliased waveforms appear to drift across the screen as if 
they are not triggered properly, and this is another way of assessing if a waveform is aliased.  
Finally, measuring the frequency of the input waveform (if repetitive) using the frequency 
counter will enable the user to determine if the Nyquist criteria is being violated, resulting in 
aliasing. 

DSO Automatic Measurements 

The Measurements grid can be used to select a wide range of automatic measurements that 
are performed on the displayed waveform.  Click on the word Select in column 1 on the grid 
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and select the desired parameter to measure from the displayed pick list.  Next, click on the 
channel in column 2 and select the desired channel to measure.  The result will be displayed 
in column 3.  To remove a measurement that you no longer require, select None from the 
measurement pick list. 
 
Note that for some measurements a certain type of waveform is required.  For example, to 
measure the period requires a waveform with at least one full cycle, and to measure rise time 
requires a waveform above a certain minimum amplitude.  If, for some reason, a particular 
measurement cannot be calculated, the symbol "---" is displayed on the measurement grid. 
 
The following is a list of the available automatic measurements together with a brief 
description and formula showing how they are calculated.  Note that some measurements 
are directly measured from the waveform (e.g. Base, RMS), while others (e.g. Amplitude, 
Peak to Peak) are calculated from other measurements: 
 
Base: The dominant low voltage of a pulse or square waveform, ignoring 

undershoot.  For waveforms with no dominant level (e.g. sine or triangle 
waveforms) this is the same as the Base Peak. 

Top: The dominant high voltage of a pulse or square waveform, ignoring 
overshoot.  For waveforms with no dominant level (e.g. sine or triangle 
waveforms) this is the same as the Top Peak. 

Base Peak: The lowest voltage of the waveform, regardless of its shape. 

Top Peak: The highest voltage of the waveform, regardless of its shape. 

Amplitude: Top - Base. 

Peak to Peak: Top Peak - Base Peak. 

Mean: Sum of all voltages / 250 (There are 250 points per acquisition). 

Cyclic Mean: Sum of all voltages within an integral number of cycles / Total number of 
points within this number of cycles (provided that a periodic waveform is 
detected). 

RMS: Square root of the sum of the squares of all voltages / 250 (There are 250 
points per acquisition). 

Cyclic RMS: Square root of the sum of the squares of all voltages within an integral 
number of cycles / Total number of points within this number of cycles 
(provided that a periodic waveform is detected). 

Overshoot: 100 % * (Top Peak - Top) / Amplitude. 

Undershoot: 100 % * (Base - Base Peak) / Amplitude. 

Crest Factor: Peak to Peak / 2 * Cyclic RMS (provided that a periodic waveform is 
detected). 

V Resolution: Resolution of voltage measurements on this V/div range. 

Cycle Count: Number of complete cycles detected in the acquisition. 

Period: Total time between 50% amplitude points on successive rising or falling 
edges of a cyclic waveform / Cycle Count (provided that a periodic 
waveform is detected). 

Frequency: 1/ Period. 

Rise Time: Total time between 10% and 90% amplitude points on rising edges / 
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Number of rising edges. 

Fall Time: Total time between 10% and 90% amplitude points on falling edges / 
Number of falling edges. 

Positive Width: Total time between 50% amplitude points on positive pulses (rising then 
falling edge) / Number of positive pulses. 

Negative Width: Total time between 50% amplitude points on negative pulses (falling then 
rising edge) / Number of negative pulses. 

Positive Slew: Voltage difference between 10% and 90% amplitude points on rising edge 
/ Time difference between these points. 

Negative Slew: Voltage difference between 10% and 90% amplitude points on rising edge 
/ Time difference between these points. 

Bandwidth: 0.35 / Rise Time.  This formula is valid only for a first order system (i.e. 
with no overshoot on a rising edge) and can be used to give a VERY 
approximate estimate of the system bandwidth.  

Duty Cycle: 100% * High Pulse Width / Period. 

T Resolution: Resolution of time measurements on this time/div range. 

DSO Channel Coupling 

The Channel Coupling switch determines the way in which the input signal to the 
oscilloscope is coupled.  There are three positions: 
 

 DC Coupling.  The input signal is DC coupled. 

 AC coupling.  The input signal is AC coupled.  Frequency components below 
about 10Hz will be attenuated, and DC components will be blocked altogether. 

 Ground.  The signal is internally connected to ground.  The input BNC 
connector becomes open circuit. 

DSO Channel Maths 

The Channel Maths controls allow you to perform a range of mathematical operations on the 
acquired waveform(s).  There are two sets of controls, one for each channel, allowing 
independent maths functions for each channel: 
 
Waveform Comparison This allows a waveform from a known good circuit to be stored as 

a reference.  Another waveform can then be compared against it 
using programmable tolerances. 

DSO Channel Offset 

The Channel Offset control adds an adjustable DC offset to the input signal to allow it to be 
moved vertically on the display.  The range of adjustment is +/- 4 divisions, so on the 1V/div 
range, for example, the ground position of the trace can be adjusted in the range of +/- 4V. 
 
This control allows waveforms which are not symmetrical about ground (e.g. digital signals 
which switch in the range 0V to 5V) to be displayed with the maximum resolution possible. 

DSO Channel Sensitivity 
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The Channel Sensitivity control sets the vertical sensitivity of the oscilloscope in volts per 
vertical division.  If you are using a x1 probe, the vertical sensitivity can be adjusted from 
20mV per division to 2V per division.  Using a x10 probe will extend this range up to 20V per 
division. 

DSO ERS Mode 

For timebase settings of 0.2us/div and faster, the oscilloscope uses Extended Resolution 
Sampling to acquire a high speed waveform with more resolution than the normal single-shot 
sampling rate (50MS/s) will allow.  This is achieved by taking repeated samples of a 
repetitive waveform and interleaving the samples using proprietary hardware and software to 
reconstruct the original waveform.  With this technique, effective sampling rates of up to 
5GS/s are possible with timing resolution of 200ps. 
 
For a stable waveform display in ERS mode, a highly stable trigger is necessary, and the 
waveform must itself be highly stable with minimum timing jitter or noise.  If any of these 
conditions are not met, the reconstructed ERS waveform will appear noisy.  The waveform 
average facility can be used to recover some information. 
 
Note that an ERS acquisition of a low frequency signal will take a long time to construct, 
because a large number of acquisitions are necessary before the resulting waveform can be 
displayed. 

DSO Timebase 

The Timebase control sets the time per horizontal division that will be used during the 
acquisition.  A fast timebase allows information around the trigger point to be displayed in 
detail, whereas a slow timebase allows a larger portion of the waveform to be displayed but in 
less detail.  Normally, a fast timebase is used to acquire high frequency signals since higher 
sampling rates (more points) are required in order to reconstruct the waveform on the display. 
 
The timebase control sets the time per division for both channels.  The time base can be set 
can be set between 5ns and 5 seconds per division. 
 
The sampling rate for single shot acquisitions is 50MS/s, but for timebase settings of 0.2us/div 
or faster ERS mode is selected to give better resolution for examining high speed signals.  
Note that the timebase control also determines, indirectly, the sampling rate.  The sampling 
rate must be high enough to suit the waveform being acquired, otherwise Aliasing will occur. 

DSO Trigger 

The Trigger function is used to control the acquisition to ensure that a stable display is 
obtained showing the desired part of the waveform on the screen.  This is achieved by 
triggering on a particular voltage level of the trigger input signal, and using this point in time 
as a reference to control the acquisition  
 
Use the Trigger Source control to select the source of the trigger signal, and the Trigger Edge 
to specify the active edge to trigger on.  The trigger signal coupling can be adjusted with the 
Trigger Coupling control.  Finally, use the Trigger Level and Trigger Delay controls to 
complete the trigger setup. 

DSO Trigger Coupling 
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The Trigger Coupling control is used to select one of four options to improve triggering on 
noisy or composite waveforms, or on waveforms with large DC offsets.  The four coupling 
options are: 
 

 The DC filter leaves the trigger signal unchanged and is the most commonly 
used setting. 

  The AC filter is designed to remove the DC component of the trigger signal, for 
example a waveform that has a DC offset such as ripple on a DC power supply. 

 The Low Frequency Reject filter attenuates low frequency components (below 
about 3.5kHz), including DC, from the trigger signal.  For example, this could be 
used to trigger on a high frequency signal, which also contains mains (50/60Hz) 
ripple. 

 The High Frequency Reject filter attenuates high frequency components (above 
about 3.5kHz) from the trigger signal.  For example, this could be used to trigger 
on mains (50/60Hz) ripple on a signal that also contains high frequency noise. 

DSO Trigger Delay 

The Trigger Delay control sets the amount of pre-trigger data (i.e. data acquired before the 
trigger) which is shown on the display.  Setting the trigger delay to zero (extreme left) causes 
data only after the trigger point being displayed (100% post-trigger data).  Setting maximum 
trigger delay (extreme right) results in data only before the trigger point to be displayed (100% 
pre-trigger data).  Setting the delay to an intermediate value results in a combination of both 
depending on the trigger delay setting. 

DSO Trigger Edge 

The Trigger Edge control allows the oscilloscope to trigger on either a rising (positive) or 
falling (negative) edge.  The actual position on the edge can be adjusted in combination with 
the Trigger Level control.  The Trigger Edge can be either of the following: 
 

  Triggers on a rising (positive) edge. 

  Triggers on a falling (negative) edge. 

DSO Trigger Level 

The Trigger Level control sets the voltage level on the trigger waveform at which the trigger 
occurs.  The trigger will occur when the waveform makes a transition through this voltage 
level in the direction set by the Trigger Edge control.  The trigger level voltage is shown on 
the display next to the trigger level control. 
 
For DC trigger (DC, HF reject) and CH1/CH2 source trigger settings, a marker is shown on 
the display to show the approximate position of the trigger on the waveform. 
For AC trigger (AC, LF reject) or EXT source trigger settings, the marker is not displayed 
because the waveform may have an unknown DC offset. 
For the FG trigger source setting, the trigger level is internally fixed and can not be adjusted. 

DSO Trigger Source 

The Trigger Source is usually set to either CH1 or CH2.  The External trigger is most often 
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used when you wish to use both channels of the oscilloscope to look at signals which are 
intermittent or difficult to trigger on.  For example, when looking at microprocessor data lines 
that are not repetitive and difficult to observe, the system clock or read/write line could be 
used as a trigger by connecting it to the EXT input.  If you are using the function generator, 
you can set the trigger source to FG to automatically trigger the DSO from the function 
generator. 
 
Note that when using the FG trigger source the trigger level is fixed internally and cannot be 
adjusted. 

DSO Waveform Comparison 

With this function a known good waveform can be stored and used as a reference.  An 
acquired waveform can then be compared with it and a pass/fail result, using adjustable 
voltage and time tolerances, can be displayed. 
 
The following buttons are used to control the comparison function: 
 

 Click this button to store the waveform for the channel you want.  The currently 
displayed waveform will be saved in the internal memory, and an envelope will be 
displayed on the display representing the saved waveform with the programmed 
tolerances. 

 

 Click this button to adjust the comparison tolerances.  You can then adjust the 
voltage tolerance, time tolerance and the pass/fail percentage comparison 
threshold.  The envelope adjusts to show the effect of the changes to the 
tolerances. 

 

 Click this button to clear the waveform and disable the comparison. 
 

 The percentage (measured in terms of the total length of the trace) of the 
waveform which lies within the envelope is calculated and displayed.  The result is 
displayed in either red (fail) or green (pass) depending on the setting of the 
pass/fail tolerance. 

MIS Digital Storage Oscilloscope Connectors 

The DSO has 2 input channels and an external trigger, all with standard BNC connectors. 

MIS Digital Multimeter 

DMM Current Measurement 

To measure current, select either DC or AC as required and attach your probes in series with 
the current to be measured to the Amps socket and common.  The current meter allows 
currents up to 1A AC or DC to be measured.  The system is protected by a fuse accessible 
from the front panel. 
 
The current is displayed in both digital form and on the analogue bar graph below the digital 
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readout.  The bar graph can also be used for Comparing Measurement Results by setting 
target values with adjustable tolerances. 
 
Below the bar graph the Measurement Statistics for the measurement are displayed, which 
give an indication of the stability of the measurement. 
 
AC measurements are true RMS but the maximum accuracy is obtained with sine waveforms.  
True RMS converters have a slow discharge characteristic which can cause errors when 
measuring a small AC current immediately after measuring a large one.  Ensure that you 
allow enough time, in these circumstances, for the reading to stabilise. 
 
Warning: Do not leave your probe connected to the Amps socket after making a 
measurement.  You may inadvertently cause damage if you later try to measure voltage with 
the probe in the Amps socket. 

DMM Resistance Measurement 

To measure resistance, attach your probes to the channel 2 and common.  The multimeter 
has seven ranges as follows.  All ranges are switched automatically: 
 
Range Maximum Resolution 
1 10R 10mR 
2 100R 100mR 
3 1k 1R 
4 10k 10R 
5 100k 100R 
6 1M 1k 
7 20M 10k 

 
The resistance is displayed in both digital form and on the analogue bar graph below the 
digital readout.  The bar graph can also be used for Comparing Measurement Results by 
setting target values with adjustable tolerances. 
 
Below the bar graph the Measurement Statistics for the measurement are displayed, which 
give an indication of the stability of the measurement. 

DMM Voltage Measurement 

To measure voltage, select either DC or AC as required and attach your probes to the desired 
channel and common.  The multimeter has three ranges as follows.  All ranges are 
switched automatically: 
 
Range Maximum Resolution 
1 2V 100uV 
2 20V 1mV 
3 400V 10mV 

 
The voltage is displayed in both digital form and on the analogue bar graph below the digital 
readout.  The bar graph can also be used for Comparing Measurement Results by setting 
target values with adjustable tolerances. 
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Below the bar graph the Measurement Statistics for the measurement are displayed, which 
give an indication of the stability of the measurement.  AC measurements are true RMS but 
the maximum accuracy is obtained with sine waveforms.  True RMS converters have a slow 
discharge characteristic that can cause errors when measuring a small AC voltage 
immediately after measuring a large one.  Ensure that you allow enough time, in these 
circumstances, for the reading to stabilise. 

MIS Digital Multimeter Connectors 

These 4mm shrouded connectors accept shrouded test leads. 
 

Measurement Statistics 
The statistics information provides information regarding stability, drift and trends for the 
digital multimeter or frequency counter measurement values.  The following functions are 
provided: 

  The highest value measured since the statistics were cleared 

  The average value measured for the number of samples taken since the 
statistics were cleared 

  The lowest value measured since the statistics were cleared 

  The number of measurements taken since the statistics were cleared 
 

 Clicking this button will reset the statistics.  They will also be reset automatically 
when changing measurement mode. 

If an invalid value is measured (e.g. voltage above 400V, resistance above 20M or frequency 
out of range), the statistics will suspend updating and will resume once a valid measurement 
is obtained. 

The BFL Front Panel 
This is the BFL front panel: 
 

 

The BFL IC Identifier 
The BFL IC Identifier allows unknown ICs to be identified without typing in a part number. 
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To open this instrument, click on the Digital IC Identifier icon, or select 
Instruments > Digital IC Identifier from the menu. 

IC Size 

The user must select the size of the IC to be identified.  This is achieved using the IC Size 
list box.  The list box contains the sizes of all ICs in the identifier library. 

Circuit Types 

The user may select an in-circuit or out-of-circuit test.  The out-of-circuit test requires a 
special out-of-circuit adapter (contact your dealer for details) 

Start/Stop Buttons 

Pressing the Start button will begin the identification process.  Pressing the Stop button will 
abort the identifier instrument at any time during the test. 

Identifier Test Result 

Any identified devices and their function are listed in the result list box.  Also, equivalent 
devices are listed. 

ICs Found 

The total number of devices identified during the test is displayed in the IC’s Found box.  
This is continually updated as the test proceeds. 

Identifier Progress 

Due to the large size of the identifier library, the identifier test can be in progress a 
considerable time.  The extent to which the test has searched through the library is indicated 
in a percentage status bar at the bottom of the screen.  Initially this will indicate 0% complete.  
As the test progresses, the displayed figure will increase toward 100% (indicating completion).  
This is also indicated graphically by a blue bar which moves towards the right of the screen as 
the test progresses. 

Identifier Status 

The status of the identifier instrument is indicated as follows: 
 

Ready: The instrument is ready to start  
Searching: The instrument is searching 
Complete: The identification is complete 
Stopped: The instrument has been stopped 

 
More than one part may be found to be equivalent to the device under test.  This is usually 
due to PCB configuration and IC pin compatibility. 
 
If no parts are identified, the device under test may not be in the identifier library or the device 
may be faulty.  Alternatively factors such as test clip connection, lack of a ground clip and 
failure to disable connecting circuitry may cause parts not to be identified. 
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Note: The IC Identifier instrument can cause prolonged backdriving of components.  Please 
take steps to prevent this by disabling connected devices by removal or by using BDO 
outputs to disable them.  Linear ICs are particularly susceptible; therefore ensure that the IC 
Identifier instrument is only used on digital ICs. 

The BFL Graphical Test Generator 
The BFL Graphical Test Generator allows the BFL digital channels to be used to output a 
timing sequence and monitor responses. 
 

  

To open this instrument, click on the Digital Graphical Test Generator icon, 
or select Instruments > Digital Graphical Test Generator from the menu. 

 
The number of channels (256 maximum), the number of patterns (230 maximum) and the 
signal type are all configurable.  Each channel is represented by a number which is 
displayed down the left hand side of the instrument. These numbers relate to the actual 
physical channel number on the front connector. The pattern number is displayed at the top of 
the display, under the instrument buttons. 

Changing Channel Numbers, Names & Types 

To change a channel number, name or type, click the mouse cursor on the appropriate 
channel name.  A green box will then highlight that channel. 

 
If the mouse is double-clicked on a channel, a channel edit box will be displayed.  This 
allows the user to change the number, name and type of the channel.  If two channels 
contain the same number, an error message will be displayed when attempting to run the 
sequence. 

Creating a Timing Sequence 

Any timing sequence can be simulated by using high and low levels.  The high and low 
levels are generated either by using the mouse cursor and double-clicking on a trace pattern 
or by using the keyboard keys "0" (Drive Low), "1" (Drive High),"X" (Don't care), "L" (Sense 
Low), "M" (Mid Level) and "H" (Sense High).  A green box will then highlight the part of the 
trace being edited. 

  
The existing state of the trace will be displayed as a 0 (Drive Low), 1 (Drive High), X (Don't 
care), L (Sense Low), M (Mid Level) and H (Sense High).  Double-clicking on this level will 
toggle it to the next state. 
 
Channels defined as outputs from the system (inputs to the unit under test) can be 
programmed as either 0 (Drive Low) or 1 (Drive High). Channels defined as inputs to the 
system (outputs from the unit under test) can be programmed as L (Sense Low), M (Mid 
Level), H (Sense High) or X (Don't care). Channels defined as bidirectional can be 
programmed to any of the states. 
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Save Button 

Once a trace has been set up, it can be saved to a file by pressing the Save button.  A 
window will appear, prompting for a filename.  Enter a filename and the sequence will be 
saved under that name, with the extension .PAT. 

Learn Button 

Once the required outputs from the system have been programmed, it is possible to learn the 
response of the inputs by pressing the Learn button. 

Open Button 

The Open button opens and loads a previously saved file.  A box will appear and all 
available .PAT files will be displayed.  Choose a file and press OK to load it. 

Run Button 

The Run button begins the logic sequence as defined by the traces.  The sequence of high 
and low pulses is output to the front connector on the BFL module.  The PSU and Outputs 
indicators show when the BFL power supply is turned on and when the output channels are 
being driven. 

Clear Button 

The Clear button will clear any changes made to the traces, and will set all traces back to a 
low state.  All the channel names and numbers are set back to their original (default) state. 

Setup Button 

The Setup button allows the user to configure the number of usable channels, patterns, test 
threshold levels and whether the power supply and outputs should be turned off at the end of 
the test. 

Delete Button 

The Delete button will delete a row or column, depending on which part of the trace is 
highlighted.  If a channel name is highlighted and the delete button is pressed, the entire 
selected channel is deleted.  If a particular point on a trace (a cell) is highlighted and the 
delete button is pressed, then that column on every channel will be deleted. 

Insert Button 

The Insert button will insert a row or column, depending on which part of the trace is 
highlighted.  If a channel name is highlighted and the insert button is pressed, a new channel 
and trace will be inserted directly before the selected channel.  If a particular point on a trace 
(a cell) is highlighted and the insert button is pressed, a new column is inserted on every 
channel directly before the selected cell. 

The BFL IC Live Comparison 
The BFL IC Live Comparison function allows two identical boards to be powered and 
compared at the same time. 
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To open this instrument, click on the Digital IC Live Comparison icon, or 
select Instruments > Digital IC Live Comparison from the menu. 

 
One of the most efficient methods to repair a PCB is to compare a suspect board with a 
known good board.  Highlighted differences between the boards can quickly lead to fault 
diagnosis.  The IC Live Comparison instrument allows a suspect board to be compared 
directly with a known good board or Golden Board.  In a 128 channel system, the suspect 
device is clipped by channels 1 to 64 and the master by channels 65 to 128.  In a 256 
channel system, the suspect device is clipped by channels 1 to 128 and the master by 
channels 129 to 256. 

Part Button 

The Part button is used for selecting the part you wish to test.  When pressed, you are 
presented with a box allowing you to select the part you wish to test for the appropriate library.  
For more information on selecting a part, see Selecting Part to Test. 

Setup Button 

The Setup button is used to configure the test parameters.  In the Setup Test Parameters 
box it is possible to configure a particular test to the requirement of the IC under test.  The 
tolerances used in the comparison of the V-I characteristic and the voltage tests may also be 
selected. 

Start Button 

The Start button will execute the tests which have been enabled in the Setup Test 
Parameters box using the configured parameters.  If no part has been loaded, the message 
No Part Loaded is displayed and no test will be executed.  When the ‘IC Live Comparison 
has started, the master device and suspect device are both tested and their resulting test 
signatures are compared.  Any differences between the two test signatures will be 
highlighted. 

Stop Button 

The Stop button will stop any test which is currently running.  This will only usually apply 
when running tests in one of the loop modes. 

Analysis Button 

The Analysis button displays the Analysis Information dialogue box which includes extended 
test result information (if no test has been executed this button will be greyed). 

IC / DV-I Button 

This button toggles (switches) between the truth table test display (IC diagram) and the Digital 
V-I (DV-I) test display.  The text on the button indicates which result display is currently 
shown.  All colours corresponding to the DV-I trace can be configured using the Select DV-I 
Trace Colours function. 

Actual / Master Button 

The Actual button is used to toggle the current result display between the actual (device 
under test) and the master (golden device).  The expected Master signature of the device 
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can be viewed by toggling the ‘Actual/Master’ button to show 'Master’.  The package display 
of the master and the actual result must be viewed separately.  The package pin names will 
be highlighted in red if there are comparison differences on individual pins.  The master DV-I 
characteristic will be displayed in green and superimposed onto the actual trace of the current 
board, which is displayed in yellow.  All colours corresponding to the DV-I trace can be 
configured. 

The << and < Buttons 

When viewing DV-I traces the << and < buttons will be active.  If there are many DV-I traces 
on the screen (up to 8) then the << button can be used to view the previous set of traces.  If 
you have zoomed into a single trace, the < button can be used to select the previous full 
trace. 

The >> and > Buttons 

When viewing DV-I traces the >> and > buttons will be active.  If there are many DV-I traces 
on the screen (up to 8) then the >> button can be used to view the next set of traces.  If you 
have zoomed into a single trace, the > button can be used to select the next full trace. 

V-I Result Comparison 

In each of the DV-I display boxes, a percentage figure is displayed which indicates the result 
of the DV-I comparison for each particular pin.  The figure denotes the degree of similarity 
between all of the points on the master characteristic and those on the corresponding pin of 
the device under test.  A percentage figure of below 95% is considered a bad comparison, 
and the percentage result will be displayed in red to indicate this.  The tolerance of this 
comparison can be selected from the setup dialogue box.  Selecting the Actual / Master 
button to Master will display both the master DV-I characteristic (in green), and the DV-I 
characteristic obtained from the board under test (in yellow).  All colours corresponding to 
the DV-I trace can be configured. 

The BFL Short Locator 
The BFL Short Locator allows short circuits to be located to a very close proximity. 
 

  

To open this instrument, click on the Short Locator icon, or select 
Instruments > Short Locator from the menu. 

 
This instrument requires a separate probe set containing red and black probes.  This 
connects into the 10 way BDO connector on the BFL Front Panel.  The instrument uses a 4 
wire low resistance measuring technique to enable the location of a short circuit on a PCB to 
be found. 
 
Note: The presence of the Short Locator probes will interfere with the test results of the IC 
Tester, IC Live Comparison and IC Identifier instruments.  Ensure that the probes are 
removed when not using the Short Locator instrument. 
 
When a low resistance is measured between the two probes, a tone is generated by the PC 
speaker and the on-screen probes move toward the right of the screen.  As the probes 
become closer to the source of the short circuit, the measured resistance decreases.  This is 
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indicated by a higher pitch, and also by the displayed probes moving further to the right of the 
screen. 

Range 

This selects the full scale sensitivity of the resistance measurement.  The ranges are: 
 

0.1 Ohm: 0.0 ohms to 0.1 ohms 
1.0 Ohm: 0.0 ohms to 1.0 ohms 
2.0 Ohm: 0.0 ohms to 2.0 ohms 

Tone 

This provides an audio indication of the measured resistance between the Short Locator 
probes.  This allows the user to concentrate on following tracks on the PCB without needing 
to look at the display.  The tone may be turned On or Off by moving the control slider.  The 
tone status is indicated in both text and picture to the side of the control. 

Error Messages 

If the measured resistance is greater than the full scale of the selected range the message 
OVERFLOW will be displayed.  If the probe leads are not connected or damaged, the 
message PROBES! will be displayed. 

The BFL IC Tester 
The BFL IC Tester allows ICs to be tested in various ways without removing them from the 
printed circuit board (PCB). 
 

  

To open this instrument, click on the Digital IC Tester icon, or select 
Instruments > Digital IC Tester from the menu. 

 
Before an IC can be tested, a part must be selected.  The currently loaded part will be 
displayed in the box directly to the left of the Part button.  If the message No Part Loaded is 
displayed here, you will be unable to run any tests.  You must select a part before a test can 
be performed.  The board under test will need to be powered from the BFL external supply (if 
power is required by the test).  If a separate power supply is used, the ground MUST be 
linked to the BFL ground terminal. 

Part Button 

The Part button is used for selecting the part you wish to test.  When pressed, you are 
presented with a box allowing you to Select Part to Test and the Test Type for the appropriate 
library. 

Setup Button 

The Setup button is used to configure the test parameters.  In the Setup Test Parameters 
box it is possible to configure a particular test to the requirement of the IC under test. 

Start Button 

The Start button will execute the tests which have been enabled in the Setup Test 
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Parameters box using the configured parameters.  If no part has been loaded, the message 
No Part Loaded is displayed and no test will be executed. 

Stop Button 

The Stop button will stop any test which is currently running.  This will only usually apply 
when running tests in one of the loop modes. 

Analysis Button 

The Test Types button displays the Analysis Information dialogue box which includes 
extended test result information (if no test has been executed this button will be greyed). 

IC / DV-I Button 

This button toggles (switches) between the truth table test display(IC diagram) and the digital 
V-I (DV-I) test display.  The text on the button indicates which result display is currently 
shown.  All colours corresponding to the digital DV-I trace can be configured using the Select 
DV-I Trace Colours function. 

Rotate Button 

When a truth table test is performed on a QFP or PLCC IC it displays only 2 sides of the IC.  
The rotate button rotates the IC to view the pins which were not initially displayed.  Pressing 
the Rotate button again displays the initial pins which were displayed. 

Actual / Master Button 

The Actual button is only active when in BFL IC Live Comparison mode.  In normal 
operation of the IC Tester, this button will be greyed. 

The << and < Buttons 

When viewing DV-I traces the << and < buttons will be active.  If there are many DV-I traces 
on the screen (up to 8) then the << button can be used to view the previous set of traces.  If 
you have zoomed into a single trace, the < button can be used to select the previous full 
trace. 

The >> and > Buttons 

When viewing DV-I traces the >> and > buttons will be active.  If there are many DV-I traces 
on the screen (up to 8) then the >> button can be used to view the next set of traces.  If you 
have zoomed into a single trace, the > button can be used to select the next full trace. 
 
Also, the currently selected MODE is displayed beneath the >> button. 

The BFL Logic Trace 

The BFL Logic Trace is an integrated part of the BFL IC Tester.  If enabled, it will display 
the logic trace for each pin of an IC under test. 

Enable / Disable Logic Trace 

The Logic Trace can be enabled and disabled in the Setup Test Parameters window.  If a 
truth table test is performed and the logic trace is disabled, the analysis window will appear 
giving details of that test.  If the test is performed and the logic trace is enabled, the analysis 
window appears again but also the logic trace window appears. 
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Understanding the Display 

The logic trace window displays all the IC pin names down the left side, the number of clock 
cycles taken to test the IC at the top and the logic traces for each pin.  Each trace is 
displayed in either white or grey.  If the test fails, a red bar will be displayed on the 
appropriate trace to highlight the fault. 

Finding the Voltage 

To examine the actual voltages measured in a test, move the mouse cursor to the point of the 
test to be examined and click the left mouse button.  The measured voltages will then be 
displayed on the left of the screen, between each pin name and logic trace.  A green 
highlight bar will indicate which clock cycle is being displayed. 

BFL Main IO Connector 

The main I/O connector is where the test cable is inserted.  This is used for IC testing and for 
the Graphical Test Generator.  You must ensure the cables are inserted in the correct 
orientation.  The yellow dot on the pin diagram below shows pin 1 (channel 1) of the 
connector, the blue dot shows pin 32, the green dot shows pin 33 and the red dot shows pin 
64.  The two rows of black dots are all ground pins. 

              (See Test Clips for more details). 

BFL Pin Conversion Table 

The pin conversion table allows the user to define which pin numbers on the test clip connect 
to which physical BFL channel numbers.  This allows the user to make custom PLCC and 
QFP package clips and cables. 
 
Note: The following pin conversion file format must be complied with to enable this utility to 
work correctly. 

File Format 

The file is a non-document pure ASCII file.  Each line contains the user test clip pin number 
and the corresponding physical channel number, separated by a comma and terminated with 
a CR/LF.  The file must contain the same number of lines as the number of pins on the test 
clip.  Each line should follow this format: 
 
nnn,pppCRLF 
nnn device clip pin number (3 chars) must start at pin 1 and increment consecutively 
ppp physical channel number (3 chars) 
CR Carriage return (1 char) 
LF Line feed (1 char) 

Example 

Here is an example where a 20 pin PLCC test clip has all pins mapped one to one, except for 
pins 19 and 20.  Pins 19 and 20 are mapped to physical channel numbers 59 and 60 
respectively. 
 
001,001 
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002,002 
003,003 
004,004 
005,005 
006,006 
007,007 
008,008 
009,009 
010,010 
011,011 
012,012 
013,013 
014,014 
015,015 
016,016 
017,017 
018,018 
019,059 
020,060 
 

Note: The numbers must be padded to three digits by use of zeros (as above). 

Pin Conversion Filename 

The user defined pin conversion files must be placed in the directory where the software was 
installed.  The following filenames have been allocated for user PLCC/QFP packages. 
 
Package Type   Filename 
PLCC20  PLCC20.CON 
PLCC28  PLCC28.CON 
PLCC32  PLCC32.CON 
PLCC44  PLCC44.CON 
PLCC52  PLCC52.CON 
PLCC68  PLCC68.CON 
PLCC84  PLCC84.CON 
 
QFP44  QFP44.CON 
QFP48  QFP48.CON 
QFP64  QFP64.CON 
QFP80  QFP80.CON 
QFP100  QFP100.CON 
QFP120  QFP120.CON 
QFP128  QFP128.CON 
QFP132  QFP132.CON 
QFP144  QFP144.CON 
QFP160  QFP160.CON 
QFP168  QFP168.CON 
QFP184  QFP184.CON 
QFP196  QFP196.CON 
QFP208  QFP208.CON 

BFL Power Supply Connectors 

The 4mm power supply connectors supply 5V @ 5A to the PCB under investigation. 
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           Black : 0V         Red : +5V 
Note: if you are using an external power supply, its ground terminal MUST be linked to the 
black socket on the BFL. 

BFL Result Analysis Information 

Each enabled test type will have either a tick or a cross beside it indicating a good or bad 
comparison for that test.  Also shown will be the result of the truth table tests if applicable.  
Any information regarding circuit conditions and pre-test information will also be shown in the 
list box.  Any notes applicable to the part under test will also be displayed in the notes box at 
the bottom of the dialog. 
 
If the logic trace is enabled and the Analysis button is pressed, the logic trace window will 
appear as well as the Analysis Information window. 

BFL Selecting Part to Test 

After the Part button has been pressed, you are presented with the new part dialogue box: 
 

 
 
The device filter allows multiple libraries to be selected, displaying their contents in the left 
hand Devices list. 
 
Holding the <control> key while selecting a library allows multiple individual selections to be 
made, while clicking on the All button highlights all the libraries. To select a range of libraries 
hold down the <shift> key and click on the first and last libraries in the desired range. 
 
You can also type the IC number directly into the Devices box.  Simply start typing the 
number of the IC you wish to test and the IC is automatically found in the list.  If the IC 
cannot be found then either the wrong library has been loaded or the IC does not exist.  The 
easiest way to check this is to enter the IC number with all the libraries selected. 
 
The currently installed library version is displayed underneath the filter box. 

Standard Libraries 

Each part in the standard BFL library has associated attributes which specify which of the test 
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types are valid for the particular part.  As an example, the part DIL 8 (Dual in Line, 8 pin 
package) cannot have an associated truth table test. 

Linear Library 

When testing linear devices the VCC+ and VCC- supply rails must not be powered up.  
Testing a linear device with the PCB powered up may cause damage to your system. 

BFL Setup Test Parameters 

The tests and parameters that are applied to the ICs can be modified as necessary.  If any 
parameters are changed and the Cancel button is clicked, none of the changes will be saved 
or used.  If the Ok button is click, the changes will be stored and used thereafter. 

Test Types 

The BFL uses a variety of Test Types or test methods to diagnose faults on a PCB.  These 
consist of: 
 
Truth Table Test: Applies the selected truth table to the IC under test 
Connections Test: Checks for open circuit pins, links between pins, floating pins and 

shorts to 5V and 0V 
Voltage Test: Measures the voltage on every pin of the IC under test 
 
In addition, the BFL contains the following test methods: 
 
Thermal Test: Detects the thermal value of each individual pin (or node) on the IC 

under test 
DV-I Test: Performs a V-I test on the IC under test 
 
The user may enable any test type from the setup menu.  However, if an enabled test type is 
not valid for a particular selected part, the system will simply miss out that test.  The test 
setup configuration will not be changed.  If the setup configuration has enabled only in-valid 
test types, an error message will be displayed when the user attempts to perform a test. 
 
Note: Some ICs do not have a Truth Table Test. 
 
To enable/disable a particular test type, click the mouse button on the particular test you wish 
to enable/disable.  If the box by the side of the text contains an X then the test is enabled.  If 
the box is empty then the test is disabled. 

Test Modes 

An IC test can be executed once, continuously or until certain conditions are met.  This is 
highlighted by the following: 
 
Single: Executes the tests once only. 
Loop: Executes the tests continually. 
True Loop: Executes the tests while ever the tests are true. 
False Loop: Executes the tests while ever the tests are false. 

Circuit Types 
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The IC under test can be tested in-circuit or out-of-circuit.  This can be chosen by 
highlighting one of the following: 
 
In: The IC under test is in-circuit (on a PCB). 
Out: The IC under test is out-of-circuit (using the external IC Adapter). 

DV-I Range 

The DV-I range can be changed by adjusting the LOW and HIGH scroll bars to the required 
value.  Each scroll bar step is 2.5V.  A graphical representation of the range is displayed 
adjacent to the scroll bars.  Pressing the Restore Default button will set the DV-I range 
settings to -10.0V and +10.0V respectively.  The Colours button allows the user to Select 
DV-I Trace Colours. 

Thresholds 

The threshold levels are a defined set of parameters that determine whether the output 
voltage of an IC is High, Low or Mid-Level.  While a test is being run, the output voltage from 
each pin of the IC is compared against the LOW, SWITCH and HIGH threshold settings to 
determine the logic state of that pin.  On the BFL, these threshold settings can be adjusted 
using the LOW, SWITCH and HIGH scroll bars.  Pressing the Restore Default button will set 
the threshold settings to: LOW: 0.5V, SWITCH: 1.2V, HIGH: 2.4V. 
 
The Swept option is for the swept threshold test.  If the checkbox contains X then the test is 
enabled.  If the box is empty then the test is disabled.  The swept threshold test identifies 
the extreme operating thresholds of a particular IC.  The swept threshold test uses the truth 
table test but sweeps the threshold voltages until all mid-level outputs (mid-high and mid-low) 
are eliminated.  The initial test threshold levels are as follows:- 
 
Low threshold: 0.1V 
Switch threshold: 1.7V 
High threshold: 4.9V 
 
The truth table test will be applied to the IC, and the high threshold levels used will be 
reduced until all mid-high pin conditions are eliminated.  Similarly, the low threshold used will 
be increased until all mid-low pin conditions are eliminated.  When all of the mid level 
conditions have been eliminated the swept threshold test will stop.  The last threshold 
voltages used will then be displayed. 
 
The swept threshold test is useful if the user wishes to test an IC beyond its normal 
specification.  In this circumstance, the test can be used to quickly identify the tightest 
thresholds at which the test will pass. 
 
Note: The swept threshold test can only be selected if setup is configured for a single, truth 
table test only. 

Power Supply 

The internal power supply can be delayed before switching on when a test is run.  The delay 
time is set by the scroll bar and the delay time is displayed directly above the scroll bar.  
Pressing the Restore Default button sets the delay to its default value of 250mS. 
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Messages 

Various messages can be displayed when running tests.  These can be enabled by selecting 
the appropriate option. 

 
Auto Clip: Displays the "No automatic clip positioning" message if appropriate to 

that test 
Notes: Displays any notes associated with the IC under test 
Test Results: Displays the results of all tests performed on the IC under test 
Logic Trace: Enables / disables the logic trace facility 

Connection Tol. 

This option is only available when using comparison mode.  It defines how to treat floating 
and open circuit pins when using comparison mode.  The options are: 
 
Same: Floating and open circuit pins are treated as the same when comparing 
Different: Floating and open circuit pins are treated as different when comparing 
Off: Floating and open circuit pins are completely ignored for comparison 

purposes 

Voltage Tol. 

This option is only available when using comparison mode.  The voltages found on the board 
under test are compared with those on the master board or in the master file.  The Voltage 
tolerance can be adjusted to ensure that correct results are obtained even if the voltages 
being compared are slightly different from each other due to normal component value 
variations. 

DV-I Tol. 

This option is only available when using comparison mode.  The DV-I performed on the 
board under test is compared with that on the master board or in the master file.  The DV-I 
tolerance can be adjusted to ensure that correct results are obtained even if the DV-I being 
compared is slightly different from the other due to normal component value variations. 

Thermal Tol. 

This option is only available when using comparison mode.  The thermal test performed on 
the IC under test is compared with that on the master board or in the master file.  The 
Thermal tolerance can be adjusted to ensure that correct results are obtained even if the 
thermal test being compared is slightly different from the other due to normal component 
value variations. 

BFL Pin Conditions 

When a test has been performed, a number of test messages may be displayed beside the IC 
pins displayed on the screen.  One or more of the following could be displayed: 
 
CFLT (CONFLICT) 
The output pin of a tri-state IC is not floating or high impedance when switched off.  This 
indicates a Conflict between this pin and another output on the PCB. 
 
FLOT (FLOATING) 
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It was found that the pin was not driven by any valid logic level, but the system has detected 
the small IC input current.  This may be due to a PCB fault such as a broken track or dry joint, 
or a faulty output on the driving IC.  This type of condition is closely related to an OPEN CCT 
pin condition, in particular for high impedance inputs such as CMOS ICs. 
 
OPCT (OPEN CCT) 
It was found that the pin had no connection and no input current could be detected.  This 
may be due to a PCB fault such as a broken track or dry joint, a faulty output on the driving IC, 
or a bad test clip connection.  This type of condition is closely related to a FLOATING pin 
condition, in particular for high impedance inputs such as CMOS ICs. 
 
GND 
The pin is connected to the 0V rail, and the voltage is valid (less than 0.5V) when under load. 
 
HIGH 
The output on this pin was detected at a high logic level, with respect to the SWITCHING 
threshold, at a point during the test at which a low logic level was expected. 
 
IPML (INPUT MID-LOW) 
The input signal on this pin was found to be between the LOW and SWITCHING threshold 
settings. 
 
IPMH (INPUT MID-HIGH) 
The input signal on this pin was found to be between the SWITCHING and HIGH threshold 
settings. 
 
L n (LINK n) 
The pin was found to be linked to other pins on the same IC.  The connected pins are 
indicated by a number n. 
 
LD0V (LOAD 0V) 
The pin presents an excessive Load (low impedance) to the 0V or GROUND rail.  The 
system is unable to drive this pin with a valid logic high voltage. 
 
LD5V (LOAD 5V) 
The pin presents an excessive Load (low impedance) to the 5V or VCC rail.  The system is 
unable to drive this pin with a valid logic low voltage. 
 
LOW 
The output on this pin was detected at a low logic level, with respect to the SWITCHING 
threshold, at a point during the test at which a high logic level was expected. 
MDHI (MID HIGH) 
The output on this pin was found to be at an invalid logic level at a point during the test.  The 
voltage was measured at a level in between the voltages specified by the SWITCHING and 
HIGH threshold voltage setup. 
 
MDLO (MID LOW) 
The output on this pin was found to be at an invalid logic level at a point during the test.  The 
voltage was measured at a level in between the voltages specified by the LOW and 
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SWITCHING threshold voltage setup. 
 
NGND (NO GND) 
The system was unable to detect a valid 0V supply. 
 
NVCC (NO VCC) 
The system was unable to detect a valid +5V supply. 
 
SH0V (SHORT 0V) 
The pin is connected directly to the 0V rail. 
 
SH5V (SHORT 5V) 
The pin is connected directly to the +5V rail. 
 
SIG (SIGNAL) 
A changing voltage Signal has been detected on the pin that may interfere with the test 
results. 
 
VCC 
The pin is connected to the +5V rail, and the voltage is valid (greater than 4.5V) when under 
load. 

The BFL EPROM Verifier 
The BFL EPROM Verifier allows the users to read, load and save EPROMs for verification 
purposes. 
 

 

To open this instrument, click on the EPROM Verifier button, or select 
EPROM Verifier from the Instruments menu. 

 
The EPROM Verifier can read EPROMs in-circuit and out-of-circuit (if using out-of-circuit 
mode, a special Adapter is required).  The contents of the EPROM are read and the data 
and checksum are then displayed on the screen.  This is then said to be the Master data.  
The master data can then be saved to a file in a binary format, or compared against another 
EPROM. 
 
The task currently being performed will be displayed under the Status box.  For example, it 
will display the word "Reading..." when reading and EPROM.  Once the data has been read 
and the checksum is being calculated, the message will change to "Calculating...” 

EPROM Type 

The drop-down list of EPROM types allows EPROMs of different sizes to be selected.  
These can be: 
 

2k by 8: 16k bit EPROM 
4k by 8: 32k bit EPROM 
8k by 8: 64k bit EPROM 
16k by 8: 128k bit EPROM 
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32k by 8: 256k bit EPROM 
64k by 8: 512k bit EPROM 
128k by 8: 1M bit EPROM 
256k by 8: 2M bit EPROM 

 
Before a file is opened or an EPROM is read, the appropriate EPROM type must be selected. 

In Circuit / Out Circuit 

The In Circuit and Out Circuit radio buttons allow the user to specify whether the EPROM to 
be read or verified is in-circuit or out-of-circuit. 

Read Button 

The Read button will read the contents of an EPROM and display the data on the screen.  
The scroll bar allows all the data to be viewed by scrolling up or down as necessary. 

Verify Button 

The Verify button will compare the master data (displayed on the screen) against another 
EPROM.  This EPROM can be in or out-of-circuit.  If the comparison is good, the message 
Verify OK is displayed.  If the comparison is bad, an error message will appear displaying 
the first address where the comparison was different and the actual and master data.  For 
example, the following message could appear: 
 Error: 00000  F3  FF 
This is interpreted as follows: 
 Error:  <address>  <actual data>  <master data> 
where the master data is the data displayed on the screen and the actual data is the data just 
read from the EPROM. 

Open Button 

The Open will open a window to allow the user to choose a file to be loaded.  The files have 
the extension .EPR and are in a binary format.  Once the file is loaded, this will become the 
master data.  The filename of the loaded file will be displayed at the bottom left of the 
instrument. 

Save Button 

The Save button will open a window to allow the user to enter a filename to be saved.  The 
saved files will have the extension .EPR and are in a binary format.  Once the file is saved 
the filename will be displayed at the bottom left of the instrument. 

Checksum 

When an EPROM is read or a file is opened (loaded) the data will be displayed on the screen.  
The checksum will then be calculated and displayed at the bottom right of the instrument in 
the checksum box. 

Status 

After an EPROM has been read or a file has been opened (loaded), the status of that EPROM 
is displayed in the status box.  This will show if the EPROM is blank or not blank. 

The BFL Output Driver 
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The BFL Output Driver allows the drive state of each of the BFL channels to be changed 
individually. This can be useful for communicating with or controlling external hardware from 
within SYSTEM 8. 
 

 

To open this instrument, click on the Advanced Board Checker icon, or 
select Instruments > Advanced Board Checker from the menu. 

  

Update BFL Button 

The Update BFL button is used to send the drive states of each of the channels in the in the 
channel list to the BFL. 

Send Settings on Open Checkbox 

The send settings on open check box is used to determine if the BFL should be updated 
when the BFL Output Driver instrument is opened.  This is useful if the BFL is required to be 
setup upon entering a TestFlow step. 

Channel 

The BFL channel number associated with a row in the channel list. 

Test Point 

The name of the channel. This is user definable text which can be used to identify a channels 
function. 

Drive State 

The drive state of each of the BFL channels can be set as follows: 
 

Off: The channel is turned off  
Drive Low: The channel is driving low 
Drive High: The channel is driving high 

BFL Auxiliary I/O Connector 
The auxiliary I/O connector is mainly used for the BDO (Bus Disable Output) cable.  It 
provides two outputs providing a LOW logic level during a test (green clips), two providing a 
HIGH logic level during a test (red clips) and one to provide a 0V link with the PCB (black clip).  
For information on BDO usage, see Test Techniques.  This connector is also used for the 
DV-I Single Probe and the Short Locator Cable. 

BFL Backdriving 
When functionally testing ICs in-circuit it is necessary to apply stimulus to the device inputs.  
However, under normal circumstances these inputs will also be connected to the outputs of 
other devices on the board.  It is only possible to test the IC by momentarily forcing the 
inputs to the required state by a technique known as backdriving or node forcing.  This 
technique works by applying a higher source or sink current output than that provided by the 
device being backdriven.  The output of the device being backdriven is forced out of 
saturation to the required level.  This is a widely used technique for in-circuit testing. 
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BFL Conflicts Explained 
Consider a tri-state IC, e.g. a device whose output may be logic high, logic low, or high 
impedance (off).  These devices are usually found on bus (data / address / etc.) lines and 
their outputs will invariably be in common (or parallel) with the outputs of other tri-state 
devices. 
 
Before testing a tri-state device, BFL checks that the outputs of these devices are in the high 
impedance condition.  Only by ensuring that the outputs are in the high impedance condition 
before test, can you be certain that, when the test is run, BFL is seeing the outputs of the 
device under test and not some other device on the same bus which may be enabled. 
 
Should the outputs of a tri-state device not be in the high impedance condition, BFL will report 
an output CONFLICT by the appropriate pin(s) of the device.  At this point the conflict should 
be removed, this often being done by the application of a BDO to the chip enable (CE) or 
output enable (OE) pin(s) of the offending device(s) (see Test Techniques).  Other ways of 
removing conflicts include enabling the write enable (WE) pins of a memory, changing the 
direction of a transceiver, removing the processor and or the memory.  Again do the test in 
the FALSE LOOP.  When the point(s) for removal of the conflict have been located a note to 
this effect can be inserted in the TestFlow file when saving an IC test). 
 
In the example below (Figure 1), IC2 and IC3 are tri-state devices such as a 74244.  Let us 
assume that point a is at a logic 0.  This will cause a logic 1 at point b and so IC2 will be 
disabled and its outputs will be tri-state.  Point c will be at logic 0 and so IC3 will be enabled.  
IC3 can therefore be tested without problem.  However it is when we try to test IC2 that the 
problems occur.  To test IC2 it must be enabled but IC3 is still enabled by the logic low at 
point a.  This will cause a CONFLICT because the outputs of IC2 and IC3 are now 
connected together.  To test IC2 its outputs must go low and high but the outputs of IC3 will 
be in one state.  As they are connected together they cannot be high and low at the same 
time and so you have a conflict. 
 
So how do you get rid of the CONFLICT?  Simply disable IC3 by either connecting a high 
BDO to points a or c. 
 
Figure 1 
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Note: Notice that the device that was the source of the conflict actually passed the test 
without the need of BDOs.  This is a very important point to remember when trying to detect 
the source of BUS CONFLICTS on large PCBs.  Not all devices that cause a conflict to occur 
will actually be affected by conflict themselves. 
 
Figure 2 

 
 
In Figure 2 we have a similar problem to Figure 1 but with one slight difference.  Both 
devices are permanently enabled by a hard wired connection to 0 volts.  Therefore it is not 
possible to get rid of the conflict by disabling one of the devices.  However as well as being 
tri-state these devices are also bi-directional.  Therefore, this time the conflict is removed by 
changing the direction of one of the devices.  This can be done by again clipping a BDO to 
point a, though this time either a high or low BDO will work.  This problem is common with 
CONFLICTS on memory devices were the chip select pin is hard wired and you must ‘BDO’ 
the read/write pin. 

How Do I Find The Conflict Source? 

This usually takes practice and experience; use the SPLIT LEAD cable to detect outputs 
linked to outputs.  Check the 20 pin devices (they are usually on bus lines) and any memory 
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devices on the PCB under test.  Remember to use the FALSE LOOP mode and probe likely 
points with the both high and low BDOs. 

What If I Cannot Find The Conflict Source? 

If there is a BUS conflict on a PCB and it is not possible to get rid of it, then there may be a 
fault on that PCB.  If it is not possible or if you do not have enough time to find the conflict 
source then you may simply accept that the result you have got is the correct one, whether 
the device passes the test or not. 
 
Figure 3 

 
The diagram in Figure 3 is an example of a test result on a faulty 74245, but it is not the pins 
with the conflict that are faulty but the two pins (6 & 14) without a conflict.  This seems 
strange until you think about it.  As we have seen it is perfectly normal for a device to fail the 
IC test because of conflict.  Therefore, which result is most likely to be correct - the fourteen 
identical pins or the two that are different from all the rest?  It is unusual for one channel of 
an octal device to be connected differently from the other seven.  The evidence suggests 
then that either this device or another on the BUS is faulty. 

BFL Loads Explained 
At the start of a test the BFL checks that it is possible to drive each input pin of the device 
under test (with the exception of VCC and GND pins).  Input pins which appear to be 
excessively loaded towards 5V or 0V are indicated as LOAD 5V or LOAD 0V respectively.  
This can be caused by various situations such as RC (resistor/capacitor) networks on the 
inputs, damaged input pins and high current source devices driving the device under test. 
 
A LOAD on an input pin is not necessarily an indication of a faulty device, but simply an 
indication of a condition that is not typical of a normal input. 

BFL Signals Explained 
Signals can come from various sources; they could come from an oscillator, a processor and 
various other sources.  Sometimes, the system will detect the signal and warn you of its 
presence.  However it will be unable to do this for frequencies of approximately 4MHz or 
greater. 

How Can I Tell If An External Signal Is Affecting The Test? 

Test the device in FALSE LOOP and look for an INPUT SIGNAL CHANGING warning on 
screen.  The device may fail in a slightly different way every time as it is tested.  Links, open 
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circuits or floating may appear and disappear. 

How Do I Stop The Signal? 

Try connecting a low BDO to one leg of the crystal or remove the crystal, remove the 
processor or EPROMS etc.  Run the test in FALSE LOOP. 
 
In Figure 1 below, the Q output from the JK flip-flop is fed back to its own clock input via a 
NAND gate.  This can cause a problem when testing either device.  When testing the NAND 
gate, a signal may appear on pin 2, caused by the feedback from the Q output of the flip flop.  
This would not usually cause the device to fail the test but it may cause a bad comparison if 
comparing boards.  To avoid this, simply connect a BDO clip to the CLEAR pin of the flip flop, 
thus holding its outputs in a fixed state.  Use a low or high BDO as appropriate, depending 
on whether the CLEAR is a low or high enable. 
 
When testing a flip flop in this configuration the device is very likely to fail due to a changing 
input signal.  This is again caused by the feedback line from the Q output.  To solve the 
problem this time simply connect a LOW BDO to pin 1 of the NAND gate, then no matter what 
pin 2 does, the output will always be a steady logic high. 
 
Figure 1 
 

 

BFL Special Tests 
There are many special function tests that can be performed.  These are listed below: 

Interconnections Tests 

The interconnections test is a derivative of the connections test.  This enables the user to 
determine interconnections between different ICs on a PCB by using an optional split cable 
and two IC clips. 
 
This feature is particularly useful if no circuit diagrams are available for the PCB under test. 
 
Test names: DIL 14x2, DIL 16x2, DIL 20x2, DIL 24x2, DIL 32x2, DIL 40x2 

DV-I Probe Test 

The Digital V-I (DV-I) probe test performs a DV-I test on a single pin or circuit node by use of 
the discrete DV-I probe cable.  The cable connects into the 10 way blue BDO connector on 
the BFL Front Panel.  The black ground clip on the cable is for use as a reference point 
(alternatively use the power supply black terminal as a ground reference).  The red probe is 
used to connect to the desired pin or circuit node.  The DV-I Probe test is best used in LOOP 
mode, although SINGLE mode can be used for one-shot acquisitions.  The display shows 
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the DV-I characteristic obtained from the red probe with respect to the 0V black clip.  The V-I 
voltage sweep range used will be the range defined in the setup menu (see Setup Test 
Parameters ). 
 
WARNING: The black test clip on the DV-I probe cable provides a hard 0V reference for the 
DV-I test.  If this clip is not connected to the PCB 0V (or ground), the user must ensure that 
no power is supplied to the PCB whilst the clip is connected.  Failure to comply could result 
in damage to the PCB. 
 
Test names: VI PROBE 

EPROM Socket Analysis 

These tests are designed so the user can examine the BUS on a PCB.  This is done by 
removing an EPROM and plugging a special cable directly into the EPROM socket, then 
selecting the appropriate test (according to the EPROM size).  All the selected tests (except 
Truth Table test) are all performed and the appropriate information is displayed.  The types 
of tests performed are user configurable in the Setup Test Parameters menu. 
 
Test names: BUS 2Kx8, BUS 4Kx8, BUS 8Kx8, BUS 16Kx8, BUS 32Kx8, BUS 64Kx8, BUS 

128Kx8, BUS 256Kx8 

Microprocessor BUS Analysis 

These tests are designed so the user can examine the BUS on a PCB.  This is done by 
removing the appropriate microprocessor and plugging a special cable directly into the 
microprocessor socket, then selecting the appropriate microprocessor test.  All the selected 
tests (except Truth Table test) are all performed and the appropriate information is displayed.  
The types of tests performed are user configurable in the Setup Test Parameters menu. 
 
Test names: BUS Z80, BUS 6502, BUS 8085, BUS 8088 

BFL Test Clips and Cables 
BFL can utilize many types of test clip, from 8 pins and upwards.  DIL (Dual in Line), SOIC 
(Small Outline Integrated Circuit), QFP (Quad Flat Pack) and PLCC (Plastic Leaded Chip 
Carrier) ICs can all be tested using the appropriate test cable. 

Connection to the PCB under Test 

Connection to the board under test is made by use of a ribbon cable and an appropriate test 
clip.  The blue connectors on the ribbon cable connect into the blue 128 way connector on 
the front of the BFL unit.  It is important to connect the cable in the correct manner. 

 

You should position the two black connectors so that their polarization notches are on the 
outside, (i.e. away from each other), with the cables running parallel.  Now install the blue 
connectors into BFL.  The two cables should still be parallel, and the black polarization 
notches should still be on opposite sides. 
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DIL Test Clip Insertion 

Conventional test clips insert into the black connectors on the test cable in the following 
manner: 
1) Position the two black connectors so that their polarization notches are on the outside, 
(i.e. away from each other), with the cables running parallel. 

 

2) The test clip inserts into the inner rows of pins (shown in green on the diagram), on the 
black connector. 

          
The clip may be inserted in any position along the row.  However, inserting the clip toward 
the end of the ribbon cable with the red stripe, will ease interpretation of results in some cases, 
and is mandatory in cases where automatic clip positioning is disabled.  In these 
circumstances, pin 1 of the test clip is the left side corner pin nearest the red stripe on the 
ribbon cable.  The test clip itself is not polarized and therefore it does not matter which way 
round the test clip is inserted into the cable (see diagram). 

SOIC Test Clip Insertion 

 a) AP Test Clips 
 
Some AP SOIC test clips have staggered pins and require a special test cable.  This cable 
can be used for any size SOIC test clip (from 8 to 28 pins).  However, when inserting the test 
clip into the cable there will often be a spare hole that is not used. For example, the red dots 
on the diagram below show the holes in the test clip connector which do not have a test clip 
pin inserted in them.  The pin in green denotes pin 1. 

      
20 pin and 28 pin SOIC clips will utilize the holes shown in red (above), but 8 pin, 14 pin, 16 
pin and 24 pin SOIC clips will not use these holes. 
 b) Pomona Test Clips 
 
The Pomona test clips are an alternative to the AP clips. They are fitted into their own cable in 
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the same way as the DIL test clips. However, it is important to use the appropriate cable for 
the correct test clips: 
  

- For DIL test clip, use the grey flat cable (for BFL and AICT modules) 
- For SOIC Pomona clips, use the multi-coloured cable (for BFL and AICT) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

QFP and PLCC Test Clip Insertion 

QFP and PLCC test clips are similar in that they have 4 sides.  Each QFP and PLCC test clip 
has a unique test cable that will only fit that particular size clip.  When the clip is inserted into 
the test cable, all of the holes must be utilized.  Usually, a red dot on one side of the test 
cable will denote pin 1. 

          
 

Custom Test Clips and Cables 

Custom cables and clips can be made by the user.  To enable the custom cables and clips to 
be used with the system, a Pin Conversion utility is available for PLCC and QFP devices.  
This will enable the physical test channels to be mapped to the logical test clip numbers.  For 
more information, see Pin Conversion Table. 
 
Connections to plugs and sockets (e.g. a 9 pin D-type) should ensure that pins 1, 2, 3… of the 
device connect to pins 1, 2, 3… of the BFL test cable. 
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Adapters and Probes 
An automatic out-of-circuit adapter is available for the BFL and the ATM which enables the 
user to test ICs out-of-circuit.  This attaches to the BFL/ATM Front Panel in the test cable 
connector.  This will allow up to 40 pin ICs to be tested with the BFL and more pins with the 
ATM.  The ICs should be inserted at the bottom of the ZIF socket with pin 1 facing upwards.  
The mode should be changed from in-circuit to out-of-circuit in the setup menu.  The 
operation of the software is then identical to in-circuit mode testing. 
 

 
 
 
SOIC adapters are also available.  This can be inserted in to the ZIF socket of the 
out-of-circuit adapter and will then allow the user to test SOICs out of circuit. 
 

 
 
ABI also have MultiProbe Range, designed as a more flexible alternative to standard test 
clips.  The MultiProbes allow voltage, connection, V-I and thermal testing on almost any 
type of device including connectors.  The range includes 0.050"/1.27 mm pitch, 10 pin for 
SOIC and most PLCC devices, and 0.100"/2.54mm pitch, 8 pin for DIL devices 

 
The SOT PenProbe is an accessory for the Analogue IC Test Solution which allows in-circuit 
functional testing of transistors and diodes in tiny SOT-23 packages. 
 
For price information on all of the above adapters and probes, please contact your distributor. 

BFL Test Techniques 
The BFL uses a variety of test methods to diagnose faults on a PCB.  The BFL can power 
the board under test from its own power supply, but it a separate power supply is used the 
GND (ground) MUST be linked to the BFL GND terminal. 

Connection to the PCB under Test 
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It is important to connect the test cable in the correct manner.  For more information, see 
Test Clips. 

Test Clip Installation 

There are different types of test clips available from ABI to cover conventional ICs, surface 
mount IC, quad flat pack ICs and PLCC ICs.  Different types of IC clip use different cables 
and are inserted in a different way.  For more information, see Test Clips. 

Using the Ground Clip 

The actual in circuit IC test can cause noise spikes to be generated on the Ground line of the 
PCB under test.  This can cause some devices to fail, flip-flops, dynamic RAMs, 
timer/counters and especially processors are all prone to failing because of ground noise.  
The ground clip is used to provide a local ground connection to the device under test and thus 
improve test reliability.  For example, when backdriving ICs that are connected to the device 
under test, the current required can be quite high.  The high current can cause transient 
voltage spikes.  If the grounding is not adequate, the IC under test may well respond to these 
spikes and may appear to fail the test.  The solution is usually to use the Ground Clip to 
provide a low impedance return path for the high backdrive current.  In nearly all cases this 
will cure the problem, but if it persists, one of the BDO signals may be used to disable the IC 
which is being backdriven. 
 
The ground clip is inserted into the end pair of holes in the outer rows of the black connector 
(shown in red on the diagram). 

 

Not all tests require the ground clip to be connected. 

Automatic Clip Positioning 

AUTOMATIC CLIP POSITIONING establishes the position of the IC within the test clip.  This 
allows the clip to be applied in any desired position or orientation.  The technique works by 
locating the VCC (+5V) and GND (0V) pins prior to commencement of a test.  Note:  
Automatic clip positioning is not possible under some circumstances.  The software will issue 
a warning to this effect when appropriate.  In these circumstances, pin 1 of the test clip must 
connect to pin 1 of the IC.. 

Powering the PCB under Test 

The BFL provides a 5Vdc, 5A power supply output to power the PCB under test.  The supply 
is connected to two terminals at the front of the module.  Connect the PSU leads to the 
appropriate power supply terminals on the PCB under test as follows: 
Black: PCB 0V or GND (ground) 
Red:  PCB +5V or VCC 
If the PCB under test has a current consumption greater than 5A a separate power supply 
must be used.  In such cases the ground or 0V supply of the power supply MUST be linked 
to the BFL/DCS module ground terminal (black connector).  The DV-I test does not require 
the PCB to be powered during test.  However, the PCB 0V power rail must be connected to 
the BFL module black ground terminal. 
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Cleaning 

For reliable test results the test clip must make good contact with the device under test.  To 
facilitate this, it may be necessary to clean the PCB under test to remove dirt, oxidation and 
flux from IC pins.  There are many cleaning solvents available which will safely do this. 

Clocks 

Clocks and oscillators on the PCB under test should be disabled to ensure static test 
conditions.  Failure to do so may result in interference and invalid or unreliable test results.  
Well designed boards usually have the facility to disable clocks and oscillators using links or 
jumpers.  Alternatively, a BDO output can be used for this purpose (see BDO Usage). 

The BDOs 

Each BFL module provides four Bus Disable Output (BDO) signals.  These are also 
sometimes referred to as guards.  The BDO cable consists of five clips connected to a blue 
10 way connector.  The connector should be attached to the 10 way connector on the front 
of each BFL module.  Two of the BDO outputs, identified by green clips, provide a low logic 
level during a test.  Two of the BDO outputs, identified by red clips, provide a logic high level 
during a test.  An additional black clip is used to provide a 0V link with the PCB.  The output 
specification of the BDO signals is identical to that of the other drive channels. 

BDO Usage 

BDO clips are used to backdrive nodes on the board under test to selectively disable circuitry.  
Clip the BDO clips to the appropriate nodes on the PCB.  The BDO clips will only be active 
for the duration of a test.  Examples of the use of BDOs would be: 
 
1) Disabling a microprocessor by forcing the RESET, HOLD or DMA REQUEST to the 

appropriate logic level. 

2) Disable clock signals to prevent test interference. 

3) Disable tri-state outputs on a common bus to prevent contention with the outputs of the 
particular IC under test. 

BFL Test Types 
The BFL (Board Fault Locator) can use a variety of test methods to diagnose faults on a 
PCB. 

Truth Table Test 

The Truth Table test tests the functionality of an IC by applying the appropriate truth table 
stimulus to the IC under test.  While this defined sequence of signals is being applied to the 
IC, the outputs of the IC are checked to ensure that they comply with the expected levels.  If 
the IC responds at all times to the input stimulus, the test result is regarded as good and a 
green tick will be displayed in the result analysis box.  If the test fails, the faulty logic level will 
be displayed next to the relevant pin on the IC diagram and a red cross will be displayed in 
the result analysis box. 
On the BFL, the low, high and switching voltage thresholds may be defined by the user in the 
Setup Test Parameters menu. 

Connections Test 
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The Connections test examines the connectivity of the device under test.  The information 
displayed can include any of the following: 
 
Link: Pins on the same device that are connected together 
Short: Pins that are connected directly to 0V or 5V 
Float: Pins that are not being driven by a valid logic level 
Open circuit: Pins that are completely open circuit 
 
The above information provided by this test is sometimes termed Manufacturing Defect 
Analysis (MDA) since it can often highlight defects caused by the manufacturing process.  
For more information on pin conditions, see Pin Conditions. 

Voltage Test 

The Voltage test measures the voltage on every pin of the IC under test before any stimulus 
is applied, and displays it as an actual voltage beside the appropriate pin on the IC diagram.  
This can be useful when testing analogue ICs and also when comparison testing.  The 
voltages are also translated to logic levels.  This identifies mid-level logic states which are a 
classic fault symptom on digital boards. 

Thermal Test 

The Thermal test exploits the thermal characteristic of a digital device’s static protection 
diodes to provide a relative measure of the temperature of the IC in the vicinity of that pin. 
The precise temperature is not known, but the relative number can be used to compare a 
good and faulty board.   
 
The test detects the thermal value of each individual pin (or node) on the IC under test, 
provided that pin has a valid diode characteristic.  The value displayed is not a valid 
temperature reading but merely a relative measure of temperature.  If a thermal test is 
performed and the IC under test does not display a thermal value, this means that the pin (or 
node) does not have a diode characteristic.   
 
Even though the thermal test applies no power to the IC under test, it can detect overloaded 
outputs, over dissipation (hot ICs) and is a useful feature in comparison testing. 

DV-I Test  

The Digital V-I Test is a long established test technique commonly used for examining the 
pin (input/output) characteristic of ICs. The result is in a graphical form and an experienced 
user can identify common faults such as leaky static protection diodes, blown bond wires, 
shorted outputs or open inputs. Alternatively, the characteristic can be stored and compared 
with a known good board for fault diagnosis. The test is conducted with the power off and is, 
therefore, appropriate for boards which cannot be powered up due to severe faults. 
 
The Digital V-I (DV-I) display depicts the Voltage (V)-Current (I) characteristic of a node with 
respect to ground.  The DV-I characteristic is obtained by applying a varying voltage to a 
device pin from a current limited source.  A graph of voltage against current is then displayed.  
The resultant curves are analogous to an analogue signature of a device pin.  The technique 
may thus be used to build up a profile of a board containing both digital and analogue 
components.  Differences in characteristic curves of components on a saved good board and 
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those of the corresponding component on a suspect board can lead to diagnosis of the fault.  
No power is applied to the board or device under test when performing a DV-I but a ground 
connection to the BFL module must be present. 
 
The BFL digital V-I test has been optimised for testing digital ICs. The source impedance and 
frequency are fixed.  The voltage limits are user adjustable in the range +/- 10V. 

Comparing Measurement Results 
The results of a measurement or calculation can be compared with a target value for pass/fail 
testing.  The results are displayed in the form of a bar graph, which displays green (pass) for 
readings inside the programmed tolerance, red otherwise. 
 

To setup measurements click on the  icon on the instrument.  A typical example of a 
setup comparison dialog box is given below (a calculator comparison box will also include an 
area for entering a FormulaPlus program). 
 

 
 
Enter the target value of the measurement in the Target box, and set the appropriate units by 
clicking on the drop down box.  Similarly adjust the Lower Tolerance, Upper Tolerance, 
Display Minimum and Display Maximum values. 
 
The display minimum and display maximum figures refer to the range displayed on the 
associated bar graph.  A measured (or calculated) value will be indicated as a pass 
(provided the compare checkbox is set) if the value is greater than or equal to target - lower 
tolerance, or less than or equal to target + upper tolerance. 

BFL Select DV-I Trace Colours 
The colours of various parts of the digital V-I display can be configured.  These are: 
 

Actual Colour: Sets the colour of the actual trace 
Master Colour: Sets the colour of the master trace 
Name, Range: Sets the colour of the text on the display 
Grid Colour: Sets the colour of the grid 
BkGnd Colour: Sets the background colour of the display 

 
The Default Colours button restores the factory default colour scheme. 

The AICT Front Panel 
This is the AICT front panel. 
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AICT Analogue V-I Tester 
The AICT Analogue V-I Tester allows the analogue signatures of ICs and discrete 
components to be acquired and compared without removing them from the printed circuit 
board (PCB).  As voltages are applied and measured by the V-I Tester, there should be no 
external power supplied to the unit being tested.  In addition, when matrix V-I testing is being 
performed there should also be no ground reference lead connected.  For more information 
on using the V-I Tester, see Using Analogue V-I. 
 

 

To open this instrument, click on the Analogue V-I Tester icon, or select 
Instruments > Analogue V-I Tester from the menu. 
 

 
Note: When using source impedances above 1k or waveform frequencies above 300Hz the 
capacitance of the probes being used will start to become significant.  This will exhibit itself 
as an elliptical analogue V-I characteristic under open circuit conditions.  The software can 
compensate for this, under user control, using the Probe Compensate button in the 
Analogue V-I Setup dialogue box. 

Size Box 

The Size box is a drop down list box containing several settings for selecting the size of 
component.  This may be a discrete probe or an IC.  The options are as follows: 
 

Probe 1: Single trace using the single V-I probe in Channel 1 
Probe 2: Single trace using the single V-I probe in Channel 2 
Probe Dual: Channel 1 and Channel 2 traces together on the same screen 
 
Clip 4: Displays four separate traces via the Analogue I/O Connector 
Clip 6: Displays six separate traces via the Analogue I/O Connector 
Clip 8: Displays eight separate traces via the Analogue I/O Connector 
Clip 10: Displays ten separate traces via the Analogue I/O Connector 
Clip 14: Displays fourteen separate traces via the Analogue I/O Connector 
 
Clip 16: Displays sixteen separate traces via the Analogue I/O Connector 
MultiProbe 8: Displays eight separate traces via the Analogue I/O Connector 
MultiProbe 10: Displays ten separate traces via the Analogue I/O Connector 
MultiProbe 16: Displays sixteen separate traces via the Analogue I/O Connector 
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Frequency Selector 

The Frequency selector is a drop down list box which is used to select the frequency of the 
output waveform.  The selected frequency can be in the range of 38Hz to 12kHz. 

Impedance Selector 

The Impedance selector is a drop down list box which is used to select the source 
impedance of the output waveform.  The selected impedance can be in the range of 100R to 
1M. 

Voltage Selector 

The Voltage selector is a drop down list box which is used to select the amplitude of the 
output waveform.  The selected voltage can be in the range of 2V to 50V peak to peak. 

Curve Selector 

The Curve selector is a drop down list box which is used to select the type of output 
waveform.  This can be one of the following: 

Sine: sets a sine wave as the output waveform 
Ramp: sets a ramp as the output waveform 
Triangle: sets a triangle wave as the output waveform 

Axis Selector 

The Axis selector is a drop down list box which is used to select the plotting axis.  This can 
be one of the following: 

V-I: sets the plotting axis to V-I (Voltage against current) 
V-T: sets the plotting axis to V-T (Voltage against time) 
I-T: sets the plotting axis to I-T (Current against time) 

Setup Button 

The Analogue V-I Setup button is used to configure the test parameters. 

Start Button 

The Start button will start the test, using the selected parameters. 

Stop Button 

The Stop button will stop any test which is currently running. 

Store Button 

The Store button stores the currently active waveform.  The trace of the current device 
under test and the stored trace will both be displayed on the screen.  The waveforms are 
only stored until store is pressed again or one of the options (such as clip type, impedance, 
wave shape etc.) is changed.  It is not operational in dual probe mode as comparison is 
performed between the two probes in this mode. 

Matrix Button 

Matrix V-I testing is a powerful technique that allows connections between pins on an IC to 
be measured and compared.  This allows ICs to be tested out of circuit as well as finding 
shorts between pins that would otherwise not have been found.  It is only available when the 
AICT Analogue IC Test Solution is installed.  When performing Matrix testing there should be 
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no ground reference connected to the unit under test. 

V-I Result Comparison 

When comparing stored traces/signatures, a percentage figure is displayed in the bottom 
left-hand-side of each display.  This represents the result of the V-I comparison for each 
particular pin.  The figure denotes the degree of similarity between all of the points on the 
master characteristic and those on the corresponding pin of the device under test.  A 
percentage figure of below 95% is considered a bad comparison, and the percentage result 
will be displayed in red to indicate this.  The tolerance of this comparison can be selected 
from the Analogue V-I Setup box.  The colours of the traces are configurable using the 
Select Analogue V-I Trace Colours function. 

Tone Box 

Clicking the tone box toggles an audible indicator of the match between the current trace and 
the stored trace. This works for both information stored using the store button, and within a 
test sequence. 

The < and > Buttons 

A single trace can be more accurately examined by positioning the mouse cursor over the 
desired V-I curve.  When the mouse cursor becomes a magnifying glass symbol, a single 
mouse click will expand the curve.  A second mouse click will restore the normal display.  If 
you have zoomed into a single trace, the <; and > buttons are enabled, and can be used to 
view the previous (<) / next (>) full trace. 

The Pulse Generator 

The pulse generator (when enabled) will continuously produce a pulse or DC level according 
to the attributes set by the user in the Analogue V-I Setup box.  The pulse length, amplitude 
and type can all be changed to suit a particular test.  The main use is for testing 3 terminal 
devices where the pulse generator would switch on/off the device under test. 

AICT Analogue IC Tester 
The AICT Analogue IC Tester is an analogue equivalent of the BFL IC Tester - it allows 
analogue ICs to be tested in-circuit, without removing them from the printed circuit board 
(PCB). 
 

 

To open this instrument, click on the Analogue IC Tester icon, or select 
Instruments > Analogue IC Tester from the menu. 
 

 
To test an IC select the part from the appropriate library using the drop down list boxes to the 
left of the instrument.  The currently loaded part will be displayed in the box in the left hand 
top corner.  The board under test will need to be powered from an external supply (if power 
is required by the test).  The ground of the external power supply MUST be linked to the 
ground (black) terminal of the AICT module. 

Setup Button 

The Setup button is used to configure the test parameters, using the Setup AICT IC Tester 
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Test Parameters window. 

Start Button 

The Start button will execute the test(s) which have been enabled using the configured 
parameters. 

Stop Button 

The Stop button will stop the currently executing test when running in loop mode.  

Actual / Master Button 

The Actual button is only active when in AICT IC Comparison mode.  In normal operation of 
the AICT IC Tester, this button will be greyed. 

Library Window 

The Library window allows a device to be selected - an image of its package type is 
displayed to the right. 

Notes Button 

The Notes button will display any notes which are relevant to the test which is currently 
selected. 

Analysis window 

The Analysis window displays extended Analysis Information after the test. 

Result window 

The Result window displays a picture of the device under test and any Pin Conditions 
detected during the last test. 

Trace window 

The Trace window displays the voltages present at each of the pins during the test. 

AICT Analogue I/O Connector 
A cable is inserted into this connector which will contain a clip of the appropriate size to 
perform functional and V-I tests on multiple pins, using the Clip 4 to Clip 24 or MultiProbe 
options.  The pin numbers of the connector are as follows: 

 

If using Clip 4 to Clip 24 or MultiProbe cables, pin 1 of the cable will attach to pin 1 of the 
connector.  The actual V-I channels are pins 1 to 12 and pins 15 to 26. 
 
Example:  If using the Clip 14 option, pins 1 to 7 of the connector would be pins 1 to 7 of the 
clip, but pins 20 to 26 of the connector would be pins 8 to 14 of the clip. 

AICT Analogue V-I Setup 
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This box contains the following parameters that are used when running the analogue V-I test: 

Enable Pulse 

This is a check box that enables and disables the pulse generator.  If the check box is empty, 
the pulse generator is disabled. 

Positive Pulse 

The waveform from the V-I pulse generator can be configured and is output to the Pulse 
connectors on the ATS Front Panel.  The start position, stop position and output voltage can 
be set using the 3 scroll bars.  These controls will be disabled and will appear greyed unless 
the Enable Pulse option is selected (enabled).  Once enabled, the user can set up the 
following parameters: 
 

Start: sets the start position of the positive pulse (0.0us to 26.21ms) 
Stop: sets the stop position of the positive pulse (103.2us to 26.32ms) 
V+:  sets the amplitude of the positive pulse (0V to +10V) 

Negative Pulse 

The waveform from the V-I pulse generator can be configured and is output to the Pulse 
connectors on the ATS Front Panel.  The start position, stop position and output voltage can 
be set using the 3 scroll bars.  These controls will be disabled and will appear greyed unless 
the Enable Pulse option is selected (enabled).  Once enabled, the user can set up the 
following parameters: 
 

Start: sets the start position of the negative pulse (0.0us to 26.21ms) 
Stop: sets the stop position of the negative pulse (103.2us to 26.32ms) 
V-: sets the amplitude of the negative pulse (0V to -10V) 

Pulse Type 

The Pulse Type box is a drop down list box that is used to select the type of pulse output from 
the V-I pulse generator. 

Positive: selects a positive pulse 
Negative: selects a negative pulse 
Bipolar: selects a bipolar pulse 
DC: selects a DC level 

DC 

This is a scroll bar that sets the DC voltage level that is output from the V-I pulse generator.  
This voltage can be in the range of +10V to -10V. 

Comp. Tol. 

This is a scroll bar that selects the comparison tolerance when using the V-I tester to 
compare the trace with a stored trace.  A low number in the Points box would make the 
comparison sensitive (e.g.: The traces would have to be almost identical to indicate a good 
comparison).  As the number of points is increased, the sensitivity of the comparison is 
decreased. 

Colours Button 
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The Colours button allows the colours of various parts of the display can be configured.  See 
Select Analogue V-I Trace Colours. 

Dot Join 

This check box enables and disables the interpolation of points during plotting.  If the check 
box is empty, dot join is disabled. 

Probe Compensation 

When using source impedances above 1k or waveform frequencies above 300Hz the 
capacitance of the probes being used will start to become significant.  This will exhibit itself 
as an elliptical analogue V-I characteristic under open circuit conditions.  The software can 
compensate for this, under user control, using the ‘Probe Compensate’ button in the 
Analogue V-I Setup dialogue box.  Pressing this button will calibrate out the stray 
capacitance of the probes.  It is important that the user should insert all probes on all 
channels that will be used before the button is pressed, otherwise the stray capacitance of the 
probe on that channel cannot be calibrated out.  If the probe on a particular channel is 
changed at any time, the ‘Probe Compensate’ button must be pressed to calibrate the system 
for the new probe.  At the test setup extremes (1M source or towards 12kHz) the 
compensation will not be perfect.  However, when using the main application of comparison 
mode, this will have little effect on the performance.  Probe compensation can take up to 30 
seconds to perform. 

The AICT Analogue IC Tester Analysis Information 
The analysis text window contains information regarding the IC test that has been performed. 
 
If the test is running in loop mode, the total number of passes and failures is displayed. Some 
functional tests return additional information regarding the test being performed and this will 
also be displayed in the analysis window.  For example, a bipolar transistor test is capable of 
approximating the Hfe of the device under test (at a single operating condition) and 
determining which pins are connected to the Base, Emitter and Collector of the device under 
test.  Any information regarding circuit conditions and pre-test information will also be shown 
in the analysis window. 

The AICT IC Tester Comparison 
One of the most efficient methods to repair a PCB is to compare a suspect board with a 
known good board.  Highlighted differences between the boards can quickly lead to fault 
diagnosis.  SYSTEM 8 allows the profile of a known good board or Golden Board to be 
saved in a TestFlow file.  A suspect board can then be compared with the profile of the 
Golden Board. 
 

The Actual button is used to toggle the current result display between the actual (device 
under test) and the master (golden device).  The expected Master signature of the device 
can be viewed by toggling the Actual/Master button to show Master.  The package display 
of the master and the actual result must be viewed separately.  The package pin names will 
be highlighted in red if there are comparison differences on individual pins. 

AICT IC Tests Types 
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The Analogue IC Tester uses several test methods to diagnose faults on a PCB. 

Functional Test 

This tests the basic functionality of a device by applying the appropriate stimulus to the device 
under test (DUT).  Analogue currents or voltages are applied to the DUT and the analogue 
responses are checked to ensure that they comply with the expected responses.  If the DUT 
responds at all times to the input stimulus, the test result is regarded as good and a green tick 
will be displayed in the result analysis box.  If the test fails, a fault code will be displayed next 
to the relevant pin on the IC diagram and a red cross will be displayed in the result analysis 
box. 
 
A representation of the stimulus and response waveforms can also be displayed graphically in 
the form of a timing diagram.  

Connections Test 

The connections test examines the connectivity of the device under test.  The information 
displayed can include any of the following: 

Link: Pins on the same device which are connected together 
Short: Pins which are connected directly to a power rail 

 
The above information provided by this test is sometimes termed Manufacturing Defect 
Analysis (MDA) since it can often highlight defects caused by the manufacturing process.  
For more information on pin conditions, see Pin Conditions. 

Voltage Test 

The voltage test measures the voltage on every pin of the device under test before any 
stimulus is applied, and displays it as an actual voltage beside the appropriate pin on the 
diagram.  This can be useful when testing analogue ICs and also when comparison testing.  

AICT Pin Conditions 
When a test has been performed, a number of test messages may be displayed beside the IC 
pins displayed on the screen.  One or more of the following could be displayed: 
 
GND 
This pin is the ground pin of the IC and has the correct voltage on it. 
 
HI V 
The voltage measured exceeded the maximum allowable positive voltage (+15.5V).  The test 
will not proceed under these conditions.  Ensure the board power supply ground is linked to 
the ATS black terminal. 
 
I>> 
The output current on this pin was found to be too high at a point during the test at which a 
lower current was expected. 
I<< 
The output current on this pin was found to be too low at a point during the test at which a 
higher current was expected. 
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L n (LINK n) 
The pin was found to be linked to other pins on the same IC.  The connected pins are 
indicated by a number n. 
 
LO V 
The voltage measured exceeded the minimum allowable negative voltage (-15.5V).  The test 
will not proceed under these conditions.  Ensure the board power supply ground is linked to 
the ATS black terminal. 
 
NGND (NO GND) 
The system was unable to detect a valid 0V supply.  Ensure the board power supply ground 
is linked to the ATS black terminal and the clip is properly located. 
 
NV+ (NO V+) 
The system was unable to detect a valid positive supply.  Ensure the board power supply 
ground is linked to the ATS black terminal and the clip is properly located. 
 
NV- (NO V+) 
The system was unable to detect a valid negative supply.  Ensure the board power supply 
ground is linked to the ATS black terminal and the clip is properly located. 
SH0V (SHORT 0V) 
The pin is connected directly to the 0V rail. 
 
SV+ (SHORT V+) 
The pin is connected directly to the positive supply rail. 
 
SV- (SHORT V-) 
The pin is connected directly to the negative supply rail. 
 
V+ 
This pin is the positive supply pin of the IC. 
 
V- 
The pin is the negative supply pin of the IC. 
 
V>> 
The output voltage on this pin was found to be too high at a point during the test at which a 
lower voltage was expected. 
 
V<< 
The output voltage on this pin was found to be too low at a point during the test at which a 
higher voltage was expected. 
 
HI V 
The voltage on this pin is too high for the test. 
 
LO V 
The voltage on this pin is too low for the test. 
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SVx+ 
This pin is shorted to an unspecified positive voltage. 
 
SVx- 
This pin is shorted to an unspecified positive voltage. 

AICT Selecting Analogue V-I Trace Colours 
The colours of various parts of the display can be configured.  These are: 
 

Actual Colour 1: The colour of the actual trace 1 (Actual Probe 1, pins 1 to 16) 
Actual Colour 2: The colour of the actual trace 2 (Actual Probe 2) 
Master Colour 1: The colour of the master trace 1 (Master Probe 1, pins 1 to 16) 
Master Colour 2: The colour of the master trace 2 (Master Probe 2) 
Name, Range: The colour of the text on the display 
Grid Colour: The colour of the grid 
BkGnd Colour: The background colour of the display 

Default Colours Button 

This button restores the factory default colour scheme.  This is: 
 

Actual Colour 1 : Light Yellow 
Actual Colour 2 : Light Blue 
Master Colour 1 : Light Green 
Master Colour 2 : Light Red 
Name, Range : White 
Grid Colour : Black 
BkGnd Colour : Grey 

AICT Setup Test Parameters 
The tests which are applied to the ICs under test and the messages which appear are 
modified as necessary.  If any parameters are changed and the CANCEL button is pressed, 
none of the changes will be saved or used.  If the OK button is pressed, the changes will be 
stored and used thereafter. 

Test Types 

The ATS IC Tester uses a variety of test types or test methods to diagnose faults on a PCB.  
These consist of: 

Functional: Applies a go/no go test to the selected device under test 
Connections test: Checks for open circuit pins, links between pins, floating pins and 

shorts 
Voltage test: Measures the voltage on every pin of the IC under test 

The user may enable any test type from the setup menu.  However, if an enabled test type is 
not valid for a particular selected part, the system will simply miss out that test.  The test 
setup configuration will not be changed.  If the setup configuration has not enabled any valid 
test types, an error message will be displayed when the user attempts to perform a test. 

Test Modes 
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An IC test can be executed once, continuously or until certain conditions are met.  This is 
highlighted by the following: 
 

Single: Executes the tests once only 
Loop: Executes the tests continually 
True loop: Executes the tests while ever the test result is true 
False loop: Executes the tests while ever the test result is false 

Test Functions 

This group configures various test functions as described below: 
 
Analogue trace: Enables/disables the analogue trace facility 
Auto clip function: Enables/disables the automatic clip positioning function.  If disabled, 

the IC test clip must be applied with pin 1 of the clip to pin 1 of the IC 
under test. 

Messages 

Various messages can be displayed when running tests.  These can be enabled by selecting 
the appropriate option: 
 

Auto clip warning: Enables/disables the "No automatic clip positioning" message if 
appropriate to that test 

Notes: Displays any notes associated with the device under test 

Voltage Tolerance 

This allows adjustment of the voltage tolerance on each pin in regard to comparing 
Master/Actual results.  This is used when the Master/Actual test results are always failing 
due to small voltage variations, i.e. tolerance of components or slightly different test 
conditions. 

AICT Using Analogue V-I 

About V-I Testing 

V-I testing (also known as Analogue Signature Analysis) is a technique which is excellent for 
fault finding on PCBs, and is ideal when diagrams and documentation are minimal.  When 
testing a board with the V-I Tester, no power is applied to the device under test.  Therefore, 
this technique is an extremely effective test for so called dead boards which cannot safely be 
powered up.  A current-limited, ac signal is applied to the device under test and the 
characteristic impedance is displayed by plotting voltage against current on an X-Y graph (the 
X axis representing voltage and the Y axis representing current). 
 
Analogue V-I testing is a very simple technique, as will be detailed.  However, this does not 
mean that it is not also a powerful fault diagnosis tool.  The basic technique is depicted 
below.  A stimulus waveform is applied through a current limiting resistor across the device 
under test (DUT).  The voltage across the DUT is plotted (on the horizontal axis) against the 
current through it (on the vertical axis). 
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From ohms law, (Z = V/I) it can be seen that the resulting characteristic represents the 
impedance of the DUT.  The stimulus waveform is usually a sine wave. For frequency 
dependent components such as capacitors and inductors, the impedance is frequency related. 
Thus a variable frequency stimulus source is required for these types of components. It can 
also be seen that the current limiting resistor and the DUT form a potential divider. To achieve 
a reasonable trace the current sense resistor should be the same order of magnitude as the 
impedance of the DUT at the test frequency. Thus, in order to use this technique on a wide 
range of DUTs, a wide range of current limiting (or source) resistors are required. 
 
It is not necessary to understand the above technique to be able to use analogue V-I testing 
for fault diagnosis. Most applications use analogue V-I testing in a comparative manner where 
understanding the displayed characteristic is not important. Indeed, in real board fault 
diagnosis situations, many components will be connected to a particular node and the 
resulting analogue V-I characteristic will be a complex composite of the individual 
components analogue V-I characteristics making it extremely difficult to completely 
understand it.  

Understanding the Display 

The V-I display plots the voltage across the device under test (V) on the horizontal axis, and 
the current through the device under test (I) on the vertical axis as shown below.  Different 
devices in different configurations produce different signatures, depending on the current flow 
through the device as the applied voltage changes.  A short circuit, for example, would be 
displayed as a vertical line, because the current flow for any applied voltage would be 
theoretically infinite (see below), whereas an open circuit would display a horizontal line 
because the current is always zero irrespective of the applied voltage (see below).  A pure 
resistor would give a diagonal line whose slope is proportional to the resistance, because the 
current is proportional to the applied voltage.  More complex curves are obtained with 
frequency dependent components such as capacitors and inductors, and also for non-linear 
devices such as diode and transistor junctions. 
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Open Circuit: 

 

Short Circuit: 

 
 
Even though the curves can sometimes be quite complex, it is not necessary to understand 
them in order to use the V-I test technique.  The comparison of the curves for a known good 
board and a suspect board can often identify faults with a minimum of knowledge.  Bear in 
mind that in a typical circuit the displayed V-I curve would normally be for a number of 
components in parallel.  A better understanding of the operation of the analogue V-I tester 
can be gained by using the system with known components out of circuit. 
 
The signatures of resistors are straight lines (see Diagram 1).  The value of the resistor 
under test affects the slope of the line, the higher the value, the closer the line gets to the 
horizontal (open circuit).  The source impedance of the V-I tester should be selected so the 
slope of the line, for a good resistor, is as close as possible to 45 degrees.  A difference in 
the slope of the curve when comparing a good and suspect board would indicate a difference 
in the resistor values on the two boards. 

Diagram 1: 

 
820 Ohm Resistor 
SETTINGS 
Frequency : 1.2kHz 
Source Impedance : 1k Ohms 
Curve : sine wave 
Voltage : 10V peak to peak 

Diagram 2: 

 
0.47uF Capacitor 
SETTINGS 
Frequency : 4.8kHz 
Source Impedance : 100 Ohms 
Curve : sine wave 
Voltage : 2V peak to peak 

 
Capacitors with relatively low values have flattened, horizontal, elliptical signatures and 
capacitors with relatively high values have flattened, vertical, elliptical signatures.  The 
optimal signature is a nearly perfect circle (see Diagram 2) which can be obtained by 
selecting the appropriate test frequency and source impedance.  Typically, the higher the 
capacitance, the lower the test impedance and frequency.  A leaky capacitor would give a 
sloping curve due to the effective resistance in parallel with the capacitor. 
 
The signature of an inductor is elliptical or circular, sometimes showing hysteresis (see 
Diagram 3).   Inductors with relatively high values have flattened, horizontal, elliptical 
signatures similar to those of capacitors.  The optimal signal is a perfect circle.  Inductors 
may have ferrite, iron, brass or air cores, which may or may not be adjustable.  Inductors 
with the same value may have very different signatures if they use different core materials or 
if the core is positioned differently.  Inductors usually require a low source impedance and 
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higher test frequencies to exhibit an elliptical signature.   
 
An open circuit inductor (a common fault with small PCB mounting devices) can easily be 
detected by the sharply contrasting V-I curves when comparing two boards. 
 
Diagram 3: 

 
10mH Inductor 
SETTINGS 
Frequency : 1.2kHz 
Source Impedance : 100 Ohms 
Curve : triangle wave 
Voltage : 4V peak to peak 

Diagram 4: 

 
1N4148 Diode 
SETTINGS 
Frequency : 60Hz 
Source Impedance : 1k Ohms 
Curve : sine 
Voltage : 6V peak to peak 
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The signature of a silicon diode can be identified easily (see Diagram 4).  The vertical part of 
the curve shows the forward bias region, and the turn-on voltage and the forward voltage drop 
can be easily identified.  The curved area of the trace shows the changeover from fully off to 
fully on as the applied voltage increases.  The horizontal part of the curve is the reverse 
voltage region where the diode is non-conducting and is effectively an open-circuit.  Faulty 
diodes can easily be identified by a deviation from this characteristic, for example a diode 
which exhibits significant reverse leakage would have a diagonal curve in the reverse region, 
similar to a resistor. 
 
Zener diodes conduct in both directions.  The forward current characteristic is similar to that 
for a diode (see above).  The characteristic in the reverse direction is also similar to a diode 
until the breakdown or Zener voltage is reached, at which point the current increases rapidly 
and the diode voltage is clamped.   
This gives rise to the curve in Diagram 5.  The test voltage should be chosen to be higher 
than the Zener voltage for this curve to be obtained.  A suspect Zener diode may not have a 
well-defined "knee" and the horizontal part of the curve in the reverse region may exhibit 
leakage effects in a similar way to a normal diode. 
 
Diagram 5: 

 
BZX55C5V1 Zener Diode 
SETTINGS 
Frequency : 60Hz 
Source Impedance : 1k Ohms 
Curve : sine 
Voltage : 20V peak to peak 

Diagram 6: 

  
PNP Transistor 
SETTINGS 
Frequency : 120Hz 
Source Impedance : 1k Ohms 
Voltage : 4V peak to peak 
Pulse Type : Bipolar : (V+ 0.12) (V-  -0.7V) 
Positive start : 0us  stop : 4.18ms 
Negative start : 4.18ms  stop : 8.33ms 

 
NPN and PNP bipolar transistors have a signature similar to that of the diode (see Diagram 4) 
when tested between the base-collector and base-emitter junctions.  If tested between the 
collector-emitter terminals the signature would appear to be open circuit.  The pulse 
generator can be used to apply a bias voltage, via a suitable resistor, to the base of the 
transistor, so that the switching action can be observed (see Diagram 6).  The pulse 
generator can also be used to trigger devices such as triacs and thyristors, so that again the 
switching action can be observed.  Transistors with open circuit or leaky junctions can easily 
be identified by the marked differences between curves. 

Summary 

In order to employ the V-I tester to its full potential as a fault diagnosis tool, it is important to 
focus on differences between curves for good and suspect boards, rather than analysing in 
great detail the meaning of the curves.  The majority of nodes on a PCB will contain parallel 
and series combinations of components, making exact analysis difficult.  The majority of 
faults on failed boards are gross failures such as short or open circuits, which are easy to 
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detect with the V-I technique without complex analysis. 

Suggested V-I Test Parameters 

There are numerous combinations of Analogue V-I test parameters which can be chosen by 
the operator. This flexibility allows the widest range of components to be tested but also 
presents some difficulty to the inexperienced operator. The following table presents typical 
test parameters for a number of different types of components to be tested. The table may be 
used to quickly obtain a representative V-I characteristic for a given component. Often, a 
different combination of test parameters will give the same characteristic.  Experienced 
operators will be able to quickly deduce the appropriate test parameters by observing the 
obtained V-I characteristic and adjusting the controls. 
 

Capacitors (Voltage = 4V pk-pk, curve = Sine) 
Range Test frequency Source impedance 
100uF - 1000uF 37.5Hz 100 ohms 
10uF - 100uF 37.5Hz - 300Hz 100 ohms 
1uF - 10uF 37.5Hz - 300Hz 1k 
10nF - 1000nF 37.5Hz - 2.4kHz 10k 
1nF - 10nF 37.5Hz - 2.4kHz 100k 
0.1nF - 1nF 37.5Hz - 600Hz 1M 

Inductors (Voltage = 2V pk-pk, curve = Sine) 
Range Test frequency Source impedance 
10mH - 100mH 2.4kHz - 240Hz 100 ohms 
1mH - 10mH 4.8kHz - 2.4kHz 100 ohms 
100uH - 1000uH 12kHz - 4.8kHz 100 ohms 

Resistors (Voltage = 4V pk-pk; test frequency = 60Hz, curve = Sine) 
Range Source impedance 
500k - 10M 1M 
50k - 500k 100k 
5k - 50k 10k 
500R - 5k 1k 
10R - 500R 100 ohms 

Digital ICs: Voltage = 4V pk-pk;  
 Test frequency = 37.5Hz; 
 Source impedance = 10k 
 
Analogue ICs:  Voltage = 10V pk-pk; 
 Test frequency = 37.5Hz; 
 Source impedance = 10k 
Diodes: Voltage = 2V pk-pk 
 Test frequency = 37.5Hz 
 Source impedance = 10k 

Matrix V-I 
Matrix V-I testing is a powerful extension to the normal Analogue V-I technique.  The Matrix 
V-I test performs a V-I test, (as described above), between every pair of pins on the device 
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under test. This provides a much more comprehensive test than the standard V-I test. For 
example if the device under test (DUT) has any links between pins this will immediately be 
apparent using the Matrix V-I test. 
 
Initially pin 1 is switched to ground to provide the V-I reference, and the V-I characteristic of 
pin 1 is then captured. Then pin 2 is switched to ground and again the V-I characteristic for 
pin 1 is captured. This is repeated until all of the pins on the DUT have been switched to 
ground to provide the reference.  The whole process is then repeated by switching each pin 
in turn to ground and capturing the V-I characteristic of pin 2 relative to the reference pin. 
When the V-I characteristics for all pins on the DUT have been captured, the test begins once 
again at pin 1. As an example, an 8 pin test would result in 64 (8x8) V-I characteristics being 
captured. 
The test displays all of the V-I characteristics associated with the selected pin, by clicking on 
the comparison bar graph next to that pin. Obviously if the characteristics for pin 1 are 
displayed, the characteristic for pin 1 with reference to pin 1 will be a short circuit, indicated by 
a vertical line. An individual characteristic can be inspected by clicking on that trace. 
 
Note that the Matrix V-I test is only available when an Analogue IC Test Solution is installed. 
 

Matrix VI Out-Of-Circuit Adapter 

In order to carry out Matrix VI tests out-of-circuit, an optional adapter is available and 
connects directly into the ATS Analogue I/O connector (using cable provided). Note that no 
ground reference is required for this test.  
 

 
 The Matrix VI adapter offers the following sockets: 
 

- 24 pin SOIC socket (wide gauge) 
- 14 pin SOIC socket (narrow gauge) 
- 24 pin DIL socket 

 
Please note that, in order to enable Matrix VI out-of-circuit, the 
tick box in the setup window needs to be selected. 
 
 
 

 

The VPS Front Panel 
This is the VPS (Variable Power Supply) front panel: 
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VPS Variable Power Supply 
The Variable Power Supply (VPS) is a self contained triple power supply unit designed to 
work with the existing SYSTEM 8 modules. 
 
As standard the supply provides the following outputs and features: - 
 
A logic supply (2.5V to 6V at 5A max) supply with adjustable over-voltage protection and fixed 
over-current protection. 
 
Positive and negative variable supplies covering the range of: -24V to 0V and 0V to +24V 
each with a maximum current of 1.5A.  Both supplies include variable current limiting from 
50mA to 1.5A. 
 

 

To open this instrument, click on the PSU button or select Power Supply 
from the Instruments menu. 
 

 

 

Power Supply Output 

The power supply output state can be one of the following: 
 

ON: All three power supplies are ON. 
OFF: All three power supplies are OFF. 

Voltage Adjustment 

The output voltages of all three supplies can be adjusted using the scroll bars. 

Over Voltage Protection 

The logic supply has built in over voltage protection which can be set using the scroll bar.  If 
the over voltage state is triggered a Vmax message is displayed in the digital readout and the 
entire power supply switches off. 
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Over Current Protection 

The current limits can be set using the scroll bars underneath the current readings on the 
instrument.  If the current limit activates, the output voltage for this supply will reduce to 
maintain a constant current.  The other supplies will be unaffected.  If the over current 
condition is removed, the output voltage will revert to its original state. 

The ATM Front Panel 
This is the ATM (Advanced Test Module) front panel: 
 

 

The ATM Advanced IC Identifier 
The ATM Advanced IC Identifier allows unknown ICs to be identified without typing in a part 
number. 
 

To open this instrument, click on the Advanced IC Identifier icon, or select 
Instruments > Advanced IC Identifier from the menu. 

IC Size 

The user must select the size of the IC to be identified.  This is achieved using the IC Size 
list box.  The list box contains the sizes of all ICs in the identifier library. 

Family 

Once an IC Size has been selected the family lost box will display all the families that contain 
parts of the selected size. By selecting one or more families from the list the time taken of 
identify the device can be reduced. 

Start / Stop Button 

Pressing the Start button will begin the identification process. 
 
Pressing the Stop button will abort the identifier instrument at any time during the test. 

Identifier Test Result 

Any identified devices and their function are listed in the result list box.  Also, equivalent 
devices are listed. 
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ICs Found 

The total number of devices identified during the test is displayed in the IC’s Found box.  
This is continually updated as the test proceeds. 

Identifier Progress 

Due to the large size of the identifier library, the identifier test can be in progress a 
considerable time.  The extent to which the test has searched through the library is indicated 
in a percentage status bar at the bottom of the screen.  Initially this will indicate 0% complete.  
As the test progresses, the displayed figure will increase toward 100% (indicating completion).  
This is also indicated graphically by a blue bar which moves towards the right of the screen as 
the test progresses. 

Identifier Status 

The status of the identifier instrument is indicated as follows: 
 

Ready:   The instrument is ready to start  
Searching:  The instrument is searching 
Complete:  The identification is complete 
Stopped:  The instrument has been stopped 

 
More than one part may be found to be equivalent to the device under test.  This is usually 
due to PCB configuration and IC pin compatibility. 
 
If no parts are identified, the device under test may not be in the identifier library or the device 
may be faulty.  Alternatively factors such as test clip connection, lack of a ground clip and 
failure to disable connecting circuitry may cause parts not to be identified. 
 
Note: The IC Identifier instrument can cause prolonged backdriving of components.  Please 
take steps to prevent this by disabling connected devices by removal or by using BDO 
outputs to disable them.  Linear ICs are particularly susceptible; therefore ensure that the IC 
Identifier instrument is only used on digital ICs. 

The ATM Advanced Graphical Test Generator  
The ATM Advanced Graphical Test Generator allows the ATM channels to be used to 
output a timing sequence and monitor responses. 
 

 

To open this instrument, click on the Advanced Graphical Test Generator 
icon, or select Instruments > Advanced Graphical Test Generator from the 
menu. 

 
The number of channels (256 maximum), the number of patterns (999 maximum) and the 
signal type are all configurable.  Each channel is represented by a number which is 
displayed down the left hand side of the instrument. These numbers relate to the actual 
physical channel number on the front connector. 
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Part Selection 

The family filter allows a specific family to be selected, displaying its contents in the Parts list 
below. 
 
You can also type the IC number directly into the Parts box.  Simply start typing the number 
of the IC you wish to test and the IC is automatically found in the list.  If the IC cannot be 
found then either the wrong library has been loaded or the IC does not exist.  The easiest 
way to check this is to enter the IC number with the All families option selected.  Once a part 
is selected its pin names are loaded and its power pins defined. 

Changing Channel Numbers, Names & Types 

To change a channel number, name or type, click the mouse cursor on the appropriate 
channel name.  A green box will then highlight that channel.  
 
If the mouse is clicked on a channel, a channel edit box will be displayed.  This allows the 
user to change the number, name and type of the channel.  If two channels contain the same 
number, an error message will be displayed when attempting to run the sequence. 

Creating a Timing Sequence 

Any timing sequence can be simulated by using high and low levels.  The high and low 
levels are generated by using the mouse cursor and clicking on a trace. 
 
The existing state of the trace will be displayed as a Drive Low, Drive High, Don't care, Sense 
Low and Sense High.  Clicking on this level will toggle it to the next state. 
 
Channels defined as outputs from the system (inputs to the unit under test) can be 
programmed as either Drive Low or Drive High.  Channels defined as inputs to the system 
(outputs from the unit under test) can be programmed as either Sense Low, Sense High or 
Don't care.  Channels defined as bidirectional can be programmed to any of the states. 

Save Button 

Once a trace has been set up, it can be saved to a file by pressing the Save button.  The 
trace is then saved internally against its part. 

Learn Button 

Once the required outputs from the system have been programmed, it is possible to learn the 
response of the inputs by pressing the Learn button. 

Import Button 

The Import button opens and loads a previously saved file.  A box will appear and all 
available .APAT files will be displayed.  Choose a file and press OK to load it. 

Export Button 

The Export button opens saves a pattern to an external file.  A box will appear and all 
available .APAT files will be displayed.  Choose a file name and press OK to save it. 

Run Button 

The Run button begins the logic sequence as defined by the traces.  The sequence of high 
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and low pulses is output to the front connector on the ATM module.  

Setup Button 

The Setup button allows the user to configure the number of usable channels, patterns, test 
threshold levels, whether auto clip positioning is to be used and the output drive levels can be 
defined. 

Delete Button 

The Delete button will delete a saved trace. 

Edit Button 

The Edit button will allow the name of a saved trace to be changed. 

The ATM Advanced Short Locator  
The ATM Advanced Short Locator allows short circuits to be located to a very close 
proximity. 
 

 

To open this instrument, click on the Advanced Short Locator icon, or select 
Instruments > Advanced Short Locator from the menu. 

 
This instrument requires a separate probe set containing red and black probes.  This 
connects into the main IO connector on the ATM Front Panel.  The instrument uses a 4 wire 
low resistance measuring technique to enable the location of a short circuit on a PCB to be 
found. 
 
Note: The presence of the Advanced Short Locator probes will interfere with the test results 
of the other Advanced instruments.  Ensure that the probes are removed when not using the 
Advanced Short Locator instrument. 
 
When a low resistance is measured between the two probes, a tone is generated by the PC 
speaker and the on-screen probes move toward the right of the screen.  As the probes 
become closer to the source of the short circuit, the measured resistance decreases.  This is 
indicated by a higher pitch, and also by the displayed probes moving further to the right of the 
screen. 

Range 

This selects the full scale sensitivity of the resistance measurement.  The ranges are: 
 

0.5 Ohm: 0.0 ohms to 0.5 ohms 
1.0 Ohm: 0.0 ohms to 1.0 ohms 
2.0 Ohm: 0.0 ohms to 2.0 ohms 

Tone 

This provides an audio indication of the measured resistance between the Short Locator 
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probes.  This allows the user to concentrate on following tracks on the PCB without needing 
to look at the display.  The tone may be turned On or Off by moving the control slider.  The 
tone status is indicated in both text and picture to the side of the control. 

Error Messages 

If the measured resistance is greater than the full scale of the selected range the message 
OVERFLOW will be displayed.  If the probe leads are not connected or damaged, the 
message PROBES! will be displayed. 

The ATM Advanced IC Tester  
The ATM Advanced IC Tester allows ICs to be tested in various ways without removing them 
from the printed circuit board (PCB). 
 

To open this instrument, click on the Advanced IC Tester icon, or select 
Instruments > Advanced IC Tester from the menu. 

 
Before an IC can be tested, a part must be selected.  The currently loaded part will be 
displayed in the box directly to the left of the Start button.  If the message No Part Loaded is 
displayed here, you will be unable to run any tests.  You must select a part before a test can 
be performed.  The board under test will need to be powered from an external supply (if 
power is required by the test) and the ground MUST be linked to the ATM ground terminal. 

Part Selection 

The family filter allows a specific family to be selected, displaying its contents in the Parts list 
below. 
 
You can also type the IC number directly into the Parts box.  Simply start typing the number 
of the IC you wish to test and the IC is automatically found in the list.  If the IC cannot be 
found then either the wrong library has been loaded or the IC does not exist.  The easiest 
way to check this is to enter the IC number with the All families option selected. 

Run Modes 

An IC test can be executed once, continuously or until certain conditions are met.  This is 
highlighted by the following: 
 
Single: Executes the tests once only. 
Loop: Executes the tests continually. 
True Loop: Executes the tests while ever the tests are true. 
False Loop: Executes the tests while ever the tests are false. 

Setup Button 

The Setup button is used to configure the test parameters.  In the Setup Test Parameters 
box it is possible to configure a particular test to the requirement of the IC under test. 

Start / Stop Button 
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The Start button will execute the tests which have been enabled in the Setup Test 
Parameters box using the configured parameters.  If no part has been loaded, the message 
No Part Loaded is displayed and no test will be executed. 
 
The Stop button will stop any test which is currently running.  This will only usually apply 
when running tests in one of the loop modes. 

Results 

The results are displayed at the bottom of the instrument. Each enabled test type will have 
either a tick or a cross beside it indicating a good or bad comparison for that test.  Also 
shown will be the result of the truth table tests if applicable.  Any information regarding circuit 
conditions and pre-test information will also be shown in the list box.  Any notes applicable to 
the part under test will also be displayed in the notes box at the bottom of the dialog. 

IC / V-I / Logic Trace Tabs 

These tabs toggle between the truth table test display(IC diagram) the digital V-I (DV-I) test 
display and the Logic Trace test display.  
 
All colours corresponding to the digital DV-I trace can be configured using the Select DV-I 
Trace Colours function. 
 
For more information on the logic trace feature see Logic Trace. 

Rotate Button 

When a truth table test is performed on a QFP or PLCC IC it displays only 2 sides of the IC.  
The rotate button rotates the IC to view the pins which were not initially displayed.  Pressing 
the Rotate button again displays the initial pins which were displayed. 

Actual / Master Button 

The Actual / Master button toggles between displaying the results that have be acquired after 
the last test or the results which were stored as the master in a TestFlow. 

The ATM Advanced Board Checker  
The ATM Advanced Board Checker allows a printed circuit board (PCB) to be tested in 
various ways without the need for multiple pieces of test equipment. 
 

To open this instrument, click on the Advanced Board Checker icon, or 
select Instruments > Advanced Board Checker from the menu. 

Update All Button 

The Update All button is used to send the actions for each of the channels in the in the 
available channel list to the ATM. The results for all of the channels will also be updated. 

Send Settings on Open Checkbox 

The send settings on open check box is used to determine if the ATM should be updated 
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when the Board Checker instrument is opened. This is useful if the ATM is required to be 
setup upon entering a TestFlow step. 

Channel Name 

Each channel can be assigned a name this is user definable text which can be used to 
identify a channels function. 

Action to Perform 

The action of each of the ATM's channels can be set as follows: 
 

Off: The channel is turned off and set to a user specified off voltage 
Measure: The channel is setup to measure a voltage with user definable tolerances 
Drive: The channel is driving on and set to a user specified drive voltage 
VI Check: The channel is setup to perform a VI test and compare against a stored 

mask with user definable tolerances 

Available Channels List 

The available channels list shows all ATM channels and their actions. The list can be filtered 
to Show All, Show Passes or Show Failures using the radio buttons.  

Channel Results 

Each channel has its own result. Once all measurements are completed the Board Checker 
instruments overall result is updated.  

Calculator 
The SYSTEM 8 Premier software contains 9 user programmable calculators, four that are 
general purpose, and five that are related to individual instruments.  Each calculator has its 
own readout display, comparison and statistics functions. 
 
Calculators allow basic measurements obtained from the measurement hardware to be used 
to perform further calculations and display or log the results. 
 
The calculator formulae are text files that contain simple commands, mathematical operators 
and expressions, variables and functions.  You can use the built-in formula files for 
commonly used functions, or develop your own application specific equations. 
 
The calculator uses the simple, but flexible, programming language FormulaPlus.  To find 
out more about FormulaPlus consult the following Conceptual Topics and Language 
References: 

Conceptual Topics 

Commenting your FormulaPlus Programs 
Declaring Variables 
Looping Through Code 
Understanding FormulaPlus Syntax 
Writing Data to Files 

Language Reference 
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Error Messages 
Keywords 
Operators 
System Variables 
Functions 

Commenting your FormulaPlus Programs 
While the FormulaPlus syntax is easy to understand we recommend that all FormulaPlus 
programs are commented.  Comments make your code easier to understand and help you to 
maintain your code. 
 
The FormulaPlus language uses the // symbols (two forward slashes) to indicate that the text 
following it is a comment.  The comment ends with either a new line character, or another set 
of // symbols. 

Examples of Comments: 

// This is a comment that ends with a new line character. 
// The display command that follows will be executed, as this comment ends here //  
display "Hello World" 

Declaring Variables 
A variable is a named storage location that contains data that may be modified during the 
execution of a FormulaPlus program. 
 
Variables must be defined before they are used by assigning a value to them.  For example, 
the statement x = 1, creates a variable x, and assigns the value 1 to it. 
 
Each variable must be unique within a calculator, and must begin with an alphabetic character.  
Variables are not case sensitive, but can contain only alphabetic characters, numbers and 
may include the underscore character. 

Examples of legal variable identifiers: 

volts_1_of_200 
new_resistance 

Examples of illegal variable identifiers: 

1_of_200_voltages 
new-resistance 

 
Attempting to use an illegal variable identifier will cause the FormulaPlus program to stop with 
an error message. 

Looping Through Code 
Looping allows a block of statements to be executed repeatedly.  Some loops repeat blocks 
of statements depending upon the result of a conditional expression, while others loop 
repeatedly. 
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WHILE Loops 

WHILE loops repeat the block of statements while the condition evaluates to true. 
 
These loops are especially useful when you want to loop while you wait for a given situation 
to occur.  For example, suppose you want to only begin logging values measured on the 
DMM Channel 1 when its voltage exceeds 5.0V, and then you only want to log the next 10 
readings.  You could do this using the following program: 
 

 
 

 
WHILE DMM_CH1 < 5.0 

 
{ 

 
WAIT DMM_CH1 

 
} 

 
count = 0 

 
STARTLOG "My Log.csv" 

 
WHILE count < 10 

 
{ 

 
WAIT DMM_CH1 

 
WRITELOG DMM_CH1 

 
count = count + 1 

 
} 

 
 

  
 
The first WHILE statement loops round the block until DMM_CH1 has a value of 5.0V or 
above.  The second WHILE loop writes the value of DMM_CH1 to "My Log.csv" and 
increments the count.  When the count equals 10 it stops repeating the block, having written 
10 values to the file. 

REPEAT Loops 

REPEAT loops repeat the block of statements while the calculator is running. 
 
These loops are especially useful when a display must be continuously updated for the 
lifetime of a calculator.  A calculator lifetime begins when you press the RUN button, or when 
a TestFlow record begins.  The calculator lifetime ends when the STOP button is pressed, or 
when the TestFlow moves to the next record. 
 
For example, suppose you want to create a display that continuously displays the voltage 
measured on DMM_CH1 divided by the voltage measured on DMM_CH2.  The FormulaPlus 
program on the right shows the correct way to do this. 
 

 
 

 
 

 
DISPLAY DMM_CH1 / DMM_CH2 

 
REPEAT 
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{ 

  
 

DISPLAY DMM_CH1 / DMM_CH2 

  
 

} 

 
The program on the left runs the DISPLAY command exactly once, and then the program 
ends.  The program on the right repeatedly runs the DISPLAY command while the calculator 
is running, continuously updating the value displayed in the calculator display box as the 
values of DMM_CH1 and DMM_CH2 change. 

Understanding FormulaPlus Syntax 
The Language Reference help text shows how to use the FormulaPlus language correctly.  
The examples in this topic explain how to interpret the most common elements.  You should 
note that, unlike some other programming languages, there is no need to delimit a new line of 
code using a semicolon. 

Keywords 

KEYWORD parameter1, parameter2, ..., parameterN 
 
A keyword has one or more parameters, examples include: 
 

DISPLAY "Hello World" 
WRITELOG DMM_CH1, DMM_CH2 

Functions 

FUNCTION (parameter1, parameter2, ..., parameterN) 
 
A function has zero or more parameters, examples include: 
 

PI() 
MIN(1, 2) 

Writing Data to Files 
When working with large amounts of data, for example when you want to log results, it is 
convenient to write data to a file.  FormulaPlus allows you to write data to files using the 
STARTLOG and WRITELOG or STARTLOGDB and WRITELOGDB keywords. 
 
Each calculator can only have one file open at any time. 
 
Before data can be written to a file, the file must be created by using the STARTLOG or 
STARTLOGDB keyword.  Data can then be written to the file using the WRITELOG or 
WRITELOGDB keyword.  The WRITELOG keyword opens the file created by STARTLOG, 
writes data to it, then closes the file again.  In the event a poorly written application program 
crashes your machine, preventing Premier from running, you should not lose your logged 
data. The WRITELOGDB keyword adds a new entry to the database created by 
STARTLOGDB. 

Comma Separated Variable Files 
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FormulaPlus writes data to files in the ".csv" file format.  Comma separated variable files are 
an industry standard file format for importing into spreadsheets such as Microsoft Excel™. 

Writing to the Same File 

 
Two or more calculators can write to the same file, although the order in which data is added 
to the file cannot be guaranteed. 
 
Example: 

 // DMM Calculator  // FC Calculator 
 
STARTLOG "C:\My Documents\My Log 
File.csv" 
count = 0 
WHILE (count < 5) { 
   WAIT DMM_CH1 
   WRITELOG "DMM", DMM_CH1 
} 

 
STARTLOG "C:\My Documents\My Log 
File.csv" 
count = 0 
WHILE (count < 5) { 
   WAIT FC_CH1 
   WRITELOG "FC", FC_CH1 
} 

 
Result: 

"FC",100.0 
"DMM",1.0 
"FC",100.0 
"FC",100.0 
"DMM",1.2 

Database Files 

FormulaPlus writes data to databases in the "SQLite3" file format.  Comma separated 
variable files are an industry standard file format for importing into spreadsheets such as 
Microsoft Excel™. 

Writing to the Same File 

Two or more calculators can write to the same file, although the order in which data is added 
to the file cannot be guaranteed. 
 
Example: 

 // DMM Calculator  // FC Calculator 
 
STARTLOGDB "C:\My Documents\My Log 
File.db" 
count = 0 
WHILE (count < 5) { 
   WAIT DMM_CH1 
   WRITELOGDB "DMM", DMM_CH1 
} 

 
STARTLOGDB "C:\My Documents\My Log 
File.db" 
count = 0 
WHILE (count < 5) { 
   WAIT FC_CH1 
   WRITELOGDB "FC", FC_CH1 
} 

 
Result: 
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Conditional Expressions 

Conditional expressions evaluate to either true (any value other than zero) or false (zero). 

List of Error Messages 
The following error conditions can occur in FormulaPlus programmes.  For detailed 
information about an individual error message, see below: -: 
 
Vars > 20 
More than 20 variables defined.  The FormulaPlus language allows up to 20 user defined 
variables.  If more than 20 user defined variables are created this error is generated. 
 
Missing = 
Missing equals sign in assignment statement.  FormulaPlus is expecting an assignment (e.g. 
X = 100) but hasn't found the = symbol. 
 
Var syntax 
Variable name contains invalid character(s).  FormulaPlus has encountered a variable name 
that contains invalid characters.  For examples of valid names see the "Declaring Variables" 
section. 
 
Var undef 
Variable name not defined.  FormulaPlus requires that variables are defined before they are 
used.  For more information on declaring variables, see the "Declaring Variables" section. 
 
Syntax 
Syntax error.  FormulaPlus cannot match the program code to any known command, 
function, variable name or operator. 
 
Missing ( 
Missing opening bracket in expression.  FormulaPlus expected to find an open bracket at 
this point, but didn't find one. 
 
Missing ) 
Missing closing bracket in expression.  FormulaPlus expected to find a closing bracket at this 
point, but didn't find one. 
 
Too complex 
Expression has too many nested brackets.  FormulaPlus allows up to 5 levels of bracket 
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nesting.  If there are more than 5 levels of brackets, this error will be displayed. 
 
Divide 0 
Divide by zero.  Numbers cannot be divided by zero - attempting to do so causes this error. 
 
Missing " 
Missing opening or closing quotation mark in string.  FormulaPlus is expecting a string, but 
either cannot locate the opening quotation mark, or the closing quotation mark..  A string 
must start and end on the same line of code. 
 
Decimals 
Invalid expression for decimal places.  FormulaPlus allows formatted numbers to have up to 
six decimal places using the FORMAT keyword.  See the FORMAT keyword for more 
information. 
 
Power arg 
Invalid argument for power operator.  FormulaPlus generates this error whenever an attempt 
is made to generate a mathematically incorrect power, or raise the power by more than 50. 
 
1. If x is raised to the power y, and x is a negative number, y must be a whole number. 

 e.g. (-2)^2 is valid, (-2)^(0.5) gives an error. 
 
2. If x is raised to the power y, and x is 0, y must be greater than 0. 

 e.g. 0^(0.5) is valid, 0^(-1) gives an error. 
 
Sq root arg 
Invalid argument for square root function.  FormulaPlus generates this error whenever an 
attempt is made to generate the square root of a negative number.  (FormulaPlus does not 
allow complex numbers.) 
 
Log arg 
Invalid argument for logarithm function.  FormulaPlus gives this error if an attempt is made to 
take the log of a value of 0 or less. 
 
Missing , 
Missing comma.  FormulaPlus gives this error when it is expecting another parameter but 
can't find a comma. 
 
Exp arg 
Invalid argument for exponential function.  FormulaPlus does not allow exponentials of 
greater than 50 to be calculated.  If an attempt is made to calculate the exponential of a 
value greater than 50, then this error is generated. 
 
Var read only 
System variable is read only.  This error is generated if an attempt is made to write to a read 
only system variable. 
 
File error 
Cannot create log file.  If the file specified with the STARTLOG keyword cannot be created, 
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FormulaPlus will give this error.  There are a number of possible reasons why a file may not 
be created: 
 

1. An attempt was made to overwrite a file that cannot be overwritten. 
2. An attempt was made to create a file in a location that does not exist. 
3. An attempt was made to write to a read only device (such as a CD-ROM). 

 
Stck ovfl 
Stack overflow.  FormulaPlus allows up to 50 WHILE / REPEAT / IF blocks to be nested 
within each other.  Any attempt exceed this limit generates a stack overflow. 
 
A block is the code placed between the opening brace symbol { and the closing brace 
symbol }. 
 
X=0 
Y=0 
WHILE (X < 100) 
{ 

// This is the first block 
WHILE (Y < 50) 
{ 

// This is a second block. 
// In FormulaPlus you can have up to 50 of 
// these nested blocks before you get an 
// error message. 
Y=Y+1 

} 
X=X+1 

} 
 
Stk undfl 
Stack underflow.  If there are more closing brace symbols } than opening brace symbols {, 
then FormulaPlus will display this error message. 
 
For example, the following would display the error message: 
 
X=0 
WHILE (X<10) 
{ 
 X=X+1 
} 
// The following extra brace causes a "Stk undfl" error message. 
} 
 
Maths 
Unknown error in mathematical operation.  While every attempt has been made to ensure 
that all mathematical errors are caught and that meaningful error messages are given, there 
may be occasions where this does not happen,. On these rare occasions FormulaPlus 
generates an Unknown error in mathematical operation error. 
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Error? 
Unknown error, contact product support.  This error should never occur.  If this error does 
occur, please contact Product Support giving as much detail about how it happened as you 
possibly can. 

List of Keywords 
For detailed information about individual keywords, see below. 
 
BLEEP 
Bleep emits a user definable sound based on a series of parameters. 
 
Syntax: 

BLEEP pitch1, time1, pitch2, time2, repeat 
 
Parameters: 

pitch1 : Pitch of first note 
time1 : Duration of first note in milliseconds 
pitch2 : Pitch of second note 
time2 : Duration of second note in milliseconds 
repeat : Number of repetitions of first and second notes. 

 
Example: 

BLEEP 4000, 250, 8000, 250, 2 
 

Result: 
// Produces a low note, followed by 
// a high note, followed by a low note 
// and then a final high note. 
// 
// Each note is played for 0.25 
// seconds. 

 
DISPLAY 
Displays a number or some text in the associated calculator readout control. 
 
Syntax: 

DISPLAY expression 
DISPLAY string 

 
Parameters: 

expression: A number to be displayed. 
string: A string to be displayed. 

 
Example: Example: 

voltage = 2.0 DISPLAY "Hello World" 
resistance = 1000.0  
FORMAT 1, "A", E  
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DISPLAY voltage / resistance  
  
Result: Result: 

2.0mA Hello World 
 
EXECUTE 
Executes a given record in the test flow. 
 
Syntax: 

EXECUTE NEXT 
EXECUTE FIRST 
EXECUTE LAST 
EXECUTE expression 

 
Parameters: 

NEXT: Evaluates to the next record in the TestFlow. 
FIRST: Evaluates to the first record in the TestFlow. 
LAST: Evaluates to the last record in the TestFlow. 
expression: Expression evaluates to a number that refers to a particular record 

number. 
 

Example: Example: 
EXECUTE NEXT EXECUTE 5 

 
Result: Result: 

// Executes the next record in the 
// test flow sequence 

// Executes the 5th record in the 
// test flow sequence 

 
FORMAT 
Allows the format of a readout to be changed.  The number of decimal places, the units of 
measurement, and the style of number can be changed. 
 
Syntax: 

FORMAT decimal-places, units, number-format 
 
Parameters: 

decimal-places: Number of decimal places to display. 
The number of decimal places must not exceed 6. 

units: Units to display, e.g. "V", "mV" etc. 
number-format: Number format (if the format isn't specified, N is assumed): 
  N for normal, e.g. 0.0001. 
  S for scientific, e.g. 100e-6. 
  E for engineering, e.g. 100u. 

 
Example: Example: Example: 

FORMAT 3, "V", N FORMAT 3, "V", S FORMAT 3, "V", E 
DISPLAY 0.001 DISPLAY 0.001 DISPLAY 0.001 

 
Result: Result: Result: 
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0.001V 1.000e-3V 1.000mV 
 
IF 
Only executes the given instructions if the condition evaluates to true (any non-zero value). 
 
Syntax: 

IF conditional_expression { true_statements } 
IF conditional_expression { true_statements } ELSE { false_statements } 

 
Parameters: 

conditional_expression: Evaluates to false (0), or true (any value other than 0). 
true_statements: Statements that are executed if the conditional-expression 

evaluates to true. 
false_statements: Statements that are executed if the conditional-expression 

evaluates to false. 
 

Example: 
IF temperature > 100 { 
   PAUSE "Too Hot!" 
   } 
ELSE { 
   PAUSE "Safe" 
   } 
 

 
Result: 

// If temperature is greater than 100 
// pause to display "Too Hot!", 
// otherwise display "Safe". 

 
LABEL 
Set the text displayed in the in the calculator's associated calculator entry box label control.  
Strings for both the A and B controls must be provided, even if only one of the controls is 
visible. 
 
Syntax: 

LABEL stringA, stringB 
 
Parameters: 

stringA: A string to be displayed in calculator entry box label control A. 
stringB: A string to be displayed in calculator entry box label control B. 

 
Example: 

LABEL "One", "True" 
 
PAUSE 
Pauses execution, either displaying a prompt or waiting for a given number of milliseconds. 
 
Syntax: 
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PAUSE string 
PAUSE expression 

 
Parameters: 

string: The string displayed to the user while the software is paused. 
expression: Evaluates to the number of milliseconds to wait for before continuing 

execution. 
 

Example: Example: 
PAUSE "Click OK to continue..." PAUSE 1000 

 
Result: Result: 

// Opens a dialog box that displays 
// the text "Click OK to continue...". 
// 
// Execution will not continue until 
// the user clicks on the 'OK' button. 

// The calculator's execution is 
// paused for 1 second. 

 
REPEAT 
Continuously executes the statements within its braces while the calculator is running. 
 
Syntax: 

REPEAT { statements } 
 
Parameters: 

statements: Statements that are executed each iteration. 
 

Example: 
resistance = 100 
REPEAT { 
   WAIT DMM_CH2 
   voltage = DMM_CH2 
   DISPLAY voltage / resistance 
   } 

 
Result: 

// When the program is executed it 
// enters the repeat block. 
// 
// Within the block the program waits 
// for the system variable DMM_CH2 
// to be updated, then displays the  
// result of a calculation. 
//  
// The block of code is then repeated 
// indefinitely, updating the display 
// whenever DMM_CH2 is updated. 
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STARTLOG 
Create a new file for logging operations.  Overwrites any data that already exists in the file. 
 
Syntax: 

STARTLOG filename 
 
Parameters: 

filename: String representing a file name. 
The filename is relative to the current working directory, unless a full path 
name is given. 

 
Examples: Examples: 

STARTLOG "results.csv" STARTLOG 
"c:\mydocu~1\results.csv" 
 

Results: 
// Creates a new file called 
// "results.csv" in the current directory 
// (normally the directory that Premier 
// was installed in). 

Results: 
// Creates a new file called 
// "results.csv" in directory 
// "mydocu~1" on the "C:\" drive. 

 
STARTLOGDB 
Create an SQLite3 database file for logging operations. A new TestFlowLog entry is added 
marked with the current user, date and time. If the database already exists, add a new 
TestFlowLog entry is added to the existing database. 
 
Syntax: 

STARTLOGDB filename 
 
Parameters: 

filename: String representing a file name. 
The filename is relative to the current working directory, unless a full path 
name is given. 

 
Examples: Examples: 

STARTLOGDB "results.db" STARTLOGDB 
"c:\mydocu\results.db" 
 

Results: 
// Creates a new file called 
// "results.db" in the current directory 
// (normally the directory that Premier 
// was installed in) and creates a new 
// TestFlowLog entry. 

Results: 
// Creates a new file called 
// "results.db" in directory 
// "mydocu" on the "C:\" drive and  
// creates a new TestFlowLog entry. 

 
TestFlowLog Entry: 
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Notes: 

This function stores data in a format that can be understood by any SQLite3 database 
viewer. 

 
SYSTEM 
Executes a program, or opens a file if the extension for that file has been registered with 
windows. 
 
Syntax: 

SYSTEM filename 
 
Parameters: 

filename: String representing a file name. 
The filename is relative to the current working directory, unless a full path 
name is given. 

 
Examples: Examples: 

SYSTEM 
"http://www.abielectronics.co.uk" 

SYSTEM "C:\Program 
Files\Microsoft Office\Microsoft 
Excel", "test.csv" 
 

Results: 
// Opens the given web page. 

Results: 
// opens the file "test.csv" in Excel 

 
SYSTEMWAIT 
Executes a program, or opens a file if the extension for that file has been registered with 
windows. Then waits for the program to return a result. 
 
Syntax: 

result = SYSTEMWAIT filename 
 
Parameters: 

filename: String representing a file name. 
     The filename is relative to the current working 

directory, unless a full path name is given. 
result:   A variable to contain the result of the executed program (normally an 

integer). 
 

Examples: Examples: 
Result = SYSTEMWAIT 
"http://www.abielectronics.co.uk" 

Result = SYSTEMWAIT "C:\Program 
Files\Microsoft Office\Microsoft 
Excel", "test.csv" 
 

Results: 
// Opens the given web page. 

Results: 
// opens the file "test.csv" in Excel 
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// Programs return value stored in 
result 

// Programs return value stored in 
result 

 
WAIT 
Waits for a system variable to be updated. 
 
Syntax: 

WAIT system_variable 
 
Parameters: 

system_variable: Any system variable. 
When that system variable updates (even if the updated value is the 
same as the previous value), execution continues. 

 
Example: 

WAIT DMM_CH1 
 
Result: 

// The calculator does not continue 
// executing the program until the 
// value of DMM_CH1 is updated. 

 
WHILE 
Continuously executes statements while the condition is true. 
 
Syntax: 

WHILE conditional_expression { statements } 
 
Parameters: 

conditional_expression: Evaluates to false (0), or true (any value other than 0). 
statements: Statements that are executed if the conditional-expression 

evaluates to true. 
 

Example: 
COUNT = 0 
STARTLOG "DMM_CH1.csv" 
WHILE COUNT < 100 { 
   WAIT DMM_CH1 
   WRITELOG COUNT, DMM_CH1 
   COUNT = COUNT + 1 
   } 

 
Result: 

// A log file is opened. 
// 
// Each time the DMM_CH1 reading 
is 
// updated its value is appended to 
// the .csv file. 
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// 
// When count reaches 100, 
// COUNT < 100 evaluates to false 
// (non-zero), and the while loop is 
// exited. 
// 
// The log file contains 100 results. 

 
WRITELOG 
Appends data to the current log file (which is created by using the STARTLOG keyword). 
 
Syntax: 

WRITELOG expression1, expression2, ..., expressionN. 
 
Parameters: 

expression1 : An expression that evaluates to either any real number, or a string. 
expression2 : An expression that evaluates to either any real number, or a string. 
... 
expressionN : An expression that evaluates to either any real number, or a string. 
 

Example: 
STARTLOG "volts.csv" 
count = 1 
volts = 1.5 
WRITELOG count, ":", volts, "V" 
 

Result: 
// A log file called "volts.csv" is 
// created in the current directory. 
// 
// The contents of the file will be: 
//    1,":",1.5,"V" 

 
Notes: 

WRITELOG has access to special functions that are not available to any other 
FormulaPlus keyword at this time. 
 

TIME() returns the current time (with a minimum resolution of 1 second). 
DATE() returns the current date. 

 
These functions return data in a format that can be understood by Microsoft Excel™ 
when imported as a ".csv" file. 

 
WRITELOGDB 
Appends data to the current log database (which is created by using the STARTLOGDB 
keyword). 
 
Syntax: 

WRITELOGDB result1_name, result1_value, result2_name, result2_value, ..., 
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resultN_name, resultN_value. 
 
Parameters: 

result1_name : A string to be the name of the result. 
result1_value : An expression that evaluates to either any real number, or a string. 
result2_name : A string to be the name of the result. 
result2_value : An expression that evaluates to either any real number, or a string. 
... 
resultN_name : A string to be the name of the result. 
resultN_value : An expression that evaluates to either any real number, or a string. 
 

Example: 
STARTLOG "volts.db" 
Resistance = 0.515034 
WRITELOG "Status", "PASS", "Resistance (Ohms)", Resistance 
 

Result: 
// A log file called "volts.db" is 
// created in the current directory. 
// 
// Then a TestFlowResult entry for each expression pair is created. 

 
TestFlowResult Entry: 

   

   
 

Notes: 
This function stores data in a format that can be understood by any SQLite3 database 
viewer. 

List of Operators 
For detailed information about individual operators, see below: 
 
* Operator 
Used to multiply two numbers. 
 
+ Operator 
Used to add two numbers. 
 
- Operator 
Used to subtract one number from another. 
 
/ Operator 
Used to divide one number by another. 
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^ Operator 
Used to raise one number to the power of another. 

List of System Variables 
System variables are pre-defined variables which can be used in FormulaPlus programmes 
for extracting readins, measurements or for controlling the operation of a programme.  For 
detailed information about individual system variables see below: 

Advanced Board Checker System Variables 

BC_CH_RESULT(Channel Number) (read-only) 
Returns the status of the specified channel on the Advanced Board Checker. 
0 Incomplete The channel is waiting for its measurement to complete. 
1 Pass The channel's measurement has completed, and the result was a pass. 
2 Fail The channel's measurement has completed, and the result was a fail. 
3 None The channel is off. 

 
BC_CH_VOLTAGE(Channel Number) (read-only) 
Returns the last voltage measured by the specified channel on the Advanced Board Checker. 

Digital Multimeter System Variables 

DMM_ACTION (read-only) 
Returns the value of the last DMM user button that was last pressed. 
 
DMM_CH1, DMM_CH2 (read-only) 
Returns the last value read from the specified channel on the Digital Multimeter. 
 
DMM_ENTRY_A, DMM_ENTRY_B 
Returns/sets the value displayed in Calculator Entry Box A/B for the DMM calculator. 

Digital Storage Oscilloscope System Variables 

DSO_ACQUISITION (read-only) 
This system variable is updated whenever a DSO acquisition has completed.  This system 
variable is useful for waiting for a DSO acquisition to finish.  For example: 

 
 

 
STARTLOG "C:\My Documents\Oscilloscope.csv" 

 
REPEAT 

 
{ 

 
WAIT DSO_ACQUISITION 

 
WRITELOG "DSO", DSO_CH1_AMPLITUDE, DSO_CH1_PERIOD 

 
} 

This example opens a file "Oscilloscope.csv" in directory "C:\My Documents".  It then enters 
the repeat loop and waits for the DSO acquisition to complete.  When the acquisition is 
complete it logs the amplitude and period of the waveform displayed on channel 1 to the open 
file.  It then loops around again and waits for the next acquisition to complete. 
 
DSO_ACQUIRE_STATUS (read-only) 
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Returns the current acquisition state of the Digital Storage Oscilloscope as follows: - 
Values 0 Starting acquisition 
 1 Waiting for trigger 
 2 Completed acquisition 
 3 Completing acquisition 
 4 Building ERS acquisition 
 5 Auto zero calibration 

 
DSO_ACQUIRE_MODE 
Returns/sets the acquisition mode for the Digital Storage Oscilloscope as follows: - 
Values 0 Automatic acquisition 
 1 Normal acquisition 
 2 Single acquisition 
 3 Stop 

 
DSO_TIMEBASE_INDEX 
Returns/sets the timebase index for the Digital Storage Oscilloscope as follows: - 
Values 0 5s / Division 
 1 2s / Division 
 2 1s / Division 
 3 0.5s / Division 
 4 0.2s / Division 
 5 0.1s / Division 
 6 50ms / Division 
 7 20ms  / Division 
 8 10ms / Division 
 9 5ms / Division 
 10 2ms / Division 
 11 1ms / Division 
 12 0.5ms / Division 
 13 0.2ms / Division 
 14 0.1ms / Division 
 15 50us / Division 
 16 20us / Division 
 17 10us / Division 
 18 5us / Division 
 19 2us / Division 
 20 1us / Division 
 21 0.5us / Division 
 22 0.2us / Division 
 23 0.1us / Division 
 24 50ns / Division 
 25 20ns / Division 
 26 10ns / Division 
 27 5ns / Division 

 
DSO_TRIG_COUPLING 
Returns/sets the trigger coupling setting used by the Digital Storage Oscilloscope as follows: - 
Values 0 DC triggering 
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 1 AC triggering 
 2 Low frequency rejection 
 3 High frequency rejection 

 
DSO_TRIG_DELAY 
Returns/sets the trigger delay for the Digital Storage Oscilloscope. 
 
DSO_TRIG_EDGE 
Returns/sets the edge used to trigger off on the Digital Storage Oscilloscope as follows: - 
Values 0 Positive edge 
 1 Negative edge 

 
DSO_TRIG_LEVEL 
Returns/sets the trigger level voltage for the Digital Storage Oscilloscope. 
 
DSO_TRIG_SOURCE 
Returns/sets the trigger source setting used by the Digital Storage Oscilloscope as follows: -. 
Values 0 Channel 1 triggering 
 1 Channel 2 triggering 
 2 External triggering 
 3 FG triggering 

 
DSO_CH1_ACTION, DSO_CH2_ACTION (read-only) 
Returns the value of the DSO user button for the specified channel that was last pressed. 
 

DSO_CH1_AMPLITUDE, DSO_CH2_AMPLITUDE (read-only) 
Returns the amplitude of the waveform displayed on the specified channel of the Digital 
Storage Oscilloscope. 
 
DSO_CH1_BANDWIDTH, DSO_CH2_BANDWIDTH (read-only) 
Returns the value of 0.35 divided by the measured rise time for the specified channel.  This 
formula is valid only for a first order system (i.e. with no overshoot on a rising edge) and can 
be used to give a VERY approximate estimate of the system bandwidth. 
 

DSO_CH1_COUPLING, DSO_CH2_COUPLING 
Returns/sets the coupling settings for the specified channel of the Digital Storage 
Oscilloscope as follows: - 
 
Values 0 Ground 
 1 DC 
 2 AC 

 
DSO_CH1_BASE, DSO_CH2_BASE (read-only) 
Returns the base voltage of the waveform displayed on the specified channel of the Digital 
Storage Oscilloscope. 
 
DSO_CH1_BASE_PEAK, DSO_CH2_BASE_PEAK (read-only) 
Returns the base peak (lowest point) of the waveform displayed on the specified channel of 
the Digital Storage Oscilloscope. 
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DSO_CH1_CREST_FACTOR, DSO_CH2_CREST_FACTOR (read-only) 
Returns the crest factor of the waveform displayed on the specified channel of the Digital 
Storage Oscilloscope. 
 
DSO_CH1_CYCLIC_MEAN, DSO_CH2_CYCLIC_MEAN (read-only) 
Returns the cyclic mean of the waveform displayed on the specified channel of the Digital 
Storage Oscilloscope. 
 
DSO_CH1_CYCLIC_RMS, DSO_CH2_CYCLIC_RMS (read-only) 
Returns the cyclic RMS of the waveform displayed on the specified channel of the Digital 
Storage Oscilloscope. 
 
DSO_CH1_CYCLES, DSO_CH1_CYCLES (read-only) 
Returns the number of complete cycles detected in the waveform displayed on the specified 
channel of the Digital Storage Oscilloscope. 
 
DSO_CH1_DUTY_CYCLE, DSO_CH2_DUTY_CYCLE (read-only) 
Returns the value of "100% * high pulse width divided by the period for the waveform on the 
specified channel of the Digital Storage Oscilloscope.". 
 
DSO_CH1_ENTRY_A, DSO_CH1_ENTRY_B, DSO_CH2_ENTRY_A, DSO_CH2_ENTRY_B 
Returns/sets the value displayed in Calculator Entry Box A or B for the specified channel of 
the DSO calculator. 
 
DSO_CH1_FALL_TIME, DSO_CH2_FALL_TIME (read-only) 
Returns the total time between the 10% and 90% amplitude points on the falling edges of the 
specified channel divided by the number of falling edges. 
 
DSO_CH1_FREQUENCY, DSO_CH2_FREQUENCY (read-only) 
Returns the frequency of the waveform displayed on the specified channel of the Digital 
Storage Oscilloscope. 
 
DSO_CH1_GAIN_INDEX, DSO_CH2_GAIN_INDEX 
Returns/sets set the volts/division setting for the specified channel on the Digital Storage 
Oscilloscope as follows: - 
Values 0 2.0V / Division 
 1 1.0V / Division 
 2 0.5V / Division 
 3 0.2V / Division 
 4 0.1V / Division 
 5 50mV / Division 
 6 20mV / Division 

 
DSO_CH1_MEAN, DSO_CH2_MEAN (read-only) 
Returns the mean of the waveform displayed on the specified channel of the Digital Storage 
Oscilloscope. 
 
DSO_CH1_NEG_SLEW, DSO_CH2_NEG_SLEW (read-only) 
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Returns the voltage difference between the 10% and 90% amplitude points on falling edge 
divided by the time difference between these points on the specified channel. 
 
DSO_CH1_NEG_TIME_CONSTANT, DSO_CH2_NEG_TIME_CONSTANT (read-only) 
Returns the falling time constant (time from the top to 37% of the amplitude) of an exponential 
falling edge on the specified channel of the DSO. 
 

DSO_CH1_NEG_WIDTH, DSO_CH2_NEG_WIDTH (read-only) 
Returns the total time between 50% amplitude points on falling pulses (falling then rising edge) 
divided by the number of negative pulses on the specified channel. 
 
DSO_CH1_OFFSET, DSO_CH2_OFFSET 
Returns/sets the offset for the specified channel on the Digital Storage Oscilloscope. 
 
DSO_CH1_OVERSHOOT, DSO_CH2_OVERSHOOT (read-only) 
Returns the overshoot of the waveform displayed on the specified channel of the Digital 
Storage Oscilloscope. 
 
DSO_CH1_PEAK_TO_PEAK, DSO_CH2_PEAK_TO_PEAK (read-only) 
Returns the peak to peak voltage of the waveform displayed on the specified channel of the 
Digital Storage Oscilloscope. 
 
DSO_CH1_PERIOD, DSO_CH2_PERIOD (read-only) 
Returns the period of the waveform displayed on the specified channel of the Digital Storage 
Oscilloscope. 
 
DSO_CH1_POS_SLEW, DSO_CH2_POS_SLEW (read-only) 
Returns the voltage difference between the 10% and 90% amplitude points on rising edge 
divided by the time difference between these points on the specified channel. 
 
DSO_CH1_POS_TIME_CONSTANT, DSO_CH2_POS_TIME_CONSTANT (read-only) 
Returns the rising time constant (time from the base to 63% of the amplitude) of an 
exponential rising edge on the specified channel of the DSO. 
 

DSO_CH1_POS_WIDTH, DSO_CH2_POS_WIDTH (read-only) 
Returns the total time between 50% amplitude points on positive pulses (rising then falling 
edge) divided by the number of positive pulses on the specified channel. 
 
DSO_CH1_RISE_TIME, DSO_CH2_RISE_TIME (read-only) 
Returns the total time between the 10% and 90% amplitude points on the rising edges of the 
specified channel divided by the number of rising edges. 
 
DSO_CH1_RMS, DSO_CH2_RMS (read-only) 
Returns the RMS voltage of the waveform displayed on the specified channel of the Digital 
Storage Oscilloscope. 
 
DSO_CH1_TIME_RESOLUTION, DSO_CH2_TIME_RESOLUTION (read-only) 
Returns the resolution of time measurements for the current timebase. 
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DSO_CH1_TOP, DSO_CH2_TOP (read-only) 
Returns the top voltage of the waveform displayed on the specified channel of the Digital 
Storage Oscilloscope. 
 
DSO_CH1_TOP_PEAK, DSO_CH2_TOP_PEAK (read-only) 
Returns the top peak voltage of the waveform displayed on the specified channel of the 
Digital Storage Oscilloscope. 
 
DSO_CH1_UNDERSHOOT, DSO_CH2_UNDERSHOOT (read-only) 
Returns the amount of undershoot of the waveform displayed on the specified channel of the 
Digital Storage Oscilloscope. 
 
DSO_CH1_VOLTAGE_RESOLUTION, DSO_CH2_VOLTAGE_RESOLUTION (read-only) 
Returns the resolution of voltage measurements on the current V/div range for the specified 
channel. 

Frequency Counter System Variables 

FC_ACTION (read-only) 
Returns the value of the last frequency counter user button that was last pressed. 
 

FC_CH1, FC_CH2 (read-only) 
Returns the last value read from for the specified channel on the Frequency Counter. 
 

FC_ENTRY_A, FC_ENTRY_A 
Returns/sets the value displayed in Calculator Entry Box A/B for the Frequency Counter 
calculator. 

Function Generator System Variables 

FG_SWEEP_STEP 
Returns/sets the frequency step through which the function generator output sweeps. 
 

FG_SET_FREQUENCY 
Returns/sets the function generator output frequency. 
 

FG_DUTY_CYCLE 
Returns/sets the function generator duty cycle. 
 

FG_DC_OFFSET 
Returns/sets the function generator DC offset. 
 
FG_ACTUAL_FREQUENCY (read-only) 
Returns the function generator frequency as measured internally by the frequency counter. 
 
FG_AMPLITUDE 
Returns/sets the function generator amplitude. 

Miscellaneous System Variables 

USER1_ACTION, USER2_ACTION, USER3_ACTION, USER4_ACTION (read-only) 
Returns the value of the user button that was last pressed for the specified user calculator. 
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USER1_ENTRY_A, USER1_ENTRY_B, USER2_ENTRY_A, USER2_ENTRY_B 
USER3_ENTRY_A, USER3_ENTRY_B, USER4_ENTRY_A, USER4_ENTRY_B 
Returns/sets the value displayed in the Calculator Entry Box A/B for user calculators 1 to 4. 

TestFlow System Variables 

TFL_ACTION (read-only) 
Returns the value of the TestFlow user button that was last pressed. 
 

TFL_ENTRY_A, TFL_ENTRY_B 
Returns/sets the value displayed in the Calculator Entry Box A/B for the TestFlow calculator. 
 
TFL_STATUS (read-only) 
Returns the status of the current TestFlow record as follows: - 
 
0 Incomplete The TestFlow is waiting for the record's tests to complete. 
1 Pass All the record's tests have completed, and the result was a pass. 
2 Fail All the record's tests have completed, and the result was a fail. 
3 None The TestFlow record doesn't have any associated tests. 

Universal Input/Outputs System Variables 

UIO_ACH1_VALUE_OUT, UIO_ACH2_VALUE_OUT 
UIO_ACH3_VALUE_OUT, UIO_ACH4_VALUE_OUT 
Returns/sets the voltage output by the specified UIO analogue channel. 
 

UIO_ACH1_VALUE_IN, UIO_ACH2_VALUE_ IN 
UIO_ACH3_VALUE_ IN, UIO_ACH4_VALUE_ IN (read-only) 
Returns the voltage measured on the specified UIO analogue channel. 
 
UIO_ACH1_DIRECTION, UIO_ACH2_DIRECTION 
UIO_ACH3_DIRECTION, UIO_ACH4_DIRECTION 
Returns/sets the direction of the specified UIO analogue channel, i.e. whether it is an output 
or an input, as follows: - 
Values 0 Output 
 1 Input 

 
UIO_ACH1_MODE, UIO_ACH2_ MODE 
UIO_ACH3_ MODE, UIO_ACH4_ MODE 
Returns/sets the mode of the specified UIO analogue channel, i.e. whether it is in voltage or 
current mode, as follows: - 
Values 0 Voltage 
 1 Current 

 
UIO_ACH1_RESTRICT, UIO_ACH2_ RESTRICT 
UIO_ACH3_ RESTRICT, UIO_ACH4_ RESTRICT 
Returns/sets the restrict state of the specified UIO analogue channel, i.e. whether it is 
enabled ir disabled, as follows: - 
Values 0 Disabled 
 1 Enabled 
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UIO_DCH1_STATE, UIO_DCH2_STATE, UIO_DCH3_STATE, UIO_DCH4_STATE 
Returns/sets the value of the specified digital channel on the UIO as follows: - 
Values 0 Low 
 1 High 

 
UIO_DCH1_DIRECTION, UIO_DCH2_ DIRECTION 
UIO_DCH3_ DIRECTION, UIO_DCH4_ DIRECTION 
Returns/sets the logic level and direction of the specified UIO digital channel as follows: - 
Values 0 Output low 
 1 Output high 
 2 Input 

Variable Power Supply System Variables 

VPS_STATUS 
Returns/sets the power status of connected VPS modules as follows: - 
Values 0 VPS Off 
 1 VPS On 

Notes: All connected VPS modules will be affected by changes to this variable. 
 
VPS_LOGIC1_VOLTAGE_SETTING, VPS_LOGIC2_ VOLTAGE _ SETTING 
VPS_NEG1_ VOLTAGE _ SETTING, VPS_NEG2_ VOLTAGE _ SETTING 
VPS_POS1_ VOLTAGE _ SETTING, VPS_POS2_ VOLTAGE _ SETTING 
Returns/sets the voltage setting for the specified VPS output.  The logic output range is 0 to 
+6.0V, negative output -24.5V to 0V, and positive output 0V to +24.5V  
 
VPS_LOGIC1_VOLTAGE_READING, VPS_LOGIC2_ VOLTAGE _READING 
VPS_NEG1_ VOLTAGE _READING, VPS_NEG2_ VOLTAGE _READING 
VPS_POS1_ VOLTAGE _READING, VPS_POS2_ VOLTAGE _READING (read-only) 
Returns the measured voltage reading for the specified VPS output 
 
VPS_LOGIC1_CURRENT_READING, VPS_LOGIC2_CURRENT_READING 
VPS_NEG1_CURRENT_READING, VPS_NEG2_CURRENT_READING 
VPS_POS1_CURRENT_READING, VPS_POS2_CURRENT_READING (read-only) 
Returns the measured current reading for the specified VPS output 
 
VPS_LOGIC1_CURRENT_TRIP, VPS_LOGIC2_CURRENT_TRIP 
Returns/sets the current trip value for the specified VPS logic output from 0 to 5A. 
 
VPS_LOGIC1_ENABLE_TRIP, VPS_LOGIC2_ENABLE_TRIP 
Returns/sets the state of the current trip for the specified VPS logic output as follows: - 
Values 0 Trip Off 
 1 Trip On 

 
VPS_LOGIC1_OVP_SETTING, VPS_LOGIC2_ OVP_SETTING 
Returns/sets the over voltage protection setting for the specified VPS logic output from 0 to 
6.5V. 
 
VPS_LOGIC1_OVP_TRIG, VPS_LOGIC2_ OVP_TRIG 
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Returns/sets the state of the over voltage protection trigger for the specified VPS logic output 
as follows: - 
Values 0 OVP off 
 1 OVP on 

 
VPS_NEG1_CURRENT_LIMIT, VPS_NEG2_CURRENT_ LIMIT 
VPS_POS1_CURRENT_ LIMIT, VPS_POS2_CURRENT_ LIMIT 
Returns/sets the current limit setting for the specified VPS output from 0.00A to 1.50A 

List of Functions 
For detailed information about individual functions see below: - 
 
ABS() 
This function returns the absolute value (or magnitude) of an expression, providing that 
expression evaluates to a number.  For example, a negative number is returned as a positive 
number with the same magnitude as the original negative number. 
 
Syntax: 

ABS (expression) 
 
Parameters: 

expression: Numerical expression whose magnitude is to be returned. 
 
Example: Example: 

FORMAT 0, "", N FORMAT 0, "", N 
DISPLAY ABS(-100) DISPLAY ABS(100) 

  
Result: Result: 

100 100 
 
COS() 
This function calculates the cosine of an expression, providing that expression evaluates to a 
number. 
 
Syntax: 

COS (angle) 
 
Parameters: 

angle: Numerical expression representing an angle (in radians) whose cosine is to be 
returned. 

 
Example: 

FORMAT 3, "", N 
DISPLAY COS(PI()/2) 
 

Result: 
 0.000 
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E() 
This function returns the value of the mathematical constant E (which is equivalent to taking 
the exponential of 1). 
 
Syntax: 

E() 
 
Parameters: 
 
Example: 

FORMAT 3, "", N 
DISPLAY E() 
 

Result: 
 2.718 
 
E12(), E24() 
This function evaluates expression, providing that expression evaluates to a number, and 
determines the nearest preferred E12/E24 resistor value. 
 
Syntax: 

E12 (expression) 
E24 (expression) 

 
Parameter: 

expression: Value for which the preferred E12/E24 resistor value is found.  
 
Example: 

FORMAT 0, "", N 
DISPLAY E12(302.5) 

Result: 330 
 
EXP() 
This function calculates the exponential of the expression, providing that expression 
evaluates to a number. 
 
Syntax: 

EXP (expression) 
 
Parameters: 

expression: Numerical expression for which the exponential will be returned. 
If the value is greater than 50, an error will be given. 

 
Example: Example: 

FORMAT 3, "", N FORMAT 3, "", N 
DISPLAY EXP(1) DISPLAY EXP(51) 

 
Result: Result: 

2.718 Exp arg 
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INT() 
Returns the integer value of the expression given, providing that expression evaluates to a 
number. 
 
Syntax: 

INT (expression) 
 
Parameters: 

expression: Numerical expression whose integer part will be returned. 
 
 
 
 
Example: Example: 

FORMAT 1,"",N FORMAT 1,"", N 
DISPLAY INT(1.5) DISPLAY INT(-1.5) 

 
Result: Result: 

2.0 -2.0 
 
LOG() 
This function evaluates the expression, and providing it evaluates to a number, returns its 
natural logarithm. 
 
Syntax: 

LOG (expression) 
 
Parameters: 

expression: Numerical expression whose natural logarithm will be returned. 
If the value is 0.0 or less, an error message is given. 

 
Example: Example: 

FORMAT 1,"",N FORMAT 1,"", N 
DISPLAY LOG(1.0) DISPLAY LOG(0.0) 

 
Result: Result: 

0.0 Log arg. 
 
MAX() 
This function returns the larger of the two values in its parameter list. 
 
Syntax: 

MAX (expression1, expression2) 
 
Parameters: 

expression1: Value to compare against. 
expression2: Value to compare against. 
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Example: Example: 
FORMAT 1,"",N FORMAT 1,"", N 
DISPLAY MAX(1, 2) DISPLAY MAX(2, 1) 

 
Result: Result: 

2.0 2.0 
 
MIN() 
This function returns the smaller of the two values in its parameter list. 
 
Syntax: 

MIN (expression1, expression2) 
 
Parameters: 

expression1: Value to compare against. 
expression2: Value to compare against. 

 
Example: Example: 

FORMAT 1,"",N FORMAT 1,"", N 
DISPLAY MIN(1, 2) DISPLAY MIN(2, 1) 

 
Result: Result: 

1.0 1.0 
 
PI() 
This function returns the value of the mathematical constant PI. 
 
Syntax: 

PI() 
 
Parameters: 
 
Example: 

FORMAT 3, "", N 
DISPLAY PI() 
 

Result: 
 3.142 
 
ROUND() 
This function rounds the value given as its first parameter to the nearest multiple of its second 
parameter. 
 
Syntax: 

ROUND (expression1, expression2) 
 
Parameters: 

expression1: Value to round. 
expression2: Nearest value to round to a multiple of. 
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Example: Example: 

FORMAT 0,"",N 
// Round to the nearest hundred 

FORMAT 0,"", N 
// Round to an even number 

DISPLAY ROUND(123, 100) DISPLAY ROUND(13, 2) 
 

Result: Result: 
100 14 

 
SIN() 
This function calculates the sine of an expression, providing that expression evaluates to a 
number. 
 
Syntax: 

SIN (angle) 
 
Parameters: 

angle: Numerical expression representing an angle (in radians) whose sine is to be 
returned. 

 
Example: 

FORMAT 3, "", N 
DISPLAY SIN(PI()/2) 
 

Result: 
 1.000 
 
SQRT() 
This function evaluates the square root of the given expression. 
 
Syntax: 

SQRT (expression) 
 
Parameters: 

expression: Numerical expression whose square root is to be returned. 
If the value is negative, an error occurs. 

 
Example: Example: 

FORMAT 1,"",N FORMAT 1,"", N 
DISPLAY SQRT(4.0) DISPLAY SQRT(-4.0) 

 
Result: Result: 

2.0 Sq root arg 
 
TAN() 
This function calculates the tangent of an expression, providing that expression evaluates to a 
number. 
 
Syntax: 
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TAN (angle) 
 
Parameters: 

angle: Numerical expression representing an angle (in radians) whose tangent is to be 
returned. 

 
Example: 

FORMAT 3, "", N 
DISPLAY TAN(0) 

 
Result: 

0.000 
 
TICK() 
This function returns the time, in seconds, that the calculator program has been running. 
 
Syntax: 

TICK() 
 
Parameters: 
 
Example: 

FORMAT 0,"",N 
PAUSE 5000 
DISPLAY TICK() 
 

Result: 
5 

What Is Python? 
Python is an object-oriented programming language, which combines remarkable power with 
very clear syntax.  There are interfaces available to many system calls and libraries, as well 
as to various windowing systems.  New modules can be easily written in C or C++.  
 
Python has been fully integrated into the SYSTEM 8 FormulaPlus calculator description 
language. 
 
Full support and documentation on the Python language is available from www.python.org 
 

Installing Python 
It is necessary to download and install python 2.7 on your computer before you can you any 
of its features from within SYSTEM 8. 
 
Python 2.7 is available as a free download directly from www.python.org, install the latest 
version available for the windows operating system. Once installed all of Python's feature will 
be available from within the SYSTEM 8 FormulaPlus calculator description language. 
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Python DMM 
The Digital Multimeter instrument can be accessed from Python using the Premier library. All 
of the DMM system variables from FormulaPlus are available in Python.  
 
Usage Example 
 
python 
{ 
 # Include talking to Premier in this script 
 import premier 
 
 # Get access to the digital multimeter 
 DMM = premier.dmm() 
 
 # Print the DMM Channel readings 
 print "Channel 1 reading is" + str(DMM.ch1) 
 print "Channel 2 reading is" + str(DMM.ch2) 
} 
 
Property Description Equivalent FormulaPlus 

Variable 
ch1 DMM channel 1 reading DMM_CH1 

ch2 DMM channel 2 reading DMM_CH2 

Python DSO 
The Digital Storage Oscilloscope instrument can be accessed from Python using the Premier 
library. All of the DSO's system variables from FormulaPlus are available in Python.  
 
Usage Example 
 
python 
{ 
 # Include talking to Premier in this script 
 import premier 
 
 # Get access to the digital storage oscilloscope 
 DSO = premier.dso() 
 
 # Set some DSO properties 
 DSO.ch1_offset = 2 
 DSO.timebase_index = 3 # 0.5s / Division 
 
 # Print some DSO properties 
 print "DSO channel 1 amplitude is" + str(DSO.ch1_amplitude) 
 print "DSO channel 1 frequency is" + str(DSO.ch1_frequency) 
} 
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Property Description Equivalent FormulaPlus Variable 
acquire_mode DSO Acquire mode DSO_ACQUIRE_MODE 

acquire_status DSO Acquisition status DSO_ACQUIRE_STATUS 

trig_coupling DSO trigger coupling DSO_TRIG_COUPLING 

trig_source DSO trigger source DSO_TRIG_SOURCE 

trig_edge DSO trigger slope DSO_TRIG_EDGE 

trig_level DSO trigger level DSO_TRIG_LEVEL 

trig_delay DSO trigger delay DSO_TRIG_DELAY 

timebase_index DSO timebase DSO_TIMEBASE_INDEX 

   

ch1_offset DSO channel 1 vertical 
offset 

DSO_CH1_OFFSET 

ch1_amplitude DSO channel 1 amplitude DSO_CH1_AMPLITUDE 

ch1_peak_to_peak DSO channel 1 peak to 
peak 

DSO_CH1_PEAK_TO_PEAK 

ch1_top DSO channel 1 top DSO_CH1_TOP 

ch1_top_peak DSO channel 1 top peak DSO_CH1_TOP_PEAK 

ch1_base DSO channel 1 base DSO_CH1_BASE 

ch1_base_peak DSO channel 1 base peak DSO_CH1_BASE_PEAK 

ch1_mean DSO channel 1 mean 
value 

DSO_CH1_MEAN 

ch1_cyclic_mean DSO channel 1 cyclical 
mean 

DSO_CH1_CYCLIC_MEAN 

ch1_rms DSO channel 1 RMS DSO_CH1_RMS 

ch1_cyclic_rms DSO channel 1 cyclical 
RMS 

DSO_CH1_CYCLIC_RMS 

ch1_overshoot DSO channel 1 overshoot DSO_CH1_OVERSHOOT 

ch1_undershoot DSO channel 1 undershoot DSO_CH1_UNDERSHOOT 

ch1_crest_factor DSO channel 1 crest factor DSO_CH1_CREST_FACTOR 

ch1_period DSO channel 1 period DSO_CH1_PERIOD 

ch1_frequency DSO channel 1 frequency DSO_CH1_FREQUENCY 

ch1_cycles DSO channel 1 number of 
cycles 

DSO_CH1_CYCLES 

ch1_rise_time DSO channel 1 rise time DSO_CH1_RISE_TIME 

ch1_fall_time DSO channel 1 fall time DSO_CH1_FALL_TIME 

ch1_pos_width DSO channel 1 positive 
width 

DSO_CH1_POS_WIDTH 

ch1_neg_width DSO channel 1 negative 
width 

DSO_CH1_NEG_WIDTH 

ch1_pos_slew DSO channel 1 positive 
slew rate 

DSO_CH1_POS_SLEW 

ch1_neg_slew DSO channel 1 negative 
slew rate 

DSO_CH1_NEG_SLEW 

ch1_bandwidth DSO channel 1 bandwidth DSO_CH1_BANDWIDTH 

ch1_duty_cycle DSO channel 1 duty cycle DSO_CH1_DUTY_CYCLE 

ch1_pos_time_constant DSO channel 1 positive 
time constant 

DSO_CH1_POS_TIME_CONSTAN
T 

ch1_neg_time_constant DSO channel 1 negative 
time constant 

DSO_CH1_NEG_TIME_CONSTAN
T 
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ch1_voltage_resolution DSO channel 1 voltage 
resolution 

DSO_CH1_VOLTAGE_RESOLUTI
ON 

ch1_time_resolution DSO channel 1 time 
resolution 

DSO_CH1_TIME_RESOLUTION 

   

ch2_offset DSO channel 2 vertical 
offset 

DSO_CH2_OFFSET 

ch2_amplitude DSO channel 2 amplitude DSO_CH2_AMPLITUDE 

ch2_peak_to_peak DSO channel 2 peak to 
peak 

DSO_CH2_PEAK_TO_PEAK 

ch2_top DSO channel 2 top DSO_CH2_TOP 

ch2_top_peak DSO channel 2 top peak DSO_CH2_TOP_PEAK 

ch2_base DSO channel 2 base DSO_CH2_BASE 

ch2_base_peak DSO channel 2 base peak DSO_CH2_BASE_PEAK 

ch2_mean DSO channel 2 mean 
value 

DSO_CH2_MEAN 

ch2_cyclic_mean DSO channel 2 cyclical 
mean 

DSO_CH2_CYCLIC_MEAN 

ch2_rms DSO channel 2 RMS DSO_CH2_RMS 

ch2_cyclic_rms DSO channel 2 cyclical 
RMS 

DSO_CH2_CYCLIC_RMS 

ch2_overshoot DSO channel 2 overshoot DSO_CH2_OVERSHOOT 

ch2_undershoot DSO channel 2 undershoot DSO_CH2_UNDERSHOOT 

ch2_crest_factor DSO channel 2 crest factor DSO_CH2_CREST_FACTOR 

ch2_period DSO channel 2 period DSO_CH2_PERIOD 

ch2_frequency DSO channel 2 frequency DSO_CH2_FREQUENCY 

ch2_cycles DSO channel 2 number of 
cycles 

DSO_CH2_CYCLES 

ch2_rise_time DSO channel 2 rise time DSO_CH2_RISE_TIME 

ch2_fall_time DSO channel 2 fall time DSO_CH2_FALL_TIME 

ch2_pos_width DSO channel 2 positive 
width 

DSO_CH2_POS_WIDTH 

ch2_neg_width DSO channel 2 negative 
width 

DSO_CH2_NEG_WIDTH 

ch2_pos_slew DSO channel 2 positive 
slew rate 

DSO_CH2_POS_SLEW 

ch2_neg_slew DSO channel 2 negative 
slew rate 

DSO_CH2_NEG_SLEW 

ch2_bandwidth DSO channel 2 bandwidth DSO_CH2_BANDWIDTH 

ch2_duty_cycle DSO channel 2 duty cycle DSO_CH2_DUTY_CYCLE 

ch2_pos_time_constant DSO channel 2 positive 
time constant 

DSO_CH2_POS_TIME_CONSTAN
T 

ch2_neg_time_constant DSO channel 2 negative 
time constant 

DSO_CH2_NEG_TIME_CONSTAN
T 

ch2_voltage_resolution DSO channel 2 voltage 
resolution 

DSO_CH2_VOLTAGE_RESOLUTI
ON 

ch2_time_resolution DSO channel 2 time 
resolution 

DSO_CH2_TIME_RESOLUTION 
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Python FC 
The Frequency Counter instrument can be accessed from Python using the Premier library. 
All of the FC's system variables from FormulaPlus are available in Python.  
 
Usage Example 
 
python 
{ 
 # Include talking to Premier in this script 
 import premier 
 
 # Get access to the frequency counter 
 FC = premier.fc() 
 
 # Print the FC Channel readings 
 print "Channel 1 reading is" + str(FC.ch1) 
 print "Channel 2 reading is" + str(FC.ch2) 
} 
 

Property Description Equivalent FormulaPlus Variable 
ch1 Frequency counter 

channel 1 reading 
FC_CH1 

ch2 Frequency counter 
channel 2 reading 

FC_CH2 

Python FGen 
The Function Generator instrument can be accessed from Python using the Premier library. 
All of the Function Generator system variables from FormulaPlus are available in Python.  
 
Usage Example 
 
python 
{ 
 # Include talking to Premier in this script 
 import premier 
 
 # Get access to the function generator 
 FGen = premier.fgen() 
 
 # Set some FGen properties 
 FGen.amplitude = 2 
 FGen.set_frequency = 2000 
 
 # Print FGen actual frequency property 
 print "FGen actual frequency is " + str(FGen.actual_frequency) 
} 
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Property Description Equivalent FormulaPlus Variable 
amplitude Amplitude FG_AMPLITUDE 

dc_offset DC Offset FG_DC_OFFSET 

set_frequency Set Frequency FG_SET_FREQUENCY 

actual_frequency Actual Frequency FG_ACTUAL_FREQUENCY 

duty_cycle Duty Cycle FG_DUTY_CYCLE 

sweep_step Sweep Step FG_SWEEP_STEP 

   

Python UIO 
The Universal Input/Output instrument can be accessed from Python using the Premier library. 
All of the UIO system variables from FormulaPlus are available in Python.  
 
Usage Example 
 
python 
{ 
 # Include talking to Premier in this script 
 import premier 
 
 # Get access to the universal input / outputs 
 UIO = premier.uio() 
 
 # Set some UIO properties 
 UIO.ach1_direction = 0 
 UIO.ach1_value_out = 2 
 UIO.ach2_direction = 1 
 
 # Print some UIO properties 
 print "UIO channel 1 output is " + str(UIO.ach1_value_out) 
 print "UIO channel 2 input is " + str(UIO.ach2_value_in) 
} 
 

Property Description Equivalent FormulaPlus Variable 
ach1_direction UIO analogue channel 1 

direction 
UIO_ACH1_DIRECTION  

ach2_direction UIO analogue channel 2 
direction 

UIO_ACH2_DIRECTION  

ach3_direction UIO analogue channel 3 
direction 

UIO_ACH3_DIRECTION  

ach4_direction UIO analogue channel 4 
direction 

UIO_ACH4_DIRECTION  

ach1_mode UIO analogue channel 1 
mode 

UIO_ACH1_MODE  

ach2_mode UIO analogue channel 2 
mode 

UIO_ACH2_MODE  

ach3_mode UIO analogue channel 3 
mode 

UIO_ACH3_MODE  
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ach4_mode UIO analogue channel 4 
mode 

UIO_ACH4_MODE  

ach1_value_out UIO analogue channel 1 
output value 

UIO_ACH1_VALUE_OUT 

ach2_value_out UIO analogue channel 2 
output value 

UIO_ACH2_VALUE_OUT 

ach3_value_out UIO analogue channel 3 
output value 

UIO_ACH3_VALUE_OUT 

ach4_value_out UIO analogue channel 4 
output value 

UIO_ACH4_VALUE_OUT 

ach1_value_in UIO analogue channel 1 
input value 

UIO_ACH1_VALUE_IN 

ach2_value_in UIO analogue channel 2 
input value 

UIO_ACH2_VALUE_IN 

ach3_value_in UIO analogue channel 3 
input value 

UIO_ACH3_VALUE_IN 

ach4_value_in UIO analogue channel 4 
input value 

UIO_ACH4_VALUE_IN 

ach1_restrict UIO analogue channel 1 
restrict enable 

UIO_ACH1_RESTRICT 

ach2_restrict UIO analogue channel 2 
restrict enable 

UIO_ACH2_RESTRICT 

ach3_restrict UIO analogue channel 3 
restrict enable 

UIO_ACH3_RESTRICT 

ach4_restrict UIO analogue channel 4 
restrict enable 

UIO_ACH4_RESTRICT 

dch1_state UIO digital channel 1 state UIO_DCH1_STATE 

dch2_state UIO digital channel 2  
state 

UIO_DCH2_STATE 

dch3_state UIO digital channel 3  
state 

UIO_DCH3_STATE 

dch4_state UIO digital channel 4  
state 

UIO_DCH4_STATE 

dch1_direction UIO digital channel 1  
direction 

UIO_DCH1_DIRECTION 

dch2_direction UIO digital channel 2  
direction 

UIO_DCH2_DIRECTION 

dch3_direction UIO digital channel 3  
direction 

UIO_DCH3_DIRECTION 

dch4_direction UIO digital channel 4  
direction 

UIO_DCH4_DIRECTION 

Python VPS 
The Variable Power Supply can be accessed from Python using the Premier library. All of the 
VPS system variables from FormulaPlus are available in Python.  
 
Usage Example 
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python 
{ 
 # Include talking to Premier in this script 
 import premier 
 
 # Get access to the VPS 
 VPS = premier.vps() 
 
 # Set some VPS properties 
 VPS.logic1_voltage_setting = 3 
 VPS.pos1_voltage_setting = 10 
 
 # Print some VPS properties 
 print "VPS logic1 voltage reading is " + str(VPS.logic1_voltage_reading) 
 print "VPS pos1 current is " + str(VPS.pos1_current_reading) 
} 
 

Property Description Equivalent FormulaPlus Variable 
logic1_voltage_reading VPS1 Logic Voltage VPS_LOGIC1_VOLTAGE_READIN

G 

pos1_voltage_reading VPS1 +ve Voltage VPS_POS1_VOLTAGE_READING 

neg1_voltage_reading VPS1 -ve Voltage VPS_NEG1_VOLTAGE_READING 

logic1_current_reading VPS1 Logic Current VPS_LOGIC1_CURRENT_READIN
G 

pos1_current_reading VPS1 +ve Current VPS_POS1_CURRENT_READING 

neg1_current_reading VPS1 -ve Current VPS_NEG1_CURRENT_READING 

logic1_voltage_setting VPS1 Logic Set Voltage VPS_LOGIC1_VOLTAGE_SETTIN
G 

pos1_voltage_setting VPS1 +ve Set Voltage VPS_POS1_VOLTAGE_SETTING 

neg1_voltage_setting VPS1 -ve Set Voltage VPS_NEG1_VOLTAGE_SETTING 

pos1_current_limit VPS1 +ve Set Current VPS_POS1_CURRENT_LIMIT 

neg1_current_limit VPS1 -ve Set Current VPS_NEG1_CURRENT_LIMIT 

logic1_ovp_setting VPS1 Logic OVP setting VPS_LOGIC1_OVP_SETTING 

logic1_ovp_trig VPS1 Logic OVP trig VPS_LOGIC1_OVP_TRIG 

logic1_current_trip VPS1 Logic current trip VPS_LOGIC1_CURRENT_TRIP 

logic1_enable_trip VPS1 Logic enable trip VPS_LOGIC1_ENABLE_TRIP 

   

logic2_voltage_reading VPS2 Logic Voltage VPS_LOGIC2_VOLTAGE_READIN
G 

pos2_voltage_reading VPS2 +ve Voltage VPS_POS2_VOLTAGE_READING 

neg2_voltage_reading VPS2 -ve Voltage VPS_NEG2_VOLTAGE_READING 

logic2_current_reading VPS2 Logic Current VPS_LOGIC2_CURRENT_READIN
G 

pos2_current_reading VPS2 +ve Current VPS_POS2_CURRENT_READING 

neg2_current_reading VPS2 -ve Current VPS_NEG2_CURRENT_READING 

logic2_voltage_setting VPS2 Logic Set Voltage VPS_LOGIC2_VOLTAGE_SETTIN
G 

pos2_voltage_setting VPS2 +ve Set Voltage VPS_POS2_VOLTAGE_SETTING 

neg2_voltage_setting VPS2 -ve Set Voltage VPS_NEG2_VOLTAGE_SETTING 
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pos2_current_limit VPS2 +ve Set Current VPS_POS2_CURRENT_LIMIT 

neg2_current_limit VPS2 -ve Set Current VPS_NEG2_CURRENT_LIMIT 

logic2_ovp_setting VPS2 Logic OVP setting VPS_LOGIC2_OVP_SETTING 

logic2_ovp_trig VPS2 Logic OVP trig VPS_LOGIC2_OVP_TRIG 

logic2_current_trip VPS2 Logic current trip VPS_LOGIC2_CURRENT_TRIP 

logic2_enable_trip VPS2 Logic enable trip VPS_LOGIC2_ENABLE_TRIP 

Using Python Example 
In order to use Python code within the calculator, the code must be contained within a Python 
code segment. 
 
python 
{ 
 ...  
 ... Python code here 
 ... 
} 

Commenting Python Code 

The Python language uses the # symbol to indicate that the text following it is a comment.  
The comment ends with either a new line character. 
 
python 
{ 

# This is a comment that ends with a new line character. 
} 

Mixing Python and FormulaPlus Example  
In this example FormulaPlus and Python code are mixed to write continuous measurements 
of the DMM channel 1 to the calculator output. 
 
// START OF FIRST PYTHON BLOCK 
python 
{ 
  import premier   # Prepare to use the Premier interface 
  NumReadings = 0   # No readings taken initially 
  Multimeter = premier.dmm() 
} 
// END OF FIRST PYTHON BLOCK 
 
// START OF CALCULATOR BLOCK 
while 1 
{ 
 // Wait for DMM channel 1 to complete 
 WAIT DMM_CH1 
 
 // START OF SECOND PYTHON BLOCK 
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 python 
 { 
  # New reading available 
  CurrentReading = Multimeter.ch1 
  NumReadings += 1 
 
  # Display this reading 
  print "Reading {0}: {1:.3f}V".format(NumReadings, CurrentReading) 
  } 
  // END OF SECOND PYTHON BLOCK 
} 
// END OF CALCULATOR BLOCK 

Python Input Example 
In this example Python is used to ask the user to enter their name and then write the users 
name to the calculator output. 
 
python 
{ 
 try: 
  UserEntry = raw_input("Please enter a name") 
  print "\nYou entered: " + UserEntry 
 except EOFError: 
  print "\nYou pressed cancel" 
} 

Python Output Example 
In this example Python is used to write "Hello there" to the calculator output. 
 
python 
{ 
 print "Hello there!" 
} 

Python Running an External Program Example  
In this example Python is used to launch the Microsoft calculator application and display any 
response to the calculator output.  
 
python 
{ 
  import subprocess 
 
  p = subprocess.Popen(["calc.exe"], stdout=subprocess.PIPE) 
  stdout, stderr = p.communicate() 
  print stdout 
} 


